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Preface

Information in this document is subject to change without notice.
© 1998–2004 ERLPhase Power Technologies Ltd. All rights reserved. 
Reproduction in any manner whatsoever without the written permission of 
ERLPhase Power Technologies Ltd. is strictly forbidden.
This manual is part of a complete set of product documentation that includes 
detailed drawings and operation. Users should evaluate the information in the 
context of the complete set of product documentation and their particular 
applications. ERLPhase assumes no liability for any incidental, indirect, or 
consequential damages arising from the use of this documentation.
While all information presented is believed to be reliable and in accordance 
with accepted engineering practices, ERLPhase makes no warranties as to the 
completeness of the information.
All trademarks used in association with B-PRO, F-PRO, L-PRO, ProLogic, T-
PRO, TESLA, TESLA Control Panel, RecordGraph, RecordBase, NXCT, 
NXVT, and NXVCT are trademarks of ERLPhase Corporation.
Windows® is a registered trademark of the Microsoft Corporation.
Procomm® is a registered trademark of Symantec.
HyperTerminal® is a registered trademark of Hilgraeve.
Modbus® is a registered trademark of Modicon.

Contact Information

ERLPhase Power Technologies Ltd.
Website: www.erlphase.com
Email: info@erlphase.com

Technical Support
Email: support@erlphase.com
Tel: 204-477-0591
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Version Descriptions

TESLA Version Compatibility

Release Date TESLA Firmware Setting Version Control Panel

2004 Oct 22 v4.0 7 v4.0

2004 Feb 17 v3.6d 7 v3.6

2004 Jan 28 v3.6c 7 v3.6

2003 Oct 10 v3.6b 7 v3.6

2003 Sep 09 v3.6b 7 v3.6

2003 June 23 v3.6a 7 v3.6

2003 April 17 v3.6 7 v3.6

2003 Feb 14 v3.5 6 v3.5

2002 Oct 11 v3.4 5 v3.4

2002 Apr 12 v3.3 5 v3.3

2001 Sep 10 v3.2 5 v3.2

2001May 04 v3.1 5 v3.1

2001 Feb 02 v3.0 4 v3.0

2000 Nov 06 v2.2 3 v2.3 or greater

2000 Jul 13 v2.1 3 v2.2 or greater

2000 May 30 v2.1 3 v2.1 or greater

2000 Feb 23 v2.0 2 v2.0 or greater

1999 Dec 16 v1.9 1 v1.3 or greater

1999 Nov 02 v1.8 1 v1.3 or greater

1999 Oct 18 v1.7 1 v1.3 or greater

1999 Jun 28 v1.6B 1 v1.3 or greater

Note: Newer versions of Control Panel are compatible with  all older versions of TESLA 
firmware.

TESLA Firmware Revision History

Release Date Version Change Summary
Release Date: 2008 February 08 TESLA User Manual 2000 iii



Version Descriptions
2004 Oct 15 v4.0 Fixed issue with missing events in records when commu-
nicating with RecordBase Server over a LAN.
Trend and recording alarm contacts now restore their 
previous state after unit reboot.
Performance improvement in SCADA communication.

2004 Feb 17 v3.6d Fixed issue with DNP Class 0 polls.

2004 Jan 28 v3.6c Improvements to IP address handling.
Fixed issue with IRIG-B where the ’sync’ flag would not 
be properly set in records under certain conditions.

2003 Sep 09 v3.6b Fixed incorrect handling of user specified IP addresses 
with leading zeros.
Improved recovery from a possible test mode deadlock 
state.
Internal file system performance improvements.

2003 June 23 v3.6a Corrected erratic behaviour on some units at startup.

2003 April 17 v3.6 Support for not connected modem/LAN notify communi-
cation modes.
Support for cross-triggering and new record notification 
via LAN.
SCADA interface to fault location information.

2003 Feb 14 v3.5 Support for stop/recycle recording modes.
Support for recording alarm and record storage summary 
information.
SCADA interface to record storage summary information.
SCADA interface to trend summary information.

2002 Oct 11 v3.4 Support for separate primary and secondary units.
Improved frequency resolution and frequency change 
handling.
Improved phasor calculations.
Improved THD calculations for small signal levels.

2002 Apr 12 v3.3 Watts/vars values calculated from sequence functions 
use all three sequence components of the defined inputs, 
rather than just the positive sequence components.

2001 Sep 10 v3.2 Trigger duration recording control mode

2001 May 04 v3.1 Power factor function
Support for DC input channels
Support for 1A nominal input channels
Selection of input channel to use as the angle measure-
ment reference

2001 Feb 02 v3.0 Trend logging
Sag and swell detection
Phase angle offsets in summation channels
Increased circular event log size to 250 events
Increased maximum number of user-defined meter 
groups to 10

2000 Nov 06 v2.2d Corrects failure to capture longer swing records which 
can occur under some conditions

TESLA Firmware Revision History
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Version Descriptions
2000 Sep 26 v2.2c Increased dial-out time-out to overcome difficulty calling 
into RecordBase

2000 Sep 22 v2.2b DNP 3 SCADA protocol
Enhancement to the Modbus SCADA protocol
Improved THD and fault location accuracy
(note: v2.2 and v2.2a were not released)

2000 Jun 09 v2.1a Improved record extension algorithms
Fixed problem with modem auto-answer handling

2000 May 30 v2.1 Support for RecordBase (dial-out, remote cross-trigger, 
automated record collection)
Support for Ethernet option
Changed Diagnostic login to Maintenance login
Implemented new unit option identification system
Fixed problem with invalid repeated external input detec-
tor triggers
Improved THD calculation some (inter-channel varia-
tions)

2000 Feb 23 v2.0 Fault location
Logic channels and triggers
Events via Modbus
Primary quantities over Modbus (metering)

1999 Dec 16 v1.9 Fixed problem of repeated triggering of low level analog 
detector

1999 Nov 02 v1.8 Fixed crash associated with connecting IRIG B signal

1999 Oct 15 v1.7 User access levels & passwords
Fixes to impedance triggers and frequency trigger hyster-
esis
Minor clean-up issues

TESLA Control Panel Revision History

Release Date Control Panel 
Version Change History

2004 Oct 22 v4.0 Fixed incorrect start time when exporting combined 
TESLA records in COMTRADE format.
RecordGraph: corrected absolute time readout for com-
bined TESLA records.
RecordGraph: Impedance View now works with COM-
TRADE files.
RecordGraph: correct trigger time now works with COM-
TRADE files.
RecordGraph: Trigger Marker now follows Time Align-
ment settings.

TESLA Firmware Revision History
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Version Descriptions
2003 Oct 10 v3.6a Prevent Utilities views from closing while saving 
changes.
Status of High/Low speed recorders now shows 
“stopped” when Accumulation Mode is set to ‘stop’ and 
the recorder is full.
Corrected erroneous status bar text in the Configuration 
view.
RecordGraph: fixed scaling prefix on derived channels.
RecordGraph: differential view for T-PRO v3.3 firmware 
now displays the differential slope settings.
RecordGraph: fixed incorrect display of DC channel 
units.

2003 April 17 v3.6 Notify operation through LAN connection is now config-
urable.
Printed SCADA points lists include fault location.

2003 Feb 14 v3.5 Displays the number of remote recordings and percent 
disk space used.
Option to have circular record storage or to stop when 
full, including a near-full alarm.
Fault Locator can be configured with summation current 
inputs.

2002 Oct 11 v3.4 Support for new low voltage ac module.
Support for separate primary and secondary units (Con-
trol Panel and RecordGraph).
RecordGraph – B-PRO settings characteristics display in 
differential view.

2002 Apr 12 v3.3 DNP over Ethernet
Additional Fault Locator functions (now 5 per channel 
group)
Data storage controls - individual directory locations for 
records and configuration files from each recorder to 
allow shared access to data and better data backup plan-
ning. 
Support for 50 Hz systems

2001 Nov 26 v3.2a Enhanced record graphics

2001 Sep 10 v3.2 Enhanced record graphics
Trigger duration based recording mode. 
Automatic on-site record printing capability 

2001 May 04 v3.1 Power factor function
Support for DC input channels
Support for 1A nominal input channels
Selection of input channel to use as the angle measure-
ment reference

2001 Feb 02 v3.0 Trend logging
Sag and swell detection
Phase angle offsets in summation channels
Increased circular event log size to 250 events
Increased maximum number of user-defined meter 
groups to 10

2000 Sep 19 v2.3a Include updated setting example files

TESLA Control Panel Revision History
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Version Descriptions
2000 Sep 14 v2.3 Support for TESLA's new DNP implementation
Various fixes and minor improvements

2000 Jul 17 v2.2a Fixed problem with output contact assignment for 18 
channel recorders

2000 Jul 13 v2.2 Users RecordGraph v1.2 module (with harmonics dis-
play)
Supports 480V modules
Various fixes and minor improvements

2000 May 31 v2.1 Can configure TESLA for use with RecordBase
Online user manual help
Uses RecordGraph v1.1 module
Modbus settings report
Event list printout

2000 Feb 23 v2.0 Fault location
Logic channels and triggers
Backward compatibility support

2000 Jan 10 v1.5 Enhanced record export utility (COM-based) - transient 
and swing
Enhanced graphics - primary/secondary, symmetrical 
component view, vertical scale handling
Password handling improvements
Improved communications (connection cancel, progress 
window, shorter timeout, etc.)
Meter cacheing
Configuration - numerous minor improvements
Other minor improvements.

1999 Dec 05 v1.44 Corrected problem with metering calculated impedance
Corrected problem with printing a configuration
Corrected problem with graphing summations with fewer 
than 3 inputs

1999 Nov 24 v1.43 Corrected problem with configuration of summation 
channels

1999 Oct 20 v1.41 Corrected problem access remote records

1999 Oct 18 v1.4 User access levels & passwords
Improved disconnect / re-connect handling
Improved configuration screen layouts including primary/
secondary scaling.

1999 Jul 28 v1.3

TESLA User Manual Revision History

Release Date Manual 
Version Change Summary

2008 Feb 08 v4.0 Rev 2 Branding to ERLPhase.

TESLA Control Panel Revision History
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Version Descriptions
2004 Oct 22 v4.0 Rev 1 Update to firmware v4.0 and Control Panel v4.0.

2003 Oct 10 v3.6 Rev 3 Update to Control Panel v3.6a.
Minor improvements to Chapter 2.

2003 June 23 v3.6 Rev 2 Change the TESLA Firmware Revision History table to 
reflect update to v3.6a.

2003 April 17 v3.6 Update to Control Panel v3.6.

2003 Feb 14 v3.5 Update to Control Panel v3.5.
Support for TESLA Portable (model 2000/P).

2002 Oct 11 v3.4 Update to Control Panel v3.4.

2002 Apr 12 v3.3 Update to Control Panel v3.3.

2001 Nov 26 v3.2 Rev 2 Update to include enhanced graphics.

2001 Sep 10 v3.2 Update to Control Panel v3.2.

2001 May 04 v3.1 Update to Control Panel v3.1.

2001 Feb 02 v3.0 Update to Control Panel v3.0.

2000 Sep 21 v2.3 Add DNP3 Reference
Update Modbus Functions 

2000 Jul 10 v2.2 Update with new RecordGraph module instructions.

2000 May 10 v2.1 Support for RecordBase

2000 Feb 24 v2.0 Updated to match Control Panel v2.0/TESLA Firmware v2.0
Formatting and text changes

2000 Jan 06 v1.5 Updated to match Control Panel v1.5/ TESLA Firmware
Add more instructions to Record Graphing section
Added Equipment List
Added and changed some diagrams
Formatting and text changes

1999 Oct 14 v1.4 Updated to match Firmware Release v1.7/Control Panel 
v1.4
Added Appendix E: Windows Setup
Minor additions and corrections

1999 Jun 25 v1.3 Updated to match Firmware Release v1.6/Control Panel 
v1.3

TESLA User Manual Revision History
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Using This Guide

This User Manual describes the installation and operation of the TESLA dis-
turbance recorder and the accompanying TESLA Control Panel user interface 
software. It is intended to support the first time user and clarify the details of 
the equipment. 

The manual uses a number of conventions to denote special information:

Example Describes

Start>Settings>Control Panel Choose the Control Panel submenu in the Set-
tings submenu on the Start menu.

Right-click Click the right mouse button.

Recordings Menu items and tabs are shown in italics.

service User input or keystrokes are shown in bold.

Text boxes similar to this one Relate important notes and information.

.. Indicates more screens.

Indicates further drop-down menu, click to dis-
play list.

Indicates a warning.
Release Date: 2008 February 08 TESLA User Manual 2000 ix





1 Overview

The TESLA Disturbance Recorder (model 2000, 2000/P) is a multi-time frame 
recording system for monitoring electrical power systems.
The recorder operates simultaneously in three time domains: high speed tran-
sient fault (seconds), low speed dynamic swing (minutes) and trending (con-
tinuous).
TESLA recorder provides an extensive set of triggers including rates and lev-
els, THD, sequence components, summations, watts, vars, power factor, im-
pedance and frequency. 
The TESLA recorder consists of: 
1   A recorder unit which is either a 19 inch 3U rack mount chassis or a portable 

housing
2   Analog input isolation modules connected to station CT, PT and other sig-

nals
3   Control Panel software installed either on a laptop or desktop PC

TESLA Recorder Features
• Simultaneous operation in transient fault and dynamic swing time frames
• 5760 samples/second (96 samples/cycle) transient fault recordings produce 

records from 0.2–5.0 seconds with automatic record extension up to 10.0 sec-
onds for multiple trigger conditions

• 60 samples/second (1 sample/cycle) dynamic swing recordings produce 
records from 10–120 seconds with automatic record extension up to 180 sec-
onds for multiple trigger conditions

• Continuous trending process preserves operational data and detects events
• User-defined, calculated channels for summations, watts, vars, power factor, 

positive, negative and zero sequence components, impedance, THD, fre-
quency, harmonics and fault locator

• 36 analog inputs (or 18 analog inputs—configuration-dependent)
• 64 external inputs (or 32 event inputs—configuration-dependent)
• 10 fault locators (or 5 fault locators – configuration dependent)
• User-configured logic function specifies logic operations on external and in-

ternal states
• 5 user-configurable output contacts (or 2 user-configurable output contacts—

configuration dependant)
• Rates and level triggering on input and calculated channels with extensive in-

dividual controls including delay, logging, record initiation and alarm contact 
activation

• Element configuration format simplifies complex setups by modelling the 
power system within the recorder

• User-assigned trigger priorities used to help identify critical events and 
records
Release Date: 2008 February 08 TESLA User Manual 2000 1-1



1 Overview
• Complete recorder configuration information and relevant event information 
is embedded in each record

• Each analog input configured to monitor a voltage can be used to detect sags 
and swells

• Record compression reducing record size, maximizing storage capacity and 
minimizing transmission time

• Standard TCP/IP communication protocol used to communicate with Control 
Panel and RecordBase software

• Analog input isolation modules are external and are mounted on DIN rails up 
to one hundred feet from the main unit for flexible installation

• Events track all external and internal triggers
• Each recorder can have one or two channel groups (configuration dependent) 

Each channel group has 18 analog and 32 external channels using a floating 
point Digital Signal Processor (DSP). A separate 486 processor is used for 
data storage and all communication control.

• Self-monitoring supervisory software with hardware self-checking circuit en-
sures reliable operation

• IRIG-B input with flexible configuration supports both Universal Time Code 
(UTC) and local time

• SCADA (Supervisory Control and Data Acquisition Systems) protocols—
Modbus, DNP3. DNP3 over Ethernet is supported

• IEEE standards for surge withstand and RFI

TESLA Control Panel Features
• Windows-based software with intuitive user interface
• Provides separate storage space for each recorder’s records and configuration 

files
• Offline mode allows records to be viewed and configurations created without 

connecting to the recorder
• Record summary shows sequence of events
• Record management facilities include multiple record selection for transfer 

and deletion and record renaming
• Record graphics provide a flexible multi-page interactive display and mea-

surement of all channels including calculated ones
• COMTRADE recording export facility
• Configuration facility maintains multiple configurations
• Real-time metering display shows all input and calculated quantities in user-

customizable layouts
• Point and click interface shows record summary and event list for records so 

that a preliminary evaluation can be made before the record is transferred
Figure 1.1:  Front View
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1 Overview
Overview of TESLA Control Panel
TESLA Control Panel is a Windows-based software program that runs on a 
desktop or laptop PC. It communicates with and manages information from 
your TESLA recorders. 

Offline/Online Use TESLA Control Panel can be used with or without a connection to a recorder. 
When connected to a recorder, all TESLA Control Panel functions are avail-
able. When a recorder is not available, you can create/modify configuration 
files and view uploaded records. 

TCP/IP Protocol TESLA Control Panel communicates with a recorder using the TCP/IP proto-
col standard. A communications link can be established through a direct serial 
cable connection, a modem or 10BaseT Ethernet.

Dial-Up Networking The Windows operating system has built-in support for TCP/IP—you may 
have to activate it. To use TCP/IP over a serial link, Windows uses its Remote 
Access Service (RAS) and Dial-Up Networking making the serial link appear 
similar to other network connections to Windows. 

Null Modem Windows Dial-Up Network supports modem communication. When a special 
modem driver called the Null Modem is installed, you can use it for direct se-
rial connection to a TESLA recorder. The Null Modem driver is provided as 
part of the TESLA Control Panel software.
Release Date: 2008 February 08 TESLA User Manual 2000 1-3



1 Overview
Front View (model 2000)

Figure 1.1:  Front View

Rear View (model 2000)

Figure 1.2:  Rear View
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1.   LEDs indicating status of recorder

2.   Communication serial Port 1 for laptop computer 1 2

ERL PHASE
Power Technologies Ltd

3.   Port 5 for optional internal modem (RJ-11) or Ethernet connection (RJ-45)

4.   External clock, IRIG-B modulated or not modulated

5.   Communication port 2 for direct connect to PC or external modem

6.   EIA 232 SCADA communication port 3

7.   Port 4 (unused)

8.   Case external ground

9.   32/64 external inputs(32 inputs per channel group)

10. 4/8 output contacts (4 per channel group)

11. 18/36 analog inputs (18 per channel group) - non isolated

12. Power supply 48/125/250 Vdc, 120 Vac nominal 
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1 Overview
Front View (model 2000/P)

Figure 1.3:  Portable Front View
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1 Overview
Physical Mounting
The recorder is 3 rack units or 5.25 inches high and approximately 12 inches 
deep. The standard recorder is designed for a 19-inch rack. For a complete me-
chanical drawing see “TESLA Mechanical Drawing” in Appendix F.
To install the recorder you need the following:
   •  19 inch rack
   •  4 - #10 screws

Power Supply
ERLPhase recorders come with a wide range power supply. The nominal op-
erating range is 48–250 Vdc, 120 Vac, 50/60 Hz. To protect against possible 
short circuit in the supply use an inline fuse or circuit breaker with a 5 A rating. 
Make the chassis ground connection to ensure proper operation and safety. 
There are no power switches on the TESLA rack mount. When power is ap-
plied, the recorder starts its initialization process and takes about 40 seconds to 
complete showing the green Recorder Functional LED.
A power switch on the TESLA portable is used to select a dc or ac power sup-
ply source and turn off the power supply.

Case Grounding

You must ground the recorder to station ground using the case-grounding ter-
minal at the back of the recorder (see Figure 1.2: Rear View).

48 Vdc Wetting 
Supply

TESLA Portable (model 2000/P) has a dc wetting supply capable of turning on 
one or all 32 external inputs. The power switch controls the wetting supply and 
must be turned on before the wetting supply becomes operational. To protect 
against possible short circuits the output is fused with a user-serviceable 1/4 A, 
125 Vdc fuse located on the front panel.

WARNING!

To ensure safety and proper operation you must connect the record-
er to the station ground using the rear grounding terminal on the re-
corder.

Ground the recorder even when testing.

Do not rely on the rack mounting screws to provide case grounding.
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2 TESLA Control Panel Setup

PC System Requirements
Install TESLA Control Panel software on a standard desktop or laptop PC run-
ning Windows 95, 98, ME, NT 4.0, 2000 and XP.

Hardware The minimum hardware requirements are: 
   •  Any 486 or greater processor
   •  64 MB of available RAM
   •  50–75 MB of available hard-disk space (60 MB recommended)
   •  VGA monitor
   •  CD-ROM drive
   •  A modem and/or serial communication port and/or LAN card 

Operating System The following software must be installed and functional prior to installing 
TESLA Control Panel: 
   •  Microsoft Windows 95, 98, ME, NT 4.0, 2000 or XP.
   •  Windows Dial-up Networking 
   •  Windows TCP/IP protocol 

Installing TESLA Control Panel
Basic Steps Instructions for installing TESLA Control Panel and configuring Windows for 

its use are covered in the following sections. 
The basic steps are: 
1   Set up Windows’ Dial-Up Networking and TCP/IP, if not previously ena-

bled.
2   Install TESLA Control Panel. 
3   Install the Null Modem driver. 
4   Create Windows Dial-Up Network definitions for modem and direct serial 

connections. 
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2 TESLA Control Panel Setup
Configuring Windows
Setting Up 
Windows’ Dial-Up 
Networking and 
TCP/IP

TESLA Control Panel software uses the Windows’ Dial-Up Networking and 
the TCP/IP communication protocol. These functions must be enabled on your 
PC to run TESLA Control Panel. This section helps you check and enable these 
functions if required. Separate instructions are provided for Windows 95/98, 
2000, NT and XP.

Windows 95/98 
Setup

Figure 2.1:  Windows 95/98 Setup

1   Determine if your computer has Dial-Up Networking installed by double-
clicking the My Computer icon and looking for a folder called Dial-Up Net-
working. If it is not there, complete the following steps to install it:

a  Double-click My Computer>Control Panel>Add/Remove Pro-
grams. 

b  Select the Windows Setup tab: highlight Communications.
c  Select Details and check mark Dial-Up Networking.
d  Select OK, then OK again (insert your Win 95/98 CD-ROM if 

prompted).
e  Select Yes when prompted to restart.

Step a - My Computer >

Control Panel>Add/Remove 

Programs

Step b - Select tab Windows 

Setup, then Communications

Step c - Select Details, check

Dial-Up Networking, OK and

OK again.
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2 TESLA Control Panel Setup
2   Double-click the My Computer>Control Panel>Network icon. 

Figure 2.2:  Verify Dial-Up Adapter

3   Verify that Dial-Up Adapter is in the list of installed components. If not:
a  Select Add, highlight Adapter and select Add again. 
b  Highlight Microsoft, then highlight Dial-Up Adapter and select OK. 

4   In the Network Control Panel screen, verify that TCP/IP is installed (TCP/
IP>Dial-Up Adapter is in the list of installed components). 
If not:

a  Select Add, highlight Protocol and select on Add again. 
b  Highlight Microsoft, then highlight TCP/IP and select OK. 
c  Select OK (insert your Win 95/98 CD-ROM if prompted). 
d  Select Yes when prompted to restart.

Step a - Select Add

Highlight Adapter,

Select Add and OK

Step b - Highlight Microsoft,

then Dial-Up Adapter and OK.

Step 2 - My Computer >

Control Panel>Network Icon
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Windows NT 4.0 
Setup

1   Determine if your computer has Dial-Up Networking installed by double-
clicking the My Computer icon and looking for a folder called Dial-Up Net-
working. If it is not there, complete the following steps to install it: 

a  Select Start>Programs>Accessories>Dial-Up Networking. 
b  Select Install. 
c  When prompted, type the location of the Windows NT 4.0 installa-

tion files. If you are directing the install process to an NT Worksta-
tion, select the installation Windows NT CD-ROM and browse to 
the “I386” directory. 

d  After the installation select Continue, and restart when prompted.
NB. If you were not prompted to install, Dial-Up Networking has already been 
installed. 
2   Double-click the My Computer>Control Panel>Network icon. 
3   Select the Protocol tab. If TCP/IP does not appear in the Network Protocols 

list then: 
a  Select Add. 
b  Double-click the TCP/IP protocol. 
c  Enter the path to the Windows NT CD-ROM, then select OK. 

Windows 2000/XP 
Setup

Dial-up networking is always installed in Windows 2000/XP.

Installing TESLA Control Panel Software from CD-ROM
1   Insert the TESLA CD-ROM in your drive. 
2   The CD-ROM should start automatically. If it doesn’t, go to Windows Ex-

plorer and run the “CD.exe” file at the root of the CD-ROM directory (usu-
ally D drive).

3   To install TESLA Control Panel software on your computer, select the TES-
LA Disturbance Recorder icon, then the Install TESLA Control Panel.

4    The Control Panel installation program starts automatically, but may take 
a few minutes. 

5   During installation a prompt appears asking whether your TESLA recorders 
are 50 Hz or 60 Hz units. For proper operation it is important to select the 
correct one. If you need to change this in the future, install TESLA Control 
Panel again.

6   When the installation is complete, a TESLA Control Panel icon is placed on 
your desktop. Use the icon to launch Control Panel. 
If you prefer, the icon can be deleted and you can start Control Panel 
through Windows Start menu (Start>Programs>NxtPhase/TESLA Control 
Panel). 
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2 TESLA Control Panel Setup
Installing Null Modem Driver Software 
A virtual software modem called a “Null Modem” must be set up for direct se-
rial cable communication with the recorder. A Null Modem driver is provided 
with the TESLA installation CD-ROM.
This section provides step by step instructions on how to install the Null Mo-
dem driver. 

Null Modem Driver 
Installation 
(Windows XP)

1   Start Windows Control Panel by going to Start>Control Panel.
2   Double-click the Phone and Modem Options icon.
3   Select the Modems tab. Select Add to open the Add Hardware Wizard.
4   Select Don't detect my modem; I will select it from a list, then select the Next 

button.

Figure 2.3:  Null Modem Driver Installation

5   Select the Have Disk button, select Browse. To find the file go to c:\Pro-
gram Files\NxtPhase\TESLA Control Panel\Null_mdm.inf. Select OK. This 
is the default location for TESLA Control Panel. If you selected a different 
location to install TESLA Control Panel, you will find the Null Modem 
driver (null_mdm.inf) in that directory.

Step 1 - Start>Settings>Control Panel.
Step 2 - Double-click Modems icon.

Step 3 - Add

Step 4 - Select Don't detect my modem; 
I will select it from a list. 
Select Next.
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2 TESLA Control Panel Setup
Figure 2.4:  Browse for Null_mdm.inf

6   Select the Generic Null Modem driver and select Next. If you are given more 
than one option, select the one that has the most recent date associated with 
it. 

7   Select the serial port you wish to use. You are setting up a serial port to be 
used for a direct cable connection to a TESLA. Typically COM1 or COM2 
are available on a PC for this purpose. Select Next. 

Figure 2.5:  

Figure 2.6:  Select Serial Port

You will get a message stating “Digital Signature Not Found” and asking 
“Do you want to continue the installation?” Select Continue Anyway to con-
tinue. 
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2 TESLA Control Panel Setup
You will get a message saying, “Your modem has been set up successful-
ly”.

8   Select Finish and close the Phone and Modem Options and Control Panel 
dialog boxes.

Null Modem Driver 
Installation 
(Windows 2000)

1   Start Windows Control Panel by going to the Start>Settings>Control Pan-
el.

2   Double-click the Phone and Modem Options icon.
3   Select the Modems tab. Select Add to open the Add/Remove Hardware Wiz-

ard.
4   Select Don't detect my modem; I will select it from a list, then select the Next 

button.

Figure 2.7:  Null Modem Driver Installation

5   Select the Have Disk button, select Browse. To find the file go to c:\Pro-
gram Files\NxtPhase\TESLA Control Panel\Null_mdm.inf. Select OK. This 
is the default location for TESLA Control Panel. If you selected a different 
location to install TESLA Control Panel, you will find the Null Modem 
driver (null_mdm.inf) in that directory.

Step 1 - Start>Settings>Control Panel.
Step 2 - Double-click Modems icon.

Step 3 - Add

Step 4 - Select Don't detect my modem; 
I will select it from a list. 
Select Next.
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2 TESLA Control Panel Setup
Figure 2.8:  Browse for Null_mdm.inf

6   Select the Generic Null Modem driver and select Next. If you are given more 
than one option, select the one that has the most recent date associated with 
it. 

7   Select the serial port you wish to use. You are setting up a serial port to be 
used for a direct cable connection to a TESLA. Typically COM1 or COM2 
are available on a PC for this purpose. Select Next.

Figure 2.9:  Select Serial Port

You may get a message stating “Digital Signature Not Found” and asking 
“Do you want to continue the installation?” Select Continue Anyway to 
continue. 
You will get a message saying, “Your modem has been set up successful-
ly”.

8   Select Finish to close the Add/Remove Hardware Wizard and close the 
Phone and Modem Options and Control Panel dialog boxes.
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2 TESLA Control Panel Setup
Null Modem Driver 
Installation 
(Windows NT)

1   Start Windows Control Panel by going to the Start>Settings>Control Pan-
el.

2   Double-click the Modems icon.
3   Select Add to open the Install New Modem dialog box.
4   Select Don't detect my modem; I will select it from a list, then select the Next 

button.

Figure 2.10:  Null Modem Driver Installation

5   Select the Have Disk button, select Browse. To find the file go to c:\Pro-
gram Files\NxtPhase\TESLA Control Panel\Null_mdm.inf. Select OK. This 
is the default location for TESLA Control Panel. If you selected a different 
location to install TESLA Control Panel, you will find the Null Modem 
driver (null_mdm.inf) in that directory.

Step 1 - Start>Settings>Control Panel.
Step 2 - Double-click Modems icon.

Step 3 - Add

Step 4 - Select Don't detect my modem; 
I will select it from a list. 
Select Next.
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2 TESLA Control Panel Setup
Figure 2.11:  Browse for Null_mdm.inf

6   Select the Generic Null Modem driver and select Next. If you are given more 
than one option, select the one that has the most recent date associated with 
it. 

7   Select the serial port you wish to use. You are setting up a serial port to be 
used for a direct cable connection to a TESLA. Typically COM1 or COM2 
are available on a PC for this purpose. Select Next. You will get a message 
saying, “Your modem has been set up successfully”.

Figure 2.12:  Select Serial Port

8   Select Finish to close the Install New Modem dialog box and close the Mo-
dems and Control Panel dialog boxes.
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Null Modem Driver 
Installation 
(Windows 95/98)

1   Start Windows Control Panel by going to the Start>Settings>Control Pan-
el.

2   Double-click the Modems icon.
3   Select Add to open the Install New Modem dialog box.
4   Select Don't detect my modem; I will select it from a list, then select the Next 

button.

Figure 2.13:  Null Modem Driver Installation

5   Select the Have Disk button, select Browse. To find the file go to c:\Pro-
gram Files\NxtPhase\TESLA Control Panel\Null_mdm.inf. Select OK. This 
is the default location for TESLA Control Panel. If you selected a different 
location to install TESLA Control Panel, you will find the Null Modem 
driver (null_mdm.inf) in that directory.

Step 1 - Start>Settings>Control Panel.
Step 2 - Double-click Modems icon.

Step 3 - Add

Step 4 - Select Don't detect my modem; 
I will select it from a list. 
Select Next.
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2 TESLA Control Panel Setup
Figure 2.14:  Browse for Null_mdm.inf

6   Select the Generic Null Modem driver and select Next. If you are given more 
than one option, select the one that has the most recent date associated with 
it. 

7   Select the serial port you wish to use. You are setting up a serial port to be 
used for a direct cable connection to a TESLA. Typically COM1 or COM2 
are available on a PC for this purpose. Select Next. 

Figure 2.15:  Select Serial Port

In Windows 98 you may get a message saying “The file Null_mdm.cat can-
not be found”. Select the Skip File button. You will get a message saying, 
“Your modem has been set up successfully”.

8   Select Finish to close the Install New Modem dialog box and close the Mo-
dems and Control Panel dialog boxes.
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2 TESLA Control Panel Setup
Dial-up Network Connections (DUN)
Windows’ Dial-Up Networks (DUN) are used to communicate with a recorder 
through your computer’s modem or serial port. 
This section takes you through the steps required to create two Dial-Up config-
urations: 
   •  APT_SERIAL for communication with a recorder via a serial cable (using 

the Null Modem installed in the previous section).
   •  APT_MODEM for communication with a recorder via your computer’s 

modem.

Windows 95/98
Windows 95/98 
APT_SERIAL Dial-
Up Network

To set up APT_SERIAL Dial-Up Networking:
1   Double-click the My Computer icon on your desktop, then double-click the 

Dial-Up Networking icon. 
2   Double-click the Make New Connection icon. 
3   Change the name “My Connection” to APT_SERIAL. The name must be 

exactly APT_SERIAL. 
4   Choose Generic NULL Modem under Select a device and select Next. 

Figure 2.16:  Windows 95/98 APT_SERIAL Dial-Up Network Connection 

Step 1 - Double-click My Computer

and Dial-Up Networking

Step 2 - Double-click

Make New Connection.

Step 3 - Change name to APT_SERIAL.

Step 4 - Choose Generic Null Modem. Step 5 - Select Area Code, Country Code

and enter 1 as Phone Number.

Step 6 - Select Next and Finish.
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2 TESLA Control Panel Setup
5   Select the proper Area Code and Country Code from the list, and enter 1 as 
the Phone Number. 

6   Select Next, then Finish. 
You should see the APT_SERIAL icon or text in Dial-Up Networking dia-
log box.

Figure 2.17:  Windows 95/98 Dial-Up Networking showing the new APT_SERIAL con-
nection 

7   Select APT_SERIAL icon, right-click to select Properties.
8   Select on the Server Types tab and set the Server Type settings. For Type of 

Dial-Up Server select PPP, Internet, Windows NT Server, Windows 98. If 
necessary, click the downward arrow to select Type of Dial-Up Server. 
Older versions of Windows have a Server Type button rather than a tab. 
Not all versions will have the Multilink tab; it is not necessary. Use the Ad-
vanced option settings and Allowed network protocols as shown in Figure 
2.18: Windows 95/98 Server Type Settings.

Figure 2.18:  Windows 95/98 Server Type Settings 

9   The default TCP/IP Settings should be used. “Server assigned IP address,” 
“Server assigned name server address,” “Use IP header compression,” and 
“Use default gateway on remote network” should be selected. Select OK.
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2 TESLA Control Panel Setup
10   Select on the Scripting tab and set the Scripting settings. Use the Browse 
button to find the file tesla.scp in c:\Program Files\Accessories. Select 
OK.

Figure 2.19:  Windows 95/98 Scripting Type Settings

11   On some versions of Windows, this dialog box looks for script files in oth-
er directories. To handle this, copy the tesla.scp file from c:\Program 
Files\Accessories to the required location. 

12   Select OK to complete the installation of the APT_SERIAL Dial-Up Net-
working connection.

13   In the Windows Control Panel (Start>Settings>Control Panel), double-
click to choose Modems. 

14   With Generic Null Modem highlighted, select Properties to view the Ge-
neric Null Modem Properties dialog box and set the baud rate to 38,400. 
Select OK. 

15   This sets up the baud rate for the null modem. The baud rate can be set at 
rates up to 115,200; 38,400 is the default baud rate of the recorder’s front 
panel. If you wish to change baud rates in the future, both the baud rate 
specified here and that set on the recorder must be changed (see “Commu-
nication Port Settings” on page 5-3).

16   Select Close to close the Modems Properties dialog box. 
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Figure 2.20:  Windows 95/98 Generic Null Modem Properties 

Windows 95/98 
APT_MODEM Dial-
Up Network

Repeat the previous steps 1 to 14 to set up APT_MODEM Dial-up Networking 
(see “Windows 95/98 APT_SERIAL Dial-Up Network” on page 2-13) except 
do the following:
   •  Use the name APT_MODEM instead of APT_SERIAL
   •  You may wish to set a higher baud rate in Step 14. When a modem is used, 

this setting only determines the speed of communication between your PC 
and the modem.

   •  Select the particular modem installed on your PC when setting up 
APT_MODEM.
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Windows NT
Windows NT 
APT_SERIAL Dial-
Up Network

To set up APT_SERIAL Dial-Up Networking:
1   Double-click the My Computer icon on your desktop, double-click the Con-

trol Panel icon, then double-click the Dial-up Networking connections 
icon. 

2   When the Dial-up Networking dialog box appears, click New.

Figure 2.21:  Windows NT New Phonebook Entry

3   Edit the Name the Phonebook Entry to APT_SERIAL. The name must be 
exactly APT_SERIAL. Click Next.

4   Select “I am calling the Internet” as the server. Click Next.

Figure 2.22:  Windows NT Server
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2 TESLA Control Panel Setup
5   Enter 1 as the phone number and click Next.

Figure 2.23:  Windows NT Phone Number

6   Select Finish when complete.
7   In the Dial-up Networking dialog box, select APT_SERIAL Phonebook en-

try and select More> Edit Entry and Modem properties.

Figure 2.24:  Windows NT Dial-up Networking - Edit entry and modem properties

8   In the Edit Phonebook entry window select the Com Port to connect the re-
corder. Select Configure and set the initial speed to 38,400 bps. Select OK.
This sets up the baud rate for the null modem. The baud rate can be set at 
rates up to 115,200; 38,400 is the default baud rate of the recorder’s front 
panel. If you wish to change baud rates in the future, both the baud rate 
specified here and that set on the recorder must be changed (see “Commu-
nication Port Settings” on page 5-3). 

1

1
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Figure 2.25:  Windows NT Modem Configuration

9   Select the Script tab, select Run this script and select tesla.scp and OK.

Figure 2.26:  Windows NT Edit Phonebook Entry

10   Select Close to finish setting up APT_SERIAL.

Windows NT 
APT_MODEM Dial-
Up Network

Repeat the previous steps 1 to 10 to set up APT_MODEM Dial-up Networking 
(see “Windows NT APT_SERIAL Dial-Up Network” on page 2-17) except:
   •  Use the name APT_MODEM instead of APT_SERIAL
   •  You may wish to set a higher baud rate in Step 8. When a modem is used, 

this setting only determines the speed of communication between your PC 
and the modem.
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Windows 2000
Windows 2000 
APT_SERIAL Dial-
Up Network

To set up APT_SERIAL Dial-Up Networking:
1   Double-click the My Computer icon on your desktop, double-click the Con-

trol Panel icon, then double-click the Network and Dial-up connections 
icon. 

2   When the Network Connection Wizard dialog box appears, click Next. (The 
Network Connection Wizard dialog box is available only if no previous 
dial-up connection exists.) Otherwise double-click the Make New Connec-
tion icon to bring up the Network Connection Wizard dialog box, click 
Next. 

3   Select Dial-up to private network and click Next.

Figure 2.27:  Windows 2000 Network Connection Type

4   Select the Modem-Generic Null Modem for the comm port that you wish to 
use for direct serial connection to the TESLA Recorder; uncheck all other 
check boxes; and click Next.

Figure 2.28:  Windows 2000 Select a Device
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5   When prompted for a phone number, enter 1 and click Next.
6   For Connection Availability select For all users and click Next.

Figure 2.29:  Windows 2000 Connection Availability

7   When the Completing the Network Connection Wizard dialog box appears, 
replace the name “Dial-up Connection” with APT_SERIAL. The name 
must be exactly APT_SERIAL. Click Finish.

Figure 2.30:  Windows 2000 Completing the Network Connection Availability
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8   A Connect APT_SERIAL dialog box appears; select Cancel to close the 
box.

Figure 2.31:  Windows 2000 Connect APT_SERIAL

9   In Network and Dial-up Connections>APT_SERIAL, right-click to bring 
up the Properties dialog box.

Figure 2.32:  Windows 2000 Select Modem

10   With Generic Null Modem highlighted, select Configure to view the Ge-
neric Modem Configuration dialog box and set the maximum speed to 
38,400. Select OK. 

1

1
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This sets up the baud rate for the null modem. The baud rate can be set at 
rates up to 115,200; 38,400 is the default baud rate of the recorder’s front 
panel. If you wish to change baud rates in the future, both the baud rate 
specified here and that set on the recorder must be changed (see “Commu-
nication Port Settings” on page 5-3). 

11   Select the Options tab of Figure 2.32: Windows 2000 Select Modem. 

Figure 2.33:  Windows 2000 Options

12   Select the Security tab, check the Run Script box; in the Run Script list se-
lect the file tesla.scp.

Figure 2.34:  Windows 2000 Security
Release Date: 2008 February 08 TESLA User Manual 2000 2-23



2 TESLA Control Panel Setup
13   Select the Networking tab.

Figure 2.35:  Windows 2000 Networking

14   Select the Sharing tab.

Figure 2.36:  Windows 2000 Sharing

15   Click OK to apply the setting to APT_SERIAL properties and close the 
APT_SERIAL dialog box.
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Windows 2000 
APT_MODEM Dial-
Up Network

Repeat the previous steps 1 to 15 to set up APT_MODEM Dial-up Networking 
(see “Windows 2000 APT_SERIAL Dial-Up Network” on page 2-20) except 
do the following:
   •  Use the name APT_MODEM instead of APT_SERIAL
   •  Select the particular modem installed on your PC, shown in Figure 2.28: 

Windows 2000 Select a Device.
   •  You may wish to set a higher baud rate, shown in Step 10. When a modem 

is used, this setting determines the speed of communication between your 
PC and the modem.

You must have a modem installed before you start this section.
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Windows XP 
APT_SERIAL Dial-
Up Network

To set up APT_SERIAL Dial-Up Networking:
1   Double-click the My Computer icon on your desktop, double-click the Con-

trol Panel icon, then double-click the Network Connections icon. 
2   Double-click the New Connection Wizard icon to bring up the New Con-

nection Wizard dialog box, click Next. 
3   Select Connect to the network at my workplace and click Next.
4   Select Dial-up Connection and click Next.
5   Enter the name APT_SERIAL exactly, click Next.

Figure 2.37:  Windows XP Network Connection Type

6   When prompted for a phone number, enter 1 and click Next.
7   For Connection Availability select Anyone’s use and click Next.

Figure 2.38:  Windows XP Connection Availability
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8   When the Completing the Network Connection Wizard dialog box appears, 
click Finish.

Figure 2.39:  Windows XP Completing the New Connection Wizard

9   A Connect APT_SERIAL dialog box appears; select Cancel to close the 
box.

Figure 2.40:  Windows XP Connect APT_SERIAL

10   In Network Connections>APT_SERIAL, right-click to bring up the Prop-
erties dialog box.

1
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Figure 2.41:  Windows XP Select Modem

11   With Generic Null Modem highlighted, select Configure to view the Ge-
neric Modem Configuration dialog box and set the maximum speed to 
38,400. Select OK. 
This sets up the baud rate for the null modem. The baud rate can be set at 
rates up to 115,200; 38,400 is the default baud rate of the recorder’s front 
panel. If you wish to change baud rates in the future, both the baud rate 
specified here and that set on the recorder must be changed (see “Commu-
nication Port Settings” on page 5-3). 

12   Select the Options tab of  Figure 2.41: Windows XP Select Modem on page 
2-28. 

1
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Figure 2.42:  Windows XP Options

13   Select the Security tab, check the Run Script box; in the Run Script list se-
lect the file tesla.scp.

Figure 2.43:  Windows XP Security
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14   Select the Networking tab.

Figure 2.44:  Windows XP Networking

15   Select the Advanced tab.

Figure 2.45:  Windows XP Advanced

16   Click OK to apply the setting to APT_SERIAL properties and close the 
APT_SERIAL dialog box.
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Windows XP 
APT_MODEM Dial-
Up Network

Repeat the previous steps 1 to 16 to set up APT_MODEM Dial-up Networking 
(see “Windows XP APT_SERIAL Dial-Up Network” on page 2-26) except do 
the following:
   •  Use the name APT_MODEM instead of APT_SERIAL
   •  Select the particular modem installed on your PC, shown in  Figure 2.41: 

Windows XP Select Modem on page 2-28.
   •  You may wish to set a higher baud rate, shown in Step 11. When a modem 

is used, this setting determines the speed of communication between your 
PC and the modem.

First Time Start-Up
Starting TESLA 
Control Panel

To start TESLA Control Panel, double-click the TESLA Control Panel icon 
placed on your desktop by the installation process or select Start>Program 
Files>NxtPhase>TESLA Control Panel.

Data Location TESLA Control Panel uses a data location on your computer to store records 
and settings from your recorders. By default it is C:\Program Files\Nxt-
Phase\Data, although you may change this later by using the File\Data Loca-
tion command from the main menu.

Figure 2.46:  Data Location

You must have a modem installed before you start this section.

When you change the data location, previously configured IEDs will 
not be affected. Only newly created IEDs will use the new data loca-
tion. To edit the data location of existing IEDs use the Main Menu Edit 
button.
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3 Connecting to the Recorder

Communication Ports for Recorder
The TESLA recorder has multiple communication ports for local and remote 
access to the user interface and SCADA services. For port pin-out and cabling 
information see “Communication Port Details” on page 3-15.

Figure 3.1:  Communication Port Summary

Port Description

Port 1 RS-232 Data Communication Equipment (DCE) female DB9.
Used for user interface access via a direct serial connection.
Default Setting: 38,400 baud, 8 data bits, no parity, 1 stop bit.

Port 2 RS-232 DCE female DB9. 
Used for:
User interface access via a direct serial connection.
User interface access via an external modem. The optional 
ERLPhase Modem Adapter converts this port to a Data Ter-
minal Equipment (DTE) to simplify connection to an external 
modem.
Default Setting: 9,600 baud, 8 data bits, no parity, 1 stop bit.
N.B. Port 2 is disabled if the recorder is equipped with an 
internal modem (see Port 5).

Port 3 RS-232 DCE female DB9.
Used for SCADA communication.
Default Setting: 9,600 baud, 8 data bits, no parity, 1 stop bit.

Port 5 RJ-11/RJ-45 receptacle.
When equipped with optional internal modem:
Used for user interface access via modem.
When equipped with optional internal Ethernet card:
User interface access.
DNP SCADA access.
Default Ethernet IP address: 192.168.1.100.

Port 1

Recorder Functional

IRIG-B Functional

Recorder Triggered

Records Stored

Test Mode

Alarm

Model 2000
Disturbance Recorder

www.erlphase.com

TESLA

Analog Inputs (±2.5V)

External Inputs 

Analog Inputs 

Output
Contacts (1-4)

Output
Contacts (5-8)

External Inputs 

Port 2Port 5 Port 3

Port 1

ERL PHASE
Power Technologies Ltd
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3 Connecting to the Recorder
Communication Ports for Portable Recorder
The TESLA Portable Recorder has multiple communication ports for local and 
remote access to the user interface and SCADA services. For port pin-out and 
cabling information see “Communication Port Details” on page 3-15.

Figure 3.2:  Communication Port Summary

Port Description

Port 1 RS-232 Data Communication Equipment (DCE) female DB9.
Used for user interface access via a direct serial connection.
Default Setting: 38,400 baud, 8 data bits, no parity, 1 stop bit.

Port 2 RS-232 DCE female DB9. 
Used for:
User interface access via a direct serial connection.
User interface access via an external modem. The optional 
ERLPhase Modem Adapter converts this port to a Data Ter-
minal Equipment (DTE) to simplify connection to an external 
modem.
Default Setting: 9,600 baud, 8 data bits, no parity, 1 stop bit.
N.B. Port 2 is always disabled unless the modem is disabled 
via the maintenance menu, for details see “Maintenance 
Menu” on page 13-4.

Port 3 RS-232 DCE female DB9.
Used for SCADA communication.
Default Setting: 9,600 baud, 8 data bits, no parity, 1 stop bit.

Network RJ-45 receptacle.
Used for user interface access via direct connection.
Used for DNP SCADA access via TCP or UDP.
Default Ethernet IP address: 192.168.1.100.

Modem RJ-11 receptacle.
Used for user access via modem.

Maximum Input Voltage ±2.5 V Low Voltage Analog Module Inputs (±2.5 V @ 1 kW)

gered

Power

OnOff –

48 –

www.erlphase.com System Frequency      

1 2 3 4 5 6 7 8 9 11 12 13 14 15 16 17 18
!

Port 1Network Port 2

IRIG-BModem Port 3

 ttdd
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3 Connecting to the Recorder
Accessing the User Interface 
The recorder’s user interface can be accessed through TESLA Control Panel 
software via a direct serial connection, a modem or an Ethernet LAN. You can 
run Control Panel on any standard PC with a Windows operating system 
(Win95 or later). 

Direct Serial Link

Figure 3.3:  Direct Serial Link

1   Create a direct serial connection between the computer’s serial port and the 
recorder’s Port 1 or Port 2.
   •  Use a standard straight through male-to-female serial cable (provided 

with the recorder). For port pin-out and cabling information see “Com-
munication Port Details” on page 3-15.

   •  Port 2 may not be used if the recorder has an internal modem installed 
unless the modem is disabled via the Maintenance Menu, for details see 
“Maintenance Menu” on page 13-4.

2   Ensure the recorder port and your PC’s port have the same baud rate and 
communication parameters. 
   •  The recorder’s Port 1 and Port 2 serial ports are fixed at 8 data bits, no 

parity and 1 stop bit. 
   •  The default baud rate of Port 1 is 38,400. The default baud rate of Port 

2 is 9,600. 
   •  The baud rate and communication parameters of your computer’s serial 

port is set through the APT_SERIAL Dial-Up Network (see “Setting 
Windows Serial Port Parameters” on page 3-12).

3   Choose the target recorder from the Select IED list in TESLA Control 
Panel’s Main Menu.

Your Windows system must be appropriately configured to run 
TESLA Control Panel (see “TESLA Control Panel Setup” on page 2-
1).

Recorder Functional

IRIG-B Functional

Records Stored

Test Mode

Alarm

Port 1

Port 1 or rear Port 2 

to DB-9 female (laptop)

Serial Extension Cable

Port 2 - direct/modem

Laptop PC

TESLA
Disturbance Reorder 

Model 2000

www.erlphase.com
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3 Connecting to the Recorder
Figure 3.4:  Edit IED

   •  If there is not already an entry for this recorder, create one using the Add 
New button.

   •  The method of communication with the recorder is part of each IED’s 
definition. Use the Edit button to view or change this information. En-
sure the Direct Serial Link option is selected.

   •  For details on IED definitions see “Working with TESLA Control Pan-
el” on page 4-1.

   •  For a quick, first time direct serial connection to a recorder you can use 
the TESLA Demo Unit IED. 

Main Menu

Select IED List

Edit button

Edit IED dialogue box
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3 Connecting to the Recorder
4   Initiate the connection by selecting the Connect button.
   •  A dialog box will appear to show connection progress.

Figure 3.5:  Connect Button Dialog Box

   •  The connection state and the current IED you are connected to is shown on 
the Windows status bar at the bottom of the screen. 

Figure 3.6:  Status Bar

If the connection fails, check the following:
   •  The APT_SERIAL dial-up network has been created and has the correct 

settings (see “TESLA Control Panel Setup” on page 2-1). 
   •  The communication parameters are the same on both ends (see Step 2 

above).
   •  The correct serial port has been selected on your computer.

Status Bar shows Tesla Control Panel 

software is connected to the recorder 

and the name of the Current IED.
Release Date: 2008 February 08 TESLA User Manual 2000 3-5



3 Connecting to the Recorder
Modem Link - 
External

Figure 3.7:  Modem Link - External

Recorder Setup
1   Connect a PC-compatible external serial modem to Port 2 on the rear of the 

recorder. 
   •  The cable between the recorder and the modem requires a crossover and 

a gender change as both devices are configured as RS-232 DCE ports.
   •  You can use the ERLPhase Modem Port Adapter (part # VA-465001) 

to make the recorder’s Port 2 appear as a DTE (like a PC serial port). A 
standard modem cable can then be used to connect to the recorder. 

   •  For port pin-out and cabling information see “Communication Port De-
tails” on page 3-15.

   •  If the unit has an internal modem, Port 2 will be disabled and an external 
modem will not work. 

2   Connect the modem to an analog telephone line or switch and turn it on.
   •  A standard telephone cable with an RJ-11 connector is used. 

3    Configure the recorder’s Port 2 to work with the modem.
   •  Port 2 settings are accessed through the recorder’s standard user inter-

face.
a  Establish a direct serial connection between your computer and Port 

1 on the recorder, run TESLA Control Panel software and initiate a 
connection to the unit. For details, see Direct Serial Link above.

b  When connected, select Utilities in the Main Menu list, and go to the 
Communication tab to access the Port 2’s settings.

External
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Telephone

System
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Telephone 

Line

Modem Adapter VA-465001
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3 Connecting to the Recorder
Figure 3.8:  Communications Setup Utility

c  Set the Baud Rate. This will be the rate at which the recorder will 
communicate with the external modem. It does not control the rate 
at which the modems communicate with each other. Unlike a direct 
serial link, there is no need for this baud rate to match that of the 
remote computer. A rate faster than the modem’s top speed is rec-
ommended to take full advantage of the modem’s compression ca-
pabilities.

d  Enable the Modem box by checking the modem box.
e  The Modem Initialization String lets you set any special command 

codes required by your modem. The factory default for this field is 
“M0” for external modems. These default values are all that are re-
quired for most modems.

f  Save your changes and disconnect.

TESLA Control Panel Setup
1   Configure your computer to work with its modem. Refer to your computer 

and modem documentation.
2   Ensure that an APT_MODEM dial-up network has been created on your 

computer (see “TESLA Control Panel Setup” on page 2-1).

From Main Menu select Utilities,

then the Communication tab.

Enable modem.

Set Baud rate.
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3 Connecting to the Recorder
3   Choose the target recorder from the Select IED list in TESLA Control 
Panel’s Main Menu.
   •  If there is not already an entry for this recorder, create one using the Add 

New button.
   •  The method of communication with the recorder is part of each IED’s 

definition. Use the Edit button to view or change this information. En-
sure the Modem Link option is selected and the telephone number of 
the recorder’s modem is entered.

   •  For details on IED definitions see “Working with TESLA Control Pan-
el” on page 4-1.

4   Initiate the connection by selecting the Connect button
   •  A dialog box will appear to show connection progress.
   •  The connection state and the current IED you are connected to is shown 

on the Windows status bar. 

Modem Link - 
Internal

Figure 3.9:  Modem Link - Internal

An optional internal modem is available for the TESLA recorder. Port 5 on the 
recorder’s rear panel will be labelled “INTERNAL MODEM” if the modem is 
installed. The TESLA Portable includes an internal modem; the modem port is 
labelled “Modem” on the recorder front panel.
Setup for the internal modem is the same as for an external modem (see previ-
ous section) with the following notes:
   •  The modem is internal to the recorder, so there is no external modem to 

connect to Port 2. 
   •  Connect the telephone switch cable to the recorder’s internal modem with 

a standard RJ-11 connector on Port 5 or Modem Port. 
   •  Internal modem configuration is done in the same way as for an external 

modem. Modem Initialization String which is “M0” for internal modems 
(see Figure 3.8: Communications Setup Utility on page 7). 

   •  If the internal modem was installed at the factory, it will already be appro-
priately configured. 

 

When an internal modem is installed, the recorder’s Port 2 is not 
available for use by an external modem or a direct serial connection.

Desktop Computer 
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Telephone 

Line
Port 5 - RJ-11 modem
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3 Connecting to the Recorder
Ethernet LAN Link

Figure 3.10:  Ethernet LAN Link

You can access the recorder’s user interface through an optional Ethernet TCP/
IP LAN. Port 5 on the recorder’s rear panel will be labelled “NETWORK” if 
the Ethernet port is installed. The TESLA Portable includes an internal ether-
net port and is labelled “Network” on the recorder’s front panel.

Recorder Setup
1   Connect recorder’s ethernet port to the ethernet LAN hub using an appro-

priate 10BaseT cable with an RJ-45 connector on Port 5 or Network Port.
   •  The recorder supports 10BaseT, although a dual speed 10/100 Ethernet 

hub or switch can be used. 
2   Modify the IP address.

   •  The default IP address is 192.168.1.100.
   •  To modify or view the IP address, use the recorder’s Maintenance menu 

(see “Maintenance Menu” on page 13-4).
   •  The IP address must not conflict with other devices on your network 

and must be accessible from the computer(s) on which run TESLA 
Control Panel and RecordBase Central Station. If you are unsure what 
IP address to use, consult your network administrator.

TESLA Control Panel Setup 
1   Ensure that the computer running TESLA Control Panel has access to the 

Ethernet network to which the recorder has been connected and has its TCP/
IP protocol enabled.

2   Start TESLA Control Panel.
3   Choose the target recorder from the Select IED list in TESLA Control 

Panel’s Main Menu.
   •  If there is not already an entry for this recorder, create one using the Add 

New button.
   •  The method of communication with the recorder is part of each IED’s 

definition. Use the Edit button to view or change this information. En-
sure the Network Link option is selected and the recorder’s IP address 
is entered.

PC with TCP/IP

Port 5 - RJ-45 

Network

10BaseT
TCP/IP

Network

Recorder Functional

IRIG-B Functional

Records Stored

Test Mode

Alarm

TESLA
Disturbance Reorder 

Model 2000

www.erlphase.com
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3 Connecting to the Recorder
   •  For details on IED definitions see “Working with TESLA Control Pan-
el” on page 4-1.

4   Initiate the connection by selecting the Connect button.
   •  A dialog box will appear to show connection progress.
   •  The connection state and the current IED you are connected to is shown 

on the Windows status bar.

Accessing SCADA Services
The recorder supports DNP3 (Level 2) and Modbus SCADA protocols as stan-
dard features. This section describes how to connect and configure the servic-
es. Protocol details, including point lists, are provided in the appendices. 

Serial Port 
Connection

Both the DNP3 and Modbus protocols are available on the recorder’s serial 
Port 3, a standard RS-232 DCE port with a female DB9 connector. The port is 
wired to support a connection to a PC serial port (or equivalent) using a stan-
dard straight-through male to female serial cable. An external RS-232 to RS-
485 converter can be used to connect to an RS-485 network. For port pin-out 
and cabling information see “Communication Ports for Recorder” on page 3-1.

Ethernet Connection If the recorder is equipped with an Ethernet card, the DNP protocol can made 
available over Ethernet using TCP or UPP. A standard 10BaseT Ethernet cable 
with an RJ-45 jack is required. 
The Ethernet port can support DNP SCADA and user interface access via Con-
trol Panel at the same time. 
For details on setting the IP address of the Ethernet card see “Ethernet LAN 
Link” on page 3-9.

Figure 3.11:  SCADA Protocol

From Main Menu select Utilities,

then the Communication tab.

Port 3 - SCADA
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3 Connecting to the Recorder
Protocol Settings Configuration of the SCADA protocol and communication parameters is made 
through the recorder user interface. Use Control Panel to connect to the record-
er, then go to the SCADA section of the Utilities>Communication tab (see 
“Accessing the User Interface” on page 3-3).

Figure 3.12:  SCADA Protocol Settings

SCADA Configuration

Mode Select one of the available SCADA modes.

Baud Rate Port 3 serial baud rate. Default is 9600.

Parity Port 3 serial parity. 
Note: When parity is set to “None” and a Modbus protocol is selected, 
the number of stop bits automatically is set to 2, as per the Modbus 
standard. 

Stop Bits (Automatic setting). Always set to 1 stop bit except as noted in Parity 
setting above

Data Bits (Automatic setting) The number of data bits is controlled by the 
selected protocol mode. 
Modbus ASCII:   7 data bits
Modbus RTU:     8 data bits
DNP 3:                8 data bits

Slave Address Identifies the unit to the SCADA master.

From Main Menu select Utilities,

then the Communication tab.

Port 3 - SCADA
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3 Connecting to the Recorder
Diagnostics Protocol monitor utilities are available to assist in resolving SCADA commu-
nication difficulties such as incompatible baud rate or addressing. The utilities 
can be accessed through the Maintenance user interface (see “Maintenance 
Menu” on page 13-4).

Setting Windows Serial Port Parameters
This section describes how to change the baud rate of your computer’s serial 
port.

Direct Serial Link To achieve a direct serial link between a serial port on the recorder and one on 
your PC, both ports need to be running with the same communication param-
eters. 
The recorder’s Port 1 and Port 2 communication parameters are:
   •  8 bit data, no parity and 1 stop bit (non-configurable).
   •  Hardware or software flow control (automatically handles either).
   •  The default baud rate of Port 1 is 38,400, Port 2’s default baud rate is 9,600. 

The baud rate for these ports is configured through the recorder’s user in-
terface via TESLA Control Panel software (see “Accessing the User Inter-
face” on page 3-3).

The computer’s serial port communication parameters are set through the 
APT_SERIAL Dial-Up Network, which was created as part of the installation 
of Control Panel software. 

Datalink Timeout (DNP) Specifies the time in which the recorder expects a response 
from the SCADA master to primary frame messages. If a response is 
not received in this time, the recorder will re-transmit the message. 
The timeout is usually set to 0 milliseconds per DNP3 Technical Bulle-
tin 9804-002. This document is available from the DNP3 User's Group 
(www.dnp.org)
For UDP and TCP modes, the timeout is not settable and is automati-
cally set to 0 milliseconds.

Master IP Address (DNP TCP or UDP) Defines the IP address of the master SCADA 
device that will be polling the TESLA. This prevents unauthorized mas-
ter devices from communicating with the TESLA.
Note: This setting does not control IP address of the TESLA’s Ethernet 
card. That is done through the recorder's Maintenance Menu. 
Make sure the Master IP Address is different from the TESLA IP 
Address.

Port DNP TCP or UDP) Defines the TCP or UDP port on which the DNP 
service may be accessed. Usually set to 20000.

SCADA Configuration
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3 Connecting to the Recorder
Windows 95/98

Figure 3.13:  Windows 95/98 

1   Access the APT_SERIAL Dial-Up Network icon by double-clicking My 
Computer on the Windows desktop and then double-clicking on Dial-Up 
Networking.

2   Bring up the APT_SERIAL properties control by right-clicking on the 
APT_SERIAL icon and selecting Properties.

3   Select the Configure button and set the desired baud rate in the Maximum 
Speed field. To set other communication parameters, use the Connections 
tab.

4   Select OK to save changes

Step 1 - Double-click My Computer.

Double-click Dial-Up Networking.

Step 2 - Right-click APT_SERIAL

and select Properties.

Step 3 - Select Configure

and set Maximum Speed.

Step 4 - Select OK.
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3 Connecting to the Recorder
Windows NT 1   Access the APT_SERIAL Dial-Up Network icon by double-clicking My 
Computer on the Windows desktop and then double-clicking on Dial-Up 
Networking.

2   Select APT_SERIAL from the pick list
3   Select the More button and pick Edit Entry and Modem Properties from the 

list.
4   Select the Configure button and set the desired baud rate in the Speed field. 
5   Select OK to save changes
NB. Other communication parameters such as the number of data bits cannot 
be set here. The recorder’s communication parameters are standard (8, N, 1), 
so changes to these parameters on your computer’s port are unlikely to be 
needed. If you do need to view or modify them, use the Modems function found 
in Windows Control Panel.

Windows 2000 1   Access the Network and Dial Up Connections function through Windows 
Control Panel. 

2   Bring up the APT_SERIAL properties control by right-clicking on the 
APT_SERIAL icon and selecting Properties 

3   Select Modem - Generic Null Modem from the Connect using modem list 
and select the Configure button.

4   Set the desired baud rate in the Maximum Speed field.
5   Select OK to save changes
NB. Other communication parameters such as the number of data bits cannot 
be set here. The recorder’s communication parameters are standard (8, N, 1), 
so changes to these parameters on your computer’s port are unlikely to be 
needed. If you do need to view or modify them, use the Phone and Modem Op-
tions function found in Windows Control Panel, and go to the Modems tab.
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3 Connecting to the Recorder
Communication Port Details
All recorder serial ports (Ports 1, 2 and 3) are configured as EIA RS-232 DCE 
devices with female DB9 connectors. This allows them to be connected direct-
ly to a PC serial port with a standard straight-through male-to-female serial ca-
ble. 
A modem adapter (part # VA-465001) is available to convert a port into a DTE 
device, equivalent to the serial port on a PC. The adapter allows you connect 
an external modem to the recorder’s Port 2 using a standard modem cable. 

TESLA Recorder

TESLA Portable

Port Location Function

1 Front Panel Serial port for direct connection to a computer. Default baud rate 
set at 38,400 baud.

2 Rear Panel Serial port for connection to an external modem or for direct con-
nection to a computer (configurable). Default baud rate set at 
9,600 baud. 
This port is unused when the recorder is equipped with the 
optional internal modem unless the modem is disabled via the 
Maintenance Menu.

3 Rear Panel Connection to SCADA (DNP3 or Modbus) interface. Default baud 
rate set at 9,600 baud.

Port
Location
(Portable 
Recorder)

Function

1 Front Panel Serial port for direct connection to a computer. Default baud rate 
set at 38,400 baud.

2 Front Panel Serial port for connection to an external modem or for direct con-
nection to a computer (configurable). Default baud rate set at 
9,600 baud. 
This port is unused unless the internal modem is disabled via the 
Maintenance Menu.

3 Front Panel Connection to SCADA (DNP3 or Modbus) interface. Default baud 
rate set at 9,600 baud.
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3 Connecting to the Recorder
Notes:
   •  IED is DCE, PC is DTE.
   •  Pins 1 and 6 are tied together internal to the IED.

Signal Name Direction
PC<->IED Pin # on the IED Port

DCD ← 1 

RxD ← 2

TxD → 3

DTR → 4

Common 5

DSR ← 6

RTS → 7

CTS ← 8

No connection 9

Male DB-9 Cable End for IED 
Port

Female DB-9 Cable End for 
Computer Port 

Pin # on Cable Pin # on Cable

1 1

2 2

3 3

4 4

5 5

6 6

7 7

8 8

9 9

Signal Name Direction
Modem <-> IED

Pin # on the Modem 
Adapter

DCD → 1 

RxD → 2

TxD ← 3
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3 Connecting to the Recorder
Notes:
   •  IED (with modem adapter) is DTE, modem is DCE.
   •  Pins 1 and 6 are tied together internal to the IED.

DTR ← 4

Common 5

DSR → 6

RTS ← 7

CTS → 8

No connection 9

Signal Name Direction
Modem <-> IED

Pin # on the Modem 
Adapter
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4 Working with TESLA Control Panel

Recorder Workspace
TESLA Control Panel supports multiple recorders. Each recorder has its own 
workspace within Control Panel. That workspace stores its communications 
parameters, records and configuration files. 

When first installed, TESLA Control Panel includes a workspace for a recorder 
called TESLA Demo Unit. It contains sample records and configuration files. 
It is configured to allow direct serial connection with an evaluation unit.

Selecting A 
Recorder 
Workspace 

To work with a particular recorder first select its corresponding recorder work-
space in TESLA Control Panel from the Select IED box on the Main Menu tab. 
Use the pull-down list to display and select the desired recorder. 

Figure 4.1:  Selecting a Recorder Workspace 

Create a separate recorder workspace for each individual recorder.

Main Menu

Current IED

Select IED - 
TESLA Demo Unit

Connect - connect
to a recorder.

Edit - change recorder
information.

Delete - delete
recorder from list.

Add New - add new 
recorder to list

Connection Status - 
Connected or
Not Connected
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4 Working with TESLA Control Panel
The Current IED Selecting a recorder sets TESLA Control Panel’s focus to that recorder’s work-
space, known as the Current IED. The records and configuration files belong 
to the selected recorder. 
If you tell TESLA Control Panel to initiate a connection, it connects to the cur-
rent IED using the communication parameters specified for this IED. 

TESLA Control Panel assumes that the recorder it is communicating with is 
the one identified as the Current IED. Forcing a connection with a different re-
corder (e.g. via a direct serial cable), causes the records and configuration files 
of that recorder to be mixed with those of the Current IED. 

Adding/Editing a Recorder Workspace Definition
Recorder work spaces are added, modified or deleted from the TESLA Control 
Panel Main Menu using controls in the Select IED dialog box. The Edit button 
displays the selected recorder’s definition screen. The Add New button is used 
to create a new recorder definition (see Figure 4.1: Selecting a Recorder Work-
space).

Figure 4.2:  Adding/Editing a Recorder Workspace Definition 

The name of the Current IED is always displayed in the Status Bar at 
the bottom of the TESLA Control Panel window (see Figure 4.1: Se-
lecting a Recorder Workspace).

IED Definition - IED Name, Comments, Location,
IED Serial Number, No. of Channel Groups, IP Address

Communication - 
choose from
   Direct Serial Link
   Modem Link
   Network Link

IP Address

Get Information From IED - 
retieves information from a recorder.
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4 Working with TESLA Control Panel
For further information on the Communication link setup see “Connecting to 
the Recorder” on page 3-1 and for the IP address setup see “Maintenance 
Menu” on page 13-4.

Add New IED...

IED Definition

IED Name The IED Name is the name you assign to this recorder’s workspace. It 
appears in the IED selection and the Current IED display at the bottom 
of the TESLA Control Panel window.
We recommend that you use the same name for this workspace as the 
Unit Name given to the recorder (see “Unit Identification” on page 52).

Comments User-defined, for your reference only.

Location User-defined, for your reference only.

IED Serial Number Enter the IED Serial Number to match the serial number of the actual 
recorder.

No. of Channel 
Groups

Refers to the hardware configuration of the recorder. A Channel Group 
consists of 18 analog and 32 digital inputs. TESLA recorders come 
with either 1 or 2 Channel Groups. 

IP Address If the Network Link is used, the IP address of the recorder must be 
specified.

Get Information 
from IED

Connecting to the recorder this function automatically retrieves infor-
mation such as the IED name and location. The automatic retrieval 
function happens only after the communication parameters have been 
set.

Communication Determines the way Control Panel communicates with the recorder.

Direct Serial Link Connection to a recorder through a serial cable.

Modem Link Connection to the recorder via telephone link. 

Network Link Connection to the recorder via TCP/IP network connection. 

Phone Number If modem link is used, insert telephone number in the Phone Number 
field. It can contain numbers plus standard modem dial characters 
(e.g. comma represents a pause).

Folder Placement

Recordings Folder The path where the IED records are stored.

Configs Folder The path where the IED configs are stored.
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4 Working with TESLA Control Panel
Online and Offline Operation
TESLA Control Panel can be used with or without a connection to the selected 
recorder. Both offline and online modes work within the recorder workspace 
you have selected as the Current IED. 

Offline Manage and display a recorder’s local (previously uploaded) records and its 
configuration files without having a communications link with the unit. 

Online Obtain full access to all functions:
   •  Records—records (both local and on the recorder)
   •  Trends
   •  Events 
   •  Metering—a live metering display 
   •  Utilities and record configuration screens 
   •  Channel and trigger configurations (the one presently active in the recorder 

and any saved ones you may have created) 
   •  Record graphics display 

Connection Status The Status Bar at the bottom right side of the TESLA Control Panel window 
shows if you are presently online or offline.
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4 Working with TESLA Control Panel
Navigating in TESLA Control Panel
TESLA Control Panel uses a split screen format. The left pane/tree is used for 
navigation or selection. The right pane is the working area for each of the pro-
gram’s main sections. To bring up the Control Tabs, shown below, you must 
select on the appropriate item on the Navigation Tree.

Figure 4.3:  TESLA Control Panel Display Sections Navigation Tree

The left pane provides a means of moving between TESLA Control Panel 
functions or selecting items within a function (e.g. channels from a record). 
For example, in the Main Menu choose the TESLA Control Panel functions—
Records, Trend, Events, Metering, Utilities and Configuration are activated by 
a double-click. 
You can optimize the screen space between the tree and the working area to 
create a larger working area. Some screens have a Hide Tree button to maxi-
mize the working area.

Working Area The Working Area on the right pane of the display represents the main working 
area of each section of the TESLA Control Panel. 

Control Tabs The Control Tabs are a row of selection tabs near the bottom of the screen. 
Each time you start a section of the TESLA Control Panel software creates a 
corresponding tab.
Select the control tabs to navigate from one screen to another or the Main Menu 
item. Use the Close button to close the screen. 

Status Bar The Status Bar at the bottom of the TESLA Control Panel displays the name of 
the selected recorder workspace and the status of the connections.

Navigation Tree Working Area

Re-Size Bar

Control Tabs Status Bar

Select Item
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5 Recorder Setup Utilities

The TESLA recorder has global setup parameters that establish its identity and 
define its operation. Setup parameters define: 
   •  Unit identification 
   •  Communication ports
   •  Recording settings 
   •  Time display and settings
   •  Analog Input Calibration
   •  Notify (RecordBase Server users only)
   •  Password protection

Figure 5.1:  Recorder Setup Utilities

The Setup parameters are accessed with the Utilities function of the 
TESLA Control Panel, if Control Panel is communicating with the re-
corder.

For details on connecting to the recorder using TESLA Control Panel 
software see “Connecting to the Recorder” on page 3-1.

v3.5
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5 Recorder Setup Utilities
Unit Identification
The Unit Identification tab identifies a particular recorder and its records. Dou-
ble-click Utilities to bring up the tabs; select Unit Identification. 

Figure 5.2:  Recorder Setup Utilities - Unit Identification 

Unit Identification

Identification

Serial Number Read-only field, displays the serial number of the TESLA unit currently 
connected.

Unit ID User-entered field that identifies the unit. It is part of the name given to 
records produced by the unit and identifies their origin. 
By convention, this name should be the same as the one used to name 
the recorder and recorder’s workspace on the Main Menu. The names 
must not contain the following: “,” “/” “\” “:” or any other character not 
valid for a Windows file name. 

IED Firmware Ver-
sion

Read-only field that displays the firmware version of the currently con-
nected TESLA unit.

Required Settings 
Version

Describes the version of the settings file required by the connected 
recorder. Control Panel is capable of creating older versions of settings 
files for use with recorders whose firmware has not been updated (see 
“Managing Configuration Files” on page 63).

Communication 
Version

Read-only field that displays the firmware version of the currently con-
nected TESLA unit.

System Frequency Read-only field that displays the system frequency.

Station

Station Name User-defined, for your reference only.

Station Number User-defined, for your reference only.

Location User-defined, for your reference only.
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Communication Port Settings
The Communication settings control the modes and baud rates of the record-
er’s three serial communication ports. When equipped with an internal network 
card, the IP address of the TESLA is changed using the maintenance login (see 
“Maintenance Menu” on page 13-4).

Figure 5.3:  Recorder Setup Utilities - Communication Ports 

Communication

Service Port

The service port is a DB-9 serial port (Port 1) and is used for direct connection to a computer 
running TESLA Control Panel user interface software.

Baud Rate Sets the baud rate of the port. Default baud rate set at 38,400 baud. 
The baud rate must be the same as that used by the serial port of the 
computer connected to this port. For details about changing the baud 
rate see “Setting Windows Serial Port Parameters” on page 3-12.

Direct/Modem Port

The direct/modem port can either be the DB-9 serial port (Port 2) or the RJ11 (Port 5) depend-
ing on whether or not an internal modem is installed and enabled. When an internal modem is 
not installed or disabled (see “Maintenance Menu” on page 13-4 to enable/disable the internal 
modem) Port 2 is active and may be used for direct connection like Port 1, or can be config-
ured to connect to an external modem. When an internal modem is installed and enabled, Port 
2 is inactive and a telephone connection to the RJ11 Port can be made. 

Port Select Selects the port and function of the rear user port. If an internal modem 
is not installed or not enabled, Port 2 can be used for direct serial con-
nection or for connection to an external modem. If an internal modem 
is installed and enabled, the internal modem must be selected. 
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For details regarding the data and functions available on the TESLA recorder’s 
SCADA port see “Modbus Functions” in Appendix D and “DNP3 Reference” 
in Appendix E.

Baud Rate Sets the baud rate of the port. If configured for direct connection, the 
baud rate must be the same as that used by the serial port of the com-
puter connected to Port 2, for details about changing the baud rate see 
“Setting Windows Serial Port Parameters” on page 3-12. Default baud 
rate is set at 9,600 baud. When configured as a modem port, the baud 
rate specifies the rate at which the recorder communicates with the 
modem. The actual communication rate between the two modems is 
less than or equal to this setting, depending on what the modems can 
negotiate over the phone line. The slower default baud rate provides a 
means of establishing an initial direct serial connection to the recorder 
in cases where the computer running TESLA Control Panel is unable 
to communicate at high rates. You can increase the rate if a modem is 
used or if your computer is able to handle higher direct serial baud 
rates.

Modem Initializa-
tion String

When using a modem, an optional modem initialization string can be 
entered containing modem control codes. Refer to your modem man-
ual for details.

SCADA

The SCADA protocols can be accessed via either the DB-9 serial port (Port 3) or the RJ-45 
(Port 5). If no Ethernet card is installed or if Modbus ASCII, Modbus RTU or DNP3 Level 2 is 
selected, Port 3 is used. If an Ethernet card is installed and either DNP3 Level 2 - TCP or 
DNP3 Level 2 - UDP are selected, SCADA can be accessed via ethernet. The factory config-
uration for SCADA is 9,600 baud, no parity, Modbus ASCII mode, Slave Address 1.

Mode This selects the SCADA protocol. DNP3 Level 2 - TCP and UDP are 
only available if an Ethernet card is installed

Baud Rate and 
Parity

Must be set the same as the master device on the SCADA network. 
The number of data bits is determined by the protocol and mode; Mod-
bus ASCII uses 7 bits, Modbus Binary and DNP3 Level 2 use 8 bits.

Slave Address The slave address must be set to an unused address value on the 
SCADA network and is used by the master to communicate with the 
TESLA. The slave address range is automatically adjusted to the valid 
range for the protocol selected.

Datalink Timeout Used only for DNP3 Level 2. This sets the timeout for the DataLink 
layer of the DNP protocol. Although configurable, the timeout should 
be disabled as per the DNP Users Group “Technical Bulletin 9804-002 
DNP Confirmation and Retry Guidelines”. The DataLink Timeout is 
automatically disabled when using either DNP3 Level 2 - TCP or UDP.

Master IP Address For either DNP3 Level 2 - TCP or UDP, the Master IP Address must be 
set to the IP address of the master device that will be polling the 
TESLA. This prevents unauthorized master devices from communicat-
ing with the TESLA.

Port For either DNP3 Level 2 - TCP or UDP, the Port is the TCP or UDP 
port that the DNP service may be accessed at and is usually set to 
20000.
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5 Recorder Setup Utilities
Recording Settings
The Recording Settings control the parameters of the High Speed Recording, 
Low Speed Recording and Trend Logging.
For High Speed and Low Speed Recording the TESLA recorder can create up 
to three records simultaneously. The TESLA employs sophisticated trigger 
combination algorithms used to combine data from multiple events into a sin-
gle record and also to reduce the amount of redundant data in the records. In 
addition, the TESLA will combine data captured using multiple time-frames 
into a single record.
In the TESLA there are two modes of capturing data; Edge Recording and Du-
ration Recording. Both modes are available for High Speed Recording, only 
Edge Recording is available for Low Speed Recording.

Edge Mode

Figure 5.4:  Recorder Setup Utilities - Edge Recording 

In Edge Recording, the rising edge of the trigger is used to create a record that 
has a set amount of pre-trigger data and a set amount of post-trigger. This is 
known as a normal length record. If another trigger is processed while the 
record is being created, the record may be extended to the full normal length 
of data associated with the new trigger. Multiple extensions can occur up to the 
Maximum Record Length limit. Records with combined High Speed and Low 
Speed data can only be extended during the High Speed data capture portion 
of the record.
Edge Recording mode tends to create smaller records that contain useful fault 
data around the start of the trigger, but may not capture data for the entire du-
ration of the trigger.
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Duration Mode

Figure 5.5:  Recorder Setup Utilities - Duration Recording 

In Duration Recording, the duration of the trigger is used to create a record that 
has a set amount of pre-trigger data, continues to record while the trigger is ac-
tive and then records a set amount of post-trigger data. If a trigger remains ac-
tive, the TESLA stops recording once the Maximum Record Length limit is 
reached. When a subsequent trigger is processed while the record is being cre-
ated, it will be combined with the first trigger using a logical OR operation as 
long as it is not near to the maximum record length limit. If the trigger is pro-
cessed near the end of the record, a new overlapping record will be created in-
stead of combining the triggers. Records with combined High Speed and Low 
Speed data can only be combined during the High Speed data capture portion 
of the record.
Duration Recording mode captures all the data during the fault trigger, but 
tends to create larger records that may contain unimportant data. 
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5 Recorder Setup Utilities
Recording

Accumulation Mode Selects whether to overwrite (“recycle”) the oldest transient or 
swing data when the disk space is full. If stop is selected, the 
recording stops when the disk space is full.

Alarm when recording 
space is

When enabled, you can enter a limit giving the percentage of 
recording space that causes an alarm condition. Enter a number 
between 60 and 90.

High Speed Recording

Trigger Mode Edge Recording Duration Recording

Sample Rate Samples at 5760 samples/second (96 samples/cycle) producing 
record lengths of a few seconds to capture transient fault condi-
tions

Pre-trigger Time The length of data that is 
recorded prior to the trigger 
time

The length of data that is 
recorded prior to the trigger 
time

Normal Record Length The length of the record includ-
ing pre-trigger data, without any 
record extensions

N/A

Post-trigger Time N/A The length of data that is cap-
tured after the falling edge of 
trigger event 

Maximum Record 
Length

The maximum length of the 
record including pre-trigger, 
post-trigger and extensions

The maximum length of the 
record including pre-trigger, trig-
ger and post-trigger

Low Speed Recording

Trigger Mode Edge Recording

Sample Rate Samples at 60 samples/second (1 sample/cycle) producing record 
lengths of a few minutes to capture slower system dynamic swings

Normal Record Length Determines the total duration of each recording under single trigger 
conditions and includes the pre-trigger time

Pre-trigger Time The length of data that is recorded prior to the trigger time

Max. Extended 
Record Length

The maximum length of the record including pre-trigger, post-trig-
ger and extensions

Trends Records at intervals of 10 seconds to 1 hour are configured for any 
analog input channel, harmonic, THD, summation, sequence com-
ponent, MW, Mvar, frequency or Z
Controls the trending operation by showing the status of the trend-
ing function and the configured recording rate
Allows you to select trend alarm option strategy to follow when the 
trending area is full and operation of the trend almost full alarm
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5 Recorder Setup Utilities
Status Current state of the trending function. The trending function has 
four states
Active
Stopped—trending has stopped because the trend data accumula-
tion area is full and Stop when full option is selected
Unconfigured—trending has not been specified in the current oper-
ating configuration; specified in the setting file (see “Trends” on 
page 7-31).
Unavailable—the firmware on the TESLA recorder requires an 
update in order to support the trending process

Sample Rate Indicates the trending interval in seconds; specified in the setting 
file (see “Trends” on page 7-31).

Accumulation Mode Selects whether to overwrite (“recycle”) the oldest trending data 
when the amount of accumulated trend data exceeds the maxi-
mum. If Stop is selected, trending stops when the accumulated 
data area is full

Alarm after data col-
lected for

When enabled, you can enter a limit giving the number of days of 
accumulated trend information that causes an alarm condition. 
Enter a number of days between 10 and 90.

Recording
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Time Display and Settings
The Time Control tab displays the recorder’s current time and provides con-
trols to describe the IRIG-B time signal input. In the absence of an IRIG-B in-
put there is a facility to set the time manually.

Figure 5.6:  Recorder Setup Utilities - Time Control 

Time

IED Time is 
displayed as

UTC Universal Coordinated Time (UTC) is consistent worldwide.
Changes the time offset used by the recorder; does not change the 
recorder’s time.

Local Time Local Time has the appropriate time zone time offset applied (e.g. 6 
hours for Central Standard Time), but no DST.
Changes the time offset used by the recorder; does not change the 
recorder’s time.

Local Time with 
DST

Local Time with Daylight Savings Time (DST) is local time with one 
hour of DST compensation added from 2 AM on the first Sunday in 
April until 2 AM on the last Sunday in October. 
Changes the time offset used by the recorder; does not change the 
recorder’s time.

Present Time When connected to a recorder, the recorder’s present time is shown 
and continually updated.

Sync/No Sync  Indicates whether the recorder is presently synchronized to an IRIG-B 
time signal input.

Incoming IRIG 
Signal Properties

These settings determine how the recorder responds to IEEE 1344 
information in the IRIG-B time signal, if it is present. 

Use IEEE 1344 If 
Present

If Use IEEE 1344 if Present is checked, the recorder obtains its offset 
to UTC from the IEEE 1344 code on the IRIG-B time signal, if it is 
available. If IEEE 1344 is not present on the IRIG-B time signal, the 
recorder will use the manually entered offset to UTC. 

Do not use IEEE 
1344

If Do Not Use IEEE 1344 is selected, the mode of the IRIG-B signal 
must be specified as either UTC, Local Time or Local Time with DST.
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Analog Input Calibration
The Analog Input Calibration utility provides a means of calibrating the 
TESLA recorder’s analog input channels (see “Analog Input Calibration” on 
page 8-5).

Notify
The TESLA recorder has the capability of calling RecordBase Central Station 
via modem or LAN to notify it of selected events. 
Notification is used for two purposes:
1   To initiate cross-triggering of dynamic swing records on other recorders 

through the RecordBase central station. 
2   To initiate record transfer to RecordBase when a new record is created. 
The Notify tab of the Utilities screen contains settings to control the dial-out 
process and the initiation of record transfers. 

Figure 5.7:  Notify Communication Strategy

Manually Set IED 
Time

Allows the recorder’s clock to be manually set, if an IRIG-B signal is 
not present. If an IRIG-B signal is present, but does not contain IEEE 
1344 data, the year can be set manually. 

Recorder Time 
Zone Setting

Provides the offset from local time to UTC in hours. This value is used 
for local time display when Local Time is selected for display.

Determine Recording
Priority
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Setting Trigger 
Priorities

Notify Communication Strategy

Connect Using The TESLA recorder can be set to notify RecordBase via 
modem, LAN, or to not notify at all. These 3 options are mutually 
exclusive. Note that the availability of these controls is depend-
ent on the specific hardware and firmware configuration of your 
particular TESLA recorder.

Modem If Modem is selected, enter the telephone number of the Record-
Base call-in modem. All standard modem dialing characters are 
supported (e.g. a comma is used to specify a pause in the dialing 
sequence).

LAN If LAN is selected, enter the IP address of the computer running 
RecordBase Server. 

Do Not Connect If Do Not Connect is selected, the TESLA recorder will not notify 
RecordBase server of new records or cross triggers. This is a 
global setting and can be used to temporarily disable notification.

Retry Attempts These rules are applied when the TESLA recorder fails to estab-
lish communication with RecordBase Server (i.e. if the phone 
line is busy, or if the network is down).

Maximum Attempts When the TESLA recorder fails to establish contact with Record-
Base Server, this is the maximum number of attempts it will 
make before giving up.

Delay Between Attempts This is the delay, in seconds, that the TESLA will wait before 
making another notification attempt.

Notify on creation of 
new Recording if Priority 
is at least

Brings up a drop-down menu that determines when the recorder 
should call its RecordBase central station to report a new record. 
The setting specifies the minimum record priority that will cause 
the recorder to send a New Record notification message to 
RecordBase. When a record is created with a priority equal to, or 
greater than value specified in the drop-down box, the recorder 
will send a New Record Created notification message to Record-
Base. 
For reference, the priority of a record is calculated by taking the 
maximum priority of the events contained in the record. 

Control of cross trigger notification calls is handled through the con-
figuration of individual trigger detectors (see “Triggers” on page 7-
28).

Event Outcome

Triggers (Channel Configuration)
Assign priority 0 to 3, highest is 3.

The priority is assigned to the record.

Record (Utilities)
Each trigger has a different priority. Record 
priority is the priority of the triggers in the 
record with the highest priority.

When the record is created, TESLA notifies 
RecordBase that the record has been made.
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Notify
Notify on creation of new record in record pri-
ority selection of Utility/Notify Screen. Select 
notify priority if record priority is a least (3 or 
less) for notification to RecordBase of new 
record.

When notified RecordBase establishes a 
connection to the TESLA and takes appropri-
ate action (such as down loading the record).

Control of trigger priorities is handled throughout the configuration of 
individual trigger detectors (see “Triggers” on page 7-28).
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Password Protection
Access to various TESLA functions can be protected through the use of pass-
words. 

Figure 5.8:  Passwords

There are three user access levels: VIEW, CHANGE and SERVICE. 

Setting Passwords Passwords can be viewed and set through the Passwords tab of TESLA Con-
trol Panel’s Utilities screen.
You have the option of explicitly disabling the password protection for each 
access level. Leaving the VIEW access level password disabled, for example, 
will allow free use of the TESLA for read-only operation. 

The Password tab can only be accessed when connected via direct 
serial link through the recorder’s service port (Port 1). This provides 
protection from unauthorized remote access while ensuring that on-
site staff can freely use the recorder.
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Function Required Access Level

Records Display Record List from IED VIEW

Delete Record from IED CHANGE

Create Fault or Swing Record VIEW

Rename Local Record None

Display Local Record List None

Delete Local Record None

Trends

Delete Trends (local) None

Delete Trends on IED CHANGE

Download Trends VIEW

Display Trends None

Event Log VIEW

Events Display Event Log VIEW

Erase Event Log CHANGE

Metering Metering Display VIEW

Utilities Display Unit Identification VIEW

Set Unit Identification CHANGE

Display Communication Settings VIEW

Set Communication Settings CHANGE

Display Recording Settings VIEW

Set Recording Settings CHANGE

Display Time & Settings VIEW

Set Time & Settings CHANGE

Display Calibration VIEW

Save Calibration Changes SERVICE

Configuration Display Configurations (Online) VIEW

Display Configurations (Offline) None

Load Configuration to IED CHANGE

Save Local Configuration None

Delete Local Configuration None
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6 Managing Configuration Files

Managing Configuration Files
The recorder’s configuration is controlled by a configuration file stored in the 
recorder’s non-volatile memory. TESLA Control Panel is used to create and 
manage configuration files and handle transfers to and from the recorder. 
Recorder configurations are managed through the Config Edit screen which 
can be started by double-clicking the Configuration line in the left pane of the 
Main Menu screen. 
The configurations shown in the Config Edit screen are those that apply to your 
selected Current IED. To work with configurations from another recorder, you 
must first select that unit as the Current IED (from the Main Menu). 

Figure 6.1:  IED Configuration Manager

Recorders with older firmware may require older versions of configu-
ration files. The Configuration Editor creates configuration files with 
older setting versions and converts existing configuration files be-
tween versions (see “Settings Version” on page 7-4).

If you attempt to load an incompatible configuration version to a re-
corder, Control Panel will give you the option of converting the file un-
less the version of Control Panel does not support the required 
setting version. In that case you must update the version of Control 
Panel installed on your computer.

The settings version required by a recorder is shown in the Utilities/
Unit Identification screen. (This applies only to firmware v2.0 and 
Control Panel v2.0 or greater; earlier releases all require Settings 
Version 1). If the settings version is not shown, you should update 
your own version of Control Panel.
Release Date: 2008 February 08 TESLA User Manual 2000 6-1



6 Managing Configuration Files
Working Directly 
with the IED’s 
Present 
Configuration

Figure 6.2:  Present Configuration

If a communication link to the Current IED is available, you can work directly 
with the recorder’s configuration in three ways. 
1   Double-click on the Present Settings item in the list
2   Select Present Settings and use the Edit button to automatically transfer the 

configuration and bring it up in the Configuration Editor. When you close 
the Configuration Editor, the configuration can be automatically loaded 
back to the recorder. This gives you a quick way to make changes on the fly. 

3   Choose to transfer the recorder’s configuration to a saved file using the Get 
from IED button. When transferred, the configuration appears in the Saved 
Settings list. This feature maintains a copy of the configuration and makes 
changes that you might not want to immediately load to the recorder. 

Working with Saved 
Configurations 

Figure 6.3:  Saved Configurations

Saved configuration files are shown under the Saved Settings heading in the 
list. Control Panel can store many saved configuration files, limited only by 
hard disk and Windows operating system constraints. 
Saved configuration files can be created, displayed and modified, copied, re-
named, deleted or loaded into the recorder. Select the desired configuration 
from the Saved Settings list by selecting on it, then select the appropriate but-
ton on the right of the screen. Double-clicking on a configuration is equivalent 
to hitting the Edit button. 

Present Settings

Saved Settings

New Configuration
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6 Managing Configuration Files
Creating a New 
Configuration

Use the New button to create a new configuration file.

Using Another 
Recorder’s 
Configuration as a 
Starting Point 

You can use the Copy from Other IED button to create a configuration for the 
current IED based on an existing one from another recorder. 

Available Channel Types and Triggers
Analog Input 
Channels (18 per 
Channel Group) 

The TESLA’s analog input channels are sampled at 96 samples per cycle and 
converted into phasor quantities. The individual sample points are recorded for 
transient fault conditions and phasors are recorded for dynamic swing condi-
tions. The Analog Input channel processing can also produce THD calculations 
and selected single harmonic magnitude for triggering purposes.
Triggers are available for: 

High magnitude
Low magnitude
Negative rate of change
Positive rate of change 
Single harmonic magnitude 
THD magnitude
Sag
Swell 

External Input 
Channels (32 per 
Channel Group) 

The external inputs are sampled at the same rate as the analog channels (96 
samples per cycle). The individual sample points are recorded for transient 
fault conditions. 
Triggers are available for: 

Positive edge transition 
Negative edge transition
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Summation 
Channels (15 per 
Channel Group) 

TESLA continuously evaluates the analog input phasor quantities. Summation 
combines individual analog inputs to create a summed phasor quantity. Each 
input can be scaled and rotated to create the appropriate summation channel, in 
addition the previously combined summation channels can be used as an input 
to a new summation channel. You can easily create station totalized current 
channels that are the sum total of the individual phases. With an 18 channel 
TESLA you can monitor three bus voltages and the phase currents of five lines. 
Summating the individual phase currents and combining them with the bus 
voltage allows you to create a station totalized watt/vars signal of the combined 
phase currents for each of the lines.
Triggers available for:

High magnitude
Low magnitude
Negative rate of change
Positive rate of change

Sequence Channels 
(6 per Channel 
Group) 

TESLA provides the specialized processing associated with sequence compo-
nents as a function which you may specify. A sequence function calculates 
positive, negative, and zero sequence components in one step. The positive se-
quence component may also be used as an input to a watts/vars or impedance 
function. 
Triggers are available for: 

Positive sequence high magnitude
Positive sequence low magnitude
Positive sequence negative rate of change
Positive sequence positive rate of change
Negative sequence high magnitude
Zero sequence high magnitude

Watts/Vars Channels 
(9 per Channel 
Group) 

A watts/vars function in TESLA calculates apparent power (volt-amps), real 
power (watts) and reactive power (vars) for one voltage input and one current 
input. If you specify analog inputs as inputs to the watts/vars function you may 
calculate watts and vars on a single-phase basis. If you specify a positive se-
quence voltage and a positive sequence current as the function inputs, you may 
calculate three-phase volt-amps, watts and vars. 
Triggers are available for: 

Watts: high level Detector 1/Detector 2
Watts: low level Detector 1/Detector 2
Watts: positive rate of change Detector 1/Detector 2
Watts: negative rate of change Detector 1/Detector 2
Vars: high level 
Vars: Low level 
Vars: positive rate of change
Vars: negative rate of change
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Impedance 
Channels (9 per 
Channel Group) 

An impedance function may be applied in a similar manner to a watts/vars 
function. The resulting impedance value is not intended for impedance record-
ing, but the trajectory of the calculated value may indicate a swing condition 
of interest. 
Triggering is based on the rate of impedance within a defined impedance circle 
centered around the origin. 

Frequency Channels 
(1 per Channel 
Group) 

A frequency function measures the frequency of the analog input of your 
choice.
Triggers are available for:

High magnitude
Low magnitude
Negative rate of change
Positive rate of change 

Logic Channels (15/
channel group) 

A logic function performs a chain of logical operations (AND, OR, etc.) on in-
dividual external (external inputs) and internal (detectors, other logics) TRUE/
FALSE values within the recorder. 
Triggers are available for: 

Transition to asserted (ON) state 
Transition to unasserted (OFF) state 

Fault Locators 
Channels (5/channel 
group) 

A fault locator monitors 3 voltage phases and 3 current phases continuously. 
When a user-configurable event occurs, the fault locator assesses the distance 
to fault using the user-supplied line parameters. If one or more of the imped-
ances is consistent with a fault on the line, fault identification (e.g. B-G) and 
location information is generated in the form of an event message. In addition, 
the information is made available on the SCADA channel.

Power Factor 
Channels (9/channel 
group)

A power factor channel monitors the power and reactive power values calcu-
lated by a watts/vars channel and triggers depending on total power level. In-
ductive power factor is defined as a situation where the calculated reactive 
power and real power are of the same sign. Capacitive power factor is defined 
as a situation where the reactive power and real power are of opposite signs. 
Separate triggers are available for:

Inductive power factor – Low magnitude
Capacitive power factor– Low magnitude
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6 Managing Configuration Files
Phase Angle 
Metering Reference

The TESLA recorder can have two channel groups (configuration dependent) 
installed on one recorder. Each channel has 18 analog and 32 external input 
channels. A recorder with two channel groups thus has a total capacity of 36 
analog channels and 64 external input channels.
The angle of each of the calculated phasors in a channel group is referenced to 
a single analog channel, designated as the angle reference channel. Earlier 
TESLA recoders use the first analog channel in each channel group as the an-
gle reference channel. Beginning with firmware version 3.1, the angle refer-
ence channel used for each channel group is configurable, and may be selected 
from any ac channel (for best results use a voltage channel). 

Circular Storage The event log stores up to 250 events with automatic overwrite the oldest 
event. The trending module, accessed through the “logging tab”, preserves the 
daily events, up to 1000 events can be saved in the daily trend log.

Planning Your Configuration
With the amount of real input and calculated channels available to the user, it 
is useful to plan the channel setups and naming convention used in your con-
figuration. The following section describes the configuration approach used in 
setting up a TESLA recorder.

Channel Groups

Figure 6.4:  Channel Group 1

The TESLA recorder can have two channel groups (configuration dependent) 
installed on one recorder. Each channel has 18 analog and 32 external input 
channels. A recorder with two channel groups thus has a total capacity of 36 
analog channels and 64 external input channels.
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6 Managing Configuration Files
It is important that the number of channel groups specified in the Control Pan-
el’s IED Definition matches the capabilities of the actual recorder. The number 
of channel groups is defined as part of the IED’s workspace. 

Grouping by Power 
System Element

An effective way to organize the many channels available on the recorder is to 
group them by the power system element they are monitoring. 
The Configuration Editor allows you to identify each element by name and use 
this element name to group and identify the analog, digital and calculated chan-
nels associated with it. 
For example, if you have a transmission line named A6B, you can define the 
element as “Line A6B.” The channels associated with that element might then 
be: 

Line A6B:Va 
Line A6B:Vb 
Line A6B:Vc 
Line A6B:Ia 
Line A6B:Ib 
Line A6B:Ic 

External inputs (digital) can also be reasonably associated with the A6B line: 
Line A6B:EI:BRK12_a 
Line A6B:EI:21N_Trip 

Calculated channels fit the model as well: 
Line A6B:W/V:Watts (watts) 
Line A6B:W/V:Vars (vars) 
Line A6B:Iseq: (sequence components)

Channel Group Analog Channels External Inputs

1 1-18 1-32

2 19-36 33-64

A channel group is associated with a DSP processor in the recorder. 
Each DSP processor works independently and has access only to its 
own channels. For this reason, you must ensure that your channels 
are organized so that calculated channels (e.g. summations) and 
their corresponding input channels are contained within the same 
channel group.
Release Date: 2008 February 08 TESLA User Manual 2000 6-7



6 Managing Configuration Files
Channel Types and 
Naming 

An understanding of how the TESLA creates and uses channel names is help-
ful to producing an optimal configuration. 
The TESLA structures channel names into three parts: 

Element Name (10 chars) 

Free-form text describing the power system element associ-
ated with this channel (e.g. Line A6B). Channels that are log-
ically related can be grouped through the use of the same 
element name.

Channel Type Standardized channel type descriptors are automatically gen-
erated when you select the channel type. 

Channel Type Examples Va Phase A voltage

Ic Phase C current

In Neutral current 

Vac Generic AC voltage 

DC DC voltage or current

EI External inputs 

Vseq Sequence component set (pos, neg, zero)

VaSum Summation of Phase A voltages 

W/V Watts/vars set

PF Power factor

Z1 Impedance

Logic Logic function

FLoc Fault locator

Frequency Frequency (one per channel group)

Description (optional) (12 
chars)

Often the combination of the Element Name and the Channel 
Type is sufficient to fully identify a channel (e.g. Line A6B:Va). 
In other cases, the Description is required to clarify the 
channel name. (e.g. You might name an external input 
channel as “Line A6B:EI:BRK 23 Open.”).
Free-form text available for additional descriptive information 
on a channel.
The Element, Channel Type and Description fields are 
combined to produce the full channel name: 
Element:Type:Description.
This is the name that will appear beside a channel when it is 
graphed. 
The recorder’s Event Log uses this format when generating 
log messages. For example: 2000 Jan 12 20:44:33.672 
LineA6B.EI.BRK23 open.
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7 The Configuration Editor

If you have not already done so, read “Planning Your Configuration” on 
page 6-6 to gain an understanding of how the TESLA names and organizes 
channels.
The Configuration Editor provides the means to create, display and modify 
configurations for the recorder. The Configuration Editor is part of Control 
Panel. 
The screen pictures shown in this section are from the sample configuration 
file ConfigDemo provided as part of Control Panel installation. We recom-
mend that you run this configuration as you read this section. 

Figure 7.1:  Unit Identification
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7 The Configuration Editor
Figure 7.2:  TESLA Configuration Editor

Navigation through Configuration Settings
The list tree in the left pane is used to navigate through the configuration. Se-
lecting an item in the tree shifts the large right pane view to the appropriate top-
ic.
The tree can be viewed in two ways, the Element Tree or the Channel Tree. The 
title at the top of the tree designates which tree is visible. To change to the al-
ternate view select the bottom tab Show Channel/Element Tree.
The Close button is available to you when you are finished viewing or making 
changes to the Settings. If you made changes, the text on the Close button 
changes to Save/Close as a reminder that Control Panel gives you an opportu-
nity to save your changes to a file (or send them to the IED) before closing the 
Configuration Editor.
Double-clicking on a tree branch in the left pane that has a small “+” to its left 
or selecting on the “+” itself expands or collapses the tree.
A right-click in the editor provides you with options appropriate to your 
present context. For example, you can create a new element by selecting the 
appropriate channel group, right-clicking and selecting Add Element. Alterna-
tively, the same function is in the Config menu.

Left Pane Right Pane

Meter Groups

Trend

Add new element or function by
right-clicking on the item and
choose from the pop-up box.

Drop-Down Menus

Toggle to choose Element 
Tree or Channel Tree.
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7 The Configuration Editor
Main Branches
Identification Screen The Identification view provides information about the selected IED and the 

particular configuration file being edited. Most of the information is drawn 
from the IED Definition and is provided to identify the target recorder (see 
“Adding/Editing a Recorder Workspace Definition” on page 4-2).
In the Comments section you can enter a description of the configuration for 
reference purposes. This description is also displayed in the configuration 
management screen to identify saved configuration files.

Channel Group 1 
Channel Group 2

Depending on the number of channels in the recorder, the tree presents one or 
two channel groups. Expand a channel group branch to access individual ele-
ment and channel definitions.

Meter Groups The main editor tree also has a branch for meter groups (see “Meter Groups” 
on page 7-30).

Trend The main editor shows a branch for trends if your settings version is 4 and 
above (see “Trends” on page 7-31).
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7 The Configuration Editor
Settings Version
Recorders with older firmware may require older versions of configuration 
files. The Configuration Editor creates older configuration file versions and au-
tomatically converts between different versions. 
The version of a configuration file is controlled through the Settings Version 
field in the main identification screen (see Figure 7.2: TESLA Configuration 
Editor). Changing the Setting Version automatically converts the configura-
tion file to the selected Settings Version. If the conversion results in the loss of 
settings from the file (i.e. the target version does not support functions which 
were enabled in the original), a list of the affected settings is displayed and you 
have the choice of cancelling the conversion or continuing. If you choose to 
close the configuration file without saving, the conversion is also abandoned. 
A new configuration file is set to the latest Setting Version by default. To cre-
ate a new configuration file for an recorder with older firmware, set the Setting 
Version appropriately after opening the new file.

To Determine the 
Required Settings 
Version

Figure 7.3:  Determine Settings Version

The settings version required by a TESLA recorder is shown in the Unit Iden-
tification screen of the Utilities menu. You must be connected to the recorder 
to view this information. 
If the settings version is not shown in this screen, you should update your own 
version of Control Panel. Earlier versions of TESLA and Control Panel do not 
report the required settings version. TESLA firmware earlier than v2.0 always 
requires settings Version 1. TESLA Control Panel software earlier than v2.0 
always creates settings Version 1.
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7 The Configuration Editor
Auto-Check and 
Convert When 
Loading

When you load a configuration file to a recorder, Control Panel first checks that 
the Settings Version is compatible. If it is not, you are given the option of con-
verting the file on the spot. If your version of Control Panel is older than the 
recorder’s firmware and does not support its required Settings Version, you 
need to update your copy of Control Panel. 

Element and Channel Tree Views
The Config Editor presents the recorder channels in two distinct views. The ti-
tle at the top of the tree pane indicates the present viewing mode. The button at 
the bottom of the tree pane lets you switch to the other viewing mode.

Element Tree View 

Figure 7.4:  Element Tree View

The Element Tree View organizes channels by the element names you create. 
Element 1 has been further expanded to show some of the channels associated 
with it, such as Va.

Channel Tree View The Channel Tree View organizes channels by channel type. You can use this 
view to gain an overview of channel usage. Although you can chose to work in 
either view, the Element Tree View is recommended for most operations as it 
provides an automatic way of grouping related channels.

Present viewing mode - 
Element Tree.

Switch between Channel
Tree and Element Tree.
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7 The Configuration Editor
Channel Overview Screens

Figure 7.5:  Channel Group Overview Screen

An overview of elements and channel settings is available by selecting a chan-
nel group, element or channel type from the tree. You can edit individual pa-
rameters in the overview display.
Use the Channel Group Overview screen to choose the Angle Reference Chan-
nel for each Channel Group (see “Phase Angle Metering Reference” on 
page 6-6). Choose any analog channel configured as an ac channel, for best re-
sults choose a voltage.
The Channel Group Overview screen shows a listing by element of the allocat-
ed functions. The last line shows functions available to be allocated.
 

Figure 7.6:  Analog Input Channel Configuration Screen
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7 The Configuration Editor
Individual Channel Configuration Screens
The settings for each channel can be displayed in individual screens by select-
ing the specific channel in the tree. Each channel type has its own configuration 
screen with parameters appropriate for its type. 

Adding an Element To add an element in the Element Tree view:
1   Select the desired channel group in the tree. 
2   Right-click and select Add Element from the shortcut menu. 
3   Type the element name and Enter. The typed text replaces the New Element 

text.

Figure 7.7:  Add an Element

For information on settings for triggers and actions see “Triggers” on page 7-
28. For additional information on channel types see “Channel Types and Nam-
ing” on page 6-8.

Step 1 - Select desired 

channel group in tree.

Step 2 - Right-click and

select  Add Element.

Step 3 - Name element

and select Enter. 
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Adding a Channel To add a channel in the Channel Tree view:
1   Select the desired channel group in the tree.
2   Expand the branches in the tree to show the channels for each group.
3   Select the channel number and an input screen appears on the right side.
4   Type in the information required to configure the channel.
5   When you close the screen, you are asked to save the configuration to the 

recorder. Select Save to Recorder.

Figure 7.8:  Adding Analog Input Channels

Chatter Limits
There are chatter limit functions built into the TESLA trigger definition. Chat-
ter limits are applied to all triggers, although separate settings are available for 
External Input channels. The chatter limit function counts the number of 
changes of state that occur within a given period. Any trigger that generates 
more than four changes of state in a user-specified period Chatter Detection 
Window is immediately disabled, and fixed in the inactive state. The chatter 
limit function continues to monitor the number of changes of state, however, 
and while the count of changes of state (in further periods) continues to exceed 
four, the disabled status of the input or trigger continues. The input or trigger 
is re-enabled when the change count is less than four for a user-specified num-
ber of periods Recovery Time.
To access the chatter limits settings, select the Identification>Limits entry in 
the configuration’s main tree view.
Note: Although an External Input triggers may be disabled by a chatter limit 
function, the recording contains the original External Input data.

Step 1 - Select  Analog
Input.

Step 2 - Right-click and
select New Analog Input.

Step 3 - Choose type.
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Storage Alarms
There are record and trend storage alarm conditions that can be configured to 
close an alarm contact. The record and trend storage alarm condition can be ac-
cessed via the SCADA protocols. You can enable the recorder nearly full and 
trend nearly full alarm conditions in the Recording tab of the Utilities screen.
To access the storage alarm configuration, select Identification>Storage 
Alarms in the configuration editor’s main tree view.

Analog Input Channels
The menu entry New Analog Input is used to add an Analog Inputs Channel.
1   Select Analog Inputs in the tree. If the Channel Tree is showing, expand An-

alog Inputs under the appropriate Channel Group and choose an unallocated 
channel.

2   Right-click and select New Analog Input.
3   Select the desired channel type from the list. If appropriate, choose the type 

that matches the input you are monitoring (e.g. Va). For an ac signal that 
has no specific phase designation you can select New AC Voltage or New 
AC Current. If you chose New Ia, Ib, Ic or New Va, Vb, Vc, three entries 
are created and the configuration screen for the first is displayed. To mon-
itor a dc quantity, select New DC.

4   When you chose a channel type, the right pane displays a channel configu-
ration screen.

Figure 7.9:  Analog Input Screen

For more information about Settings for triggers and actions see “Triggers” on 
page 7-28 and “Actions” on page 7-29.

TESLA Analog Input

Element Selected from the Channel Tree the element is variable.
Selected from the Element tree the element is fixed.
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7 The Configuration Editor
Type Based on the channel type you selected. If desired, use the Type field 
to modify the phase reference of an existing channel. It cannot be 
used to define a new analog channel or change a voltage channel into 
a current channel and vice versa.

Description Extends the channel name if it requires further description to make it 
unique (see “Planning Your Configuration” on page 6-6).

Channel Identifies the hardware input associated with the channel group. The 
list shows only inputs not assigned to other channels.
To get an overview of channel assignments, switch to the Channel 
Tree view and look at the Analog Channel list.

Module Type The Module Type indicates type of external input isolation module 
being used with this channel (see “AC Voltage Input Module” 
in Appendix I, and “DC Input Module” in Appendix L). 
This provides scaling information to the system. 
A dc isolation module channel can be used for either an ac or a dc 
input to the TESLA recorder. DC signals brought to the TESLA 
through dc isolation modules is bipolar, that is, if the full-scale value is 
5 volts the module will also read voltages down to -5 volts.

Units AC current select mA, A or kA.
AC voltage select mV, V or kV.
DC module select mA, A, mV or V.

Angle Offset Provides a phase angle offset for the Analog Input channels. It affects:
• The phasor (phase angle) value for the analog channel to which it 

is applied.
• The analog channel metering screen’s phase angle values.
• The calculated channels which use the analog channel’s phasors 

(phase angle) as part of the calculation (watts, vars, Impedance, 
Summations, Sequence components, etc.). Anything to do with 
the calculated channels will be affected, such as metering 
screens and triggers.

• The graphs for the calculated channels will be affected because 
the data points for the graph are calculated.

The data points for the analog channel graphs are not affected 
because they are measured value data points.
When the Angle Offset is used on a reference channel, it affects all 
other channels and appears on the metering screens.

Rate of Change 
Interval

Period of time over which both positive and negative rate of change is 
measured. 0.5 to 8.0 cycles.

Single Harmonic 
Number

2 to 25 multiple of fundamental frequency

Nominal Level Provides a nominal level for sag and swell detector.

Limit Specifies magnitude, rate of change, single harmonic, THD, sag and 
swell trigger levels.

 Delay Requires an element to be energized before an active state is deter-
mined. Magnitudes with rate of change are settable from 0 to 1,200 
seconds in half-cycle increments. Single harmonic and THD are setta-
ble from 1 to 10,000 seconds in 1 second increments.

Enable Enable/disable

Fault Enable/disable

TESLA Analog Input
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7 The Configuration Editor
AC Scaling When you select the View/Set Scale button on the Analog Input form for an ac 
channel, Control Panel displays the Scaling dialog box. The scaling factor is 
the equivalent to the turns ratio of the primary transducer (CT or PT). The nom-
inal secondary value is the default calibration for the channel. 
If you are using an ac module to measure the ac quantity, Control Panel sets 
the Full Scale quantity appropriately; if you are using the dc input module enter 
the Full Scale value associated with the values of the scaling resistors Rsh, Rin 
and Rfb as listed in “DC Input Module” in Appendix L. 

Figure 7.10:  AC Scaling

DC Scaling When you select the View/Set Scale button on the Analog Input form for a dc 
channel, Control Panel displays the Scaling dialog box, Figure 7.11: DC Scal-
ing. You must set the Full Scale value, which can be determined from the scal-
ing resistors attached to the module. For dc channels, TESLA uses two-point 
scaling, whereby the conversion process performs a linear transformation be-
tween two points. The secondary values are the default calibration points for 
the channel.
The terms Primary and Secondary are used in the case where a measurement 
transducer is applied and the output of the transducer is routed to the input of 
the dc module. In this case, Secondary refers to the output of the transducer; 
Primary refers to the scale and units of the signal measured by the transducer.
The “Scaling Resistors attached to the module” are the Rsh, Rin and Rfb values 
referred to in “DC Input Module” in Appendix L. Enter the associated Full 
Scale value from “DC Input Module” in Appendix L as the Full Scale (Second-
ary) value. If you are measuring a dc voltage or current directly, enter the same 
values as Primary and Secondary for each of Points 1 and 2. The specific val-
ues for Point 1 and 2, provided they are reasonably separated, are not signifi-

Swing Enable/disable

Log Enable/disable

Notify Enable/disable

Cross Trigger Enable/disable

Priority 1, 2, 3

Alarm Contact 2, 3, 5, 6, 7 – 36 channel TESLA
2, 3 – 18 channel TESLA

TESLA Analog Input
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7 The Configuration Editor
cant, except that they are used as default values for the calibration activity. For 
instance, if you are directly measuring a 48 Vdc input, you may wish to enter 
0 V for Point 1 and 48 V for Point 2.
If you are monitoring an ac signal through a dc module, you must define the 
signal as an ac signal. 

Figure 7.11:  DC Scaling

Sag and Swell 
Detectors

Sag and Swell detectors are available on voltage channels. There are three re-
lated fields in the Configuration screen controlling Sag and Swell detectors. 
The definition of a Sag or Swell depends on a Nominal Level of voltage. The 
Sag and Swell thresholds are expressed as a percentage of the Nominal Level. 
The Sag threshold is configurable between 50% and 90% of Nominal. The 
minimum Sag level is fixed at 10% of Nominal. The Swell threshold is config-
urable between 110% and 150% of Nominal. The maximum Swell level is 
fixed at 180% of Nominal.
The duration of a Sag or Swell is fixed at any value between 0.5 cycle and 1 
minute.
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External Input Channels

Figure 7.12:  External Input Configuration Screen

The menu entry New External Input is used to add an External Input Channel.
5   Select External Inputs in the tree.
6   Right-click and select New External Input and give it an unique name.
7   When you chose a channel type, the right pane displays a channel configu-

ration screen.
For more information about Settings for triggers and actions see “Triggers” on 
page 7-28 and “Actions” on page 7-29.

TESLA External Input Configuration

Element Selected from the Channel Tree the element is variable.
Selected from the Element tree the element is fixed.

Type Fixed as EI (external input) and is not shown. It will automatically be 
used as part of the channel’s name.

Description Extends the channel name if it requires further description to make it 
unique (see “Planning Your Configuration” on page 6-6).

Channel Identifies the actual External Input number connected to the input. 
This number is identified on the rear of the TESLA chassis. The list 
only shows inputs which have not been assigned to other channels.

Definite Delay Requires the element to be energized before an active state is deter-
mined. Settable from 0 to 5,000 ms in eighth cycle increments.

Label On/Off

Enable Enable/disable

Fault Enable/disable

Swing Enable/disable

Log Enable/disable

Notify Enable/disable

Cross Trigger Enable/disable

Priority 1, 2, 3
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Summation Channel

Figure 7.13:  Adding Summation Channels

The menu entry New Summation is used to add a Summation Channel.
8   Select Summations in the tree. If the Channel Tree is showing, expand Sum-

mations under the appropriate Channel Group and choose an unallocated 
channel.

9   Right-click and select New Summations.
10   Select the desired channel type from the list. If appropriate, choose the type 

that matches the input you are monitoring (e.g. Va). For an ac signal that 
has no specific phase designation you can select New AC Voltage or New 
AC Current. If you chose New Ia, Ib, Ic or New Va, Vb, Vc, three entries 
are created and the configuration screen for the first is displayed.

Alarm Contact 2, 3, 5, 6, 7 – 36 channel TESLA
2, 3 – 18 channel TESLA

TESLA External Input Configuration
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7 The Configuration Editor
11   When you chose a channel type, the right pane displays a channel config-
uration screen.

For information about Settings for triggers and actions see “Triggers” on 
page 7-28 and “Actions” on page 7-29.

Figure 7.14:  Summation Function Configuration Screen

TESLA Summation Function Configuration

Element Selected from the Channel Tree the element is variable.
Selected from the Element tree the element is fixed.

Type Selected for you based on the channel type you just selected. If 
desired, the Type field can be used to modify the phase reference of 
an existing channel; it cannot be used to define a new summation 
channel, it cannot change a Voltage channel into a Current channel, 
nor vice versa.

Description Extends the channel name if it requires further description to make it 
unique (see “Planning Your Configuration” on page 6-6).

Summation Index Identifies the internal summation channel. Unlike the analog and 
external input channels, this is not associated with a hardware input, 
but simply identifies which of the internal virtual summation channels 
will be used. 
Each channel group has 15 available summation channels. Select 
any available channel. If the only option is “undefined”, you have 
already used all available channels.

Rate of Change 
Interval

Period of time over which both positive and negative rate of change is 
measured. 0.5 to 8.0 cycles.

Element Type 
Description

Identifies the channels to be used in the summation. The list includes 
all previously defined analog channels and any summation channel 
with a lower summation index field. It grows automatically as you 
define new channels. 
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7 The Configuration Editor
Scale Factor Specify a Scale Factor and a Rotation for each of the inputs. TESLA 
applies the scale factor to measurements in the Secondary domain. 
When converting to the Primary domain, TESLA applies the scale fac-
tor of the first defined input. Click Show Primary Units to see how this 
affects the summation calculation. While Control Panel is in Primary 
Units mode, you may view and/or modify the scale factor as it would 
apply in the Primary domain. When you click Show Secondary Units, 
TESLA Control Panel shows you the equivalent scale factor in the 
Secondary domain.

Angle Offset With Settings Version 4 and above specify an angle offset.

Limit Specifies the magnitude and rate of change trigger levels.

Delay Requires the element to be energized before and active state is deter-
mined. Settable from 0 to 1,200 seconds in half-cycle increments.

Enable Enable/disable

Fault Enable/disable

Swing Enable/disable

Log Enable/disable

Notify Enable/disable

Cross Trigger Enable/disable

Priority 1, 2, 3

Alarm Contact 2, 3, 5, 6, 7 – 36 channel TESLA
2, 3 – 18 channel TESLA

TESLA Summation Function Configuration
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Sequence Component Channels

Figure 7.15:  Sequence Function Configuration

The menu entry New Sequence Functions is used to add a Sequence Function 
Channel.
12   Select Sequence Functions in the tree. If the Channel Tree is showing, ex-

pand Sequence Functions under the appropriate Channel Group and choose 
an unallocated channel. Use new sequence to add a sequence set—positive, 
negative and zero.

13   Right-click and select New Sequence Function—select a choice of voltage 
or current sequence set. Only one voltage sequence or one current sequence 
per element is supported.

14   When you chose a channel type, the right pane displays a channel config-
uration screen.

For information about Settings for triggers and actions see “Triggers” on 
page 7-28 and “Actions” on page 7-29.

TESLA Sequence Function Configuration

Element Selected from the Channel Tree the element is variable.
Selected from the Element tree the element is fixed.

Type Selected for you based on the channel type you just selected. 

Description Extends the channel name if it requires further description to make it 
unique (see “Planning Your Configuration” on page 6-6).

Sequence Index Identifies the internal sequence channel. Unlike the analog and exter-
nal input channels, this is not associated with a hardware input, but 
simply identifies which of the internal virtual sequence channels will 
be used. 
Each channel group has 6 available sequence channels. Select any 
available channel. If the only option is “undefined”, you have already 
used all available sequence channels.

Element Type 
Description

Identifies the channels used to create the sequence set. The list 
includes all analog input or summation channels which have already 
been defined. It grows automatically as you define new channels.

Scale Factor A Scale Factor and a rotation for each of the inputs can be specified. 
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Rate of Change 
Interval

Period of time over which both positive and negative rate of change is 
measured. 0.5 to 8.0 cycles.

Limit Specifies the magnitude and rate of change trigger levels.

Delay Requires the element to be energized before an active state is deter-
mined. Settable from 0 to 1,200 seconds in half-cycle increments.

Enable Enable/disable

Fault Enable/disable

Swing Enable/disable

Log Enable/disable

Notify Enable/disable

Cross Trigger Enable/disable

Priority 1, 2, 3

Alarm Contact 2, 3, 5, 6, 7 – 36 channel TESLA
2, 3 – 18 channel TESLA

TESLA Sequence Function Configuration
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Impedance Channels

Figure 7.16:   Impedance Configuration Screen

The menu entry New Impedance is used to add an Impedance Channel.
1   Select Impedance Functions in the tree. If the Channel Tree is showing, ex-

pand Impedance Functions under the appropriate Channel Group and 
choose an unallocated channel.

2   Right-click and select New impedance.
3   The Impedance function continuously recalculates the apparent impedance 

from the configured voltage and current signals, then subtracts an earlier 
calculated value (determined by the “Rate of Change Interval” setting). The 
impedance trigger operates if the difference is between the “Minimum 
Change” and “Maximum Change” settings, and the calculated impedance 
is within “Circle Radius” of the origin.

4   When you chose a channel type, the right pane displays a channel configu-
ration screen.

For information about Settings for triggers and actions see “Triggers” on 
page 7-28 and “Actions” on page 7-29.

TESLA Impedance Function Configuration

Element Selected from the Channel Tree the element is variable.
Selected from the Element tree the element is fixed.

Type Fixed as Z1, automatically used as part of the channel’s name. 

Description Extends the channel name if it requires further description to make it 
unique (see “Planning Your Configuration” on page 6-6).
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Impedance Index Identifies the internal impedance channel. Unlike the analog and 
external input channels, this is not associated with a hardware input, 
but simply identifies which of the internal virtual impedance channels 
will be used. Each channel group has 9 available impedance chan-
nels. Select any available channel. If the only option is “undefined,” 
you have already used all available channels.

Voltage Input Identifies the channels to be used to create the impedance. If you 
select analog or summation channels as inputs, the impedance chan-
nel calculates single-phase impedance; if you select sequence chan-
nels, it calculates three-phase impedance.

Current Input Identifies the channels to be used to create the impedance. If you 
select analog or summation channels as inputs, the impedance chan-
nel calculates single-phase impedance; if you select sequence chan-
nels, it calculates three-phase impedance.

Rate of Change 
Interval

Period of time over which both positive and negative rate of change is 
measured. 0.5 to 8.0 cycles.

Circle Radius Specifies impedance circle to be modified.

Minimum Change Specifies the minimum impedance change to be detected.

Maximum Change Specifies the maximum impedance change to be detected.

Definite Delay Requires the element to be energized before an active state is deter-
mined. Settable from 0 to 1,200 seconds in half-cycle increments.

Enable Enable/disable

Fault Enable/disable

Swing Enable/disable

Log Enable/disable

Notify Enable/disable

Cross Trigger Enable/disable

Priority 1, 2, 3

Alarm Contact 2, 3, 5, 6, 7 – 36 channel TESLA
2, 3 – 18 channel TESLA

TESLA Impedance Function Configuration
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Watts and Vars Channels

Figure 7.17:  Watts/Vars Configuration

The menu entry New Watts/Vars Function is used to add Watts/Vars Function 
Channel.
1   Select Watts/Vars Functions in the tree. If the Channel Tree is showing, ex-

pand Watts/Vars Functions under the appropriate Channel Group and 
choose an unallocated channel. 

2   Right-click and select New Watts/Vars Function from the shortcut menu.
3   When you chose a channel type, the right pane displays a channel configu-

ration screen.
For information about Settings for triggers and actions see “Triggers” on 
page 7-28 and “Actions” on page 7-29.

TESLA Watts/Vars Function Configuration

Element Selected from the Channel Tree the element is variable.
Selected from the Element tree the element is fixed.

Type Fixed as W/V, automatically used as part of the channel’s name.

Description Extends the channel name if it requires further description to make it 
unique (see “Planning Your Configuration” on page 6-6).

Watts/Vars Index Identifies the internal watts/vars set channel. Unlike the analog and 
external input channels, this is not associated with a hardware input, 
but simply identifies which of the internal virtual channels will be used. 
Each channel group has 9 available watts/vars channels. Select any 
available channel. If the only option is “undefined”, you have already 
used all available channels. 

Scale Factor A Scale Factor and a rotation for each of the inputs can be specified. 

Voltage Input Identifies the channels to be used to create the watts and vars. These 
can be either analog input channels, summations or positive 
sequences. If you select analog or summation channels as inputs, 
single phase watts and vars will be calculated; if you select sequence 
channels, three-phase watts and vars will be calculated.
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Current Input Identifies the channels to be used to create the watts and vars. These 
can be either analog input channels, summations or positive 
sequences. If you select analog or summation channels as inputs, 
single phase watts and vars will be calculated; if you select sequence 
channels, three-phase watts and vars will be calculated.

Rate of Change Interval

Watts 1 Period of time over which both positive and negative rate of change 
for Watt Detector 1 is measured. 0.5 to 8.0 cycles.

Watts 2 Period of time over which both positive and negative rate of change 
for Watt Detector 2 is measured. 0.5 to 8.0 cycles.

Vars Period of time over which both positive and negative rate of change 
for Var Detector is measured. 0.5 to 8.0 cycles.

Limit Specifies the magnitude and rate of change trigger levels.

Delay Requires the element to be energized before an active state is deter-
mined. Settable from 0 to 1,200 seconds in half-cycle increments.

Enable Enable/disable

Fault Enable/disable

Swing Enable/disable

Log Enable/disable

Notify Enable/disable

Cross Trigger Enable/disable

Priority 1, 2, 3

Alarm Contact 2, 3, 5, 6, 7 – 36 channel TESLA
2, 3 – 18 channel TESLA

TESLA Watts/Vars Function Configuration
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Frequency Channels

Figure 7.18:  Frequency Channels

The menu entry New Frequency is used to add a Frequency Channel.
1   Select Frequency in the tree.
2   Right-click and select New Frequency. Unlike the other calculated channels, 

there is only one frequency channel per Channel Group.
3   When you chose a channel type, the right pane displays a channel configu-

ration screen.
For more information about Settings for triggers and actions see “Triggers” on 
page 7-28 and “Actions” on page 7-29.
For information about Settings for triggers and actions see “Triggers” on 
page 7-28 and “Actions” on page 7-29.

TESLA Frequency Measurement Configuration

Frequency derived 
from

Identifies the analog input channel on which to measure frequency.

Rate of Change 
Interval

Period of time over which both positive and negative rate of change is 
measured. 0.5 to 8.0 cycles

Limit Specifies the magnitude and rate of change trigger levels.
High magnitude limit is 7/6 x nominal frequency, low magnitude limit is 
5/6 x nominal frequency.

Delay Requires the element to be energized before an active state is deter-
mined. Settable from 0 to 1,200 seconds in half-cycle increments.

Enable Enable/disable

Fault Enable/disable

Swing Enable/disable

Log Enable/disable

Notify Enable/disable
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Logic Channels

Figure 7.19:  Logic Channel

The menu entry New Logic Function is used to add a Logic Function Channel.
1   Select Logic Function in the tree.
2   Right-click and select New Logic Function. The menu entry New Logic 

adds a logic channel. You can choose up to 5 state values from all the de-
fined detectors in the channel group. Each of these may be inverted, and a 
chain of logic operations are performed on the 5 state values. Transitions in 
the resultant state may be delayed as required by the application.

3   When you chose a channel type, the right pane displays a channel configu-
ration screen.

For more information about Settings for triggers and actions see “Triggers” on 
page 7-28 and “Actions” on page 7-29.

Cross Trigger Enable/disable

Priority 1, 2, 3

Alarm Contact 2, 3, 5, 6, 7 – 36 channel TESLA
2, 3 – 18 channel TESLA

TESLA Frequency Measurement Configuration

Step 1 -Select 
an Element.

Step 2 - Select 
New Logic Function.

Step 3 - Selecting
an element brings 
up Logic screen
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TESLA Logic Function Configuration

Element Selected from the Channel Tree the element is variable.
Selected from the Element tree the element is fixed.

Type The type is fixed as “Logic.”

Description Extends the channel name if it requires further description to make it 
unique (see “Planning Your Configuration” on page 6-6).

Logic Function 
Index

Each channel group has 15 available logic channels. Select any avail-
able channel. If the only option is “undefined,” you have already used 
all available channels.

Inputs 1–5 Select from previously defined detectors.

Delay Module Assert—selectable from 0 to 20,000 ms in half-cycle increments.
Deassert

Gates NOT, AND, NAND, OR, NOR, Exclusive OR, and Exclusive NOR.

Enable Enable/disable

Fault Enable/disable

Swing Enable/disable

Log Enable/disable

Notify Enable/disable

Cross Trigger Enable/disable

Priority 1, 2, 3

Alarm Contact 2, 3, 5, 6, 7 – 36 channel TESLA
2, 3 – 18 channel TESLA
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Fault Locator Channels

Figure 7.20:  Fault Locators

The menu entry New Fault Locator is used to add a Fault Locator Channel.
1   Select Fault Locator in the tree.
2   Right-click and select New Fault Locator. The menu entry New Logic adds 

a logic channel.The fault locator channel monitors 3 line voltage inputs and 
3 line current inputs. When an “assert” transition occurs, the phase informa-
tion collected is used to determine the location of the fault from the line 
conditions monitored prior to the transition. The line parameters refer to the 
total line length. The distance may be indicated in miles or kilometers.

3   When you chose a channel type, the right pane displays a channel configu-
ration screen.

TESLA Fault Locator Configuration

Element Selected from the Channel Tree the element is variable.
Selected from the Element tree the element is fixed.

Type Fixed as “FLoc.” 

Description Extends the channel name if it requires further description to make it 
unique (see “Planning Your Configuration” on page 6-6).

Fault Locator Index Each channel group has 5 available fault locator channels. Select any 
available channel. If the only option is “undefined,” you have already 
used all available channels.

Initiating Event Select from previously defined detectors.
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Power Factor Channels

Figure 7.21:  Power Factor Channels

The menu entry New Power Factor is used to add a Power Factor Channel.
1   Select Power Factor in the tree.
2   Right-click and select New PF Detector. The Power Factor Detector moni-

tors the watts, vars, and volt-amps values computed by a watts/vars func-
tion and operates when the power factor is less than a user-specified 
threshold. Separate detectors allow separate thresholds for lagging (induc-
tive) and leading (capacitive) power factors. To reduce the incidence of nui-
sance operations, you may specify a minimum volt-amps setting.

3   When you chose a channel type, the right pane displays a channel configu-
ration screen.

TESLA Power factor Detector Configuration

Element Selected from the Channel Tree the element is variable.
Selected from the Element tree the element is fixed.

Type Fixed as PF.

Description Extends the channel name if it requires further description to make it 
unique (see “Planning Your Configuration” on page 6-6).

PF Detector Index Each channel group has 9 available PF channels. Select any availa-
ble channel. If the only option is “undefined,” you have already used 
all available channels.

Watts/Vars function 
to monitor

Select from previously defined detectors.

Disable detector if 
VA less than

Can be set using primary or secondary units.

Limit Power factor trigger level. 0 to 1 in 0.001 increments.

Delay Requires the element to be energized before an active state is deter-
mined. Settable from 1 to 10,000 seconds in 1 second increments.
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Triggers
You can apply trigger conditions to each input or calculated channel. The trig-
ger parameters for each channel are included in that channel’s configuration 
screen, as detailed above.

High and Low 
Magnitude Triggers

The magnitude triggers are used to detect conditions where the channel’s sig-
nal is outside of the defined threshold. For analog input channels, the magni-
tude of the fundamental is used. The Limit parameter defines the trigger 
threshold in units defined in the Units field above. The Delay parameter spec-
ifies the minimum duration of the condition required to initiate a trigger. 
To prevent multiple triggers on threshold conditions, an hysteresis of 2% of 
setting is applied to magnitude triggers. Frequency magnitude triggers have a 
fixed 0.02 Hz hysteresis. Power factor triggers have a fixed hysteresis of 0.05.

Positive and 
Negative Rate of 
Change Triggers

Rate of change detectors are used to detect conditions where the channel’s sig-
nal is changing at a rate outside the defined boundary. The Rate of Change In-
terval determines the period over which the signal change is evaluated. Longer 
intervals can be used to reduce nuisance triggers due to short-term signal; 
shorter intervals improve pick-up time. The other part of the rate of change set-
ting is the Limit, which sets the amount of change which can occur over the 
specified interval. The Delay parameter specifies the minimum duration of the 
condition required to initiate a trigger.
Some channel types (e.g. Watts/Vars) have a number of Rate of Change Inter-
val settings to provide greater flexibility.

THD Triggers THD magnitude triggering is available on all analog input channels. The Limit 
parameter specifies the percentage of THD. The Delay parameter specifies the 
minimum duration of the condition required to initiate a trigger.

Single Harmonic 
Triggers

A trigger on the magnitude of a selected individual harmonic is available on all 
analog input channels. The Single Harmonic Number parameter sets the target 
harmonic. The Limit parameter specifies the percentage of fundamental of the 

Enable Enable/disable

Fault Enable/disable

Swing Enable/disable

Log Enable/disable

Notify Enable/disable

Cross Trigger Enable/disable

Priority 1, 2, 3

Alarm Contact 2, 3, 5, 6, 7 – 36 channel TESLA
2, 3 – 18 channel TESLA

TESLA Power factor Detector Configuration
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harmonic. The Delay parameter specifies the minimum duration of the condi-
tion required to initiate a trigger.

External Input and 
Logic Triggers

External Input and Logic triggers are available for either or both state edges. 
The Definite Delay parameter specifies the minimum duration of the condition 
required to initiate a trigger for an external input. Individual delay settings are 
available for each transition of logic channels. Logic triggers are generated 
when the state of the logic output changes.

Sag and Swell Sag and Swell triggers are available for ac voltage channels. The magnitude 
thresholds used by Sag and Swell detectors for a channel are defined in terms 
of a Nominal Value, which must be defined for that channel.

Impedance Triggers Impedance triggers are available on calculated Impedance channels. The rate 
of change of impedance is calculated as the movement of the calculated imped-
ance in the complex plane over the Rate of Change Interval. If that movement 
is between the Minimum Change and Maximum Change values, the detector 
becomes active. If the calculated value of impedance is outside a “circle of in-
terest,” the trigger is automatically disabled. The centre of the “circle of inter-
est” lies at the origin, and its radius is user-specified.

Actions
When a trigger occurs, a number of independent actions can be initiated.

Record Fault The recorder makes/continues a high speed transient fault recording.

Record Swing The recorder makes/continues a low speed dynamic swing recording.

Log The recorder enters a message into the Event Log.

Cross-Trigger The recorder activates the Cross-Trigger contact output, enabling other record-
ers to activate on the same event.

Alarm Contact One of the alarm contacts (2, 3, 5, 6, or 7) that may be activated as a result of 
the trigger.

Notify The recorder attempts to place a call through the attached modem to the Re-
cordBase Central Station.

With a Definite Delay of 0, the recorder still requires that a state 
change be present for a minimum of four consecutive samples to be 
considered valid.
Release Date: 2008 February 08 TESLA User Manual 2000 7-29



7 The Configuration Editor
Priority
Each individual trigger detector can be assigned a priority level from 0 to 3, 
with 3 being the highest priority. Notify contains settings to control the dial-
out process and the initiation of record transfers, see “Notify” on page 5-10.
The priority number is used to assign a priority to each record. The record’s 
priority is based on the highest priority event contained in the record. The 
record priority is shown as part of the record summary.

Meter Groups

Figure 7.22:  Add Meter Group Screen

A Meter Group is a collection of measured and calculated values that are pre-
sented as a group by the Control Panel’s Metering function. Metering Groups 
are referred to by a user-specified name, and the name of the Metering Group 
appears on the tab in the Metering display.
There are two default metering groups and ten user-defined for a total of ten 
metering groups in all.
The Metering display has fixed displays for analog and external input chan-
nels. You may add additional displays containing any set of channels, orga-
nized as you wish.
1   To create a meter group, right-click on the Meter Groups entry in the Con-

figuration menu. 
2   Select Add Meter Group. A New Meter Group line appears, and the New 

Meter Group text is selected. 
3   Type the Meter Group name, then Enter. The text you type replaces the New 

Meter Group text.
4   In the meter group screen, you can place any defined channel in any cell. 

The resultant meter group display will show the desired channels in the 
specified place on the screen.
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Trends

Figure 7.23:  Configuration showing Trends

To define a trend select either New Trend from the Config menu or New Trend 
from the right-click context menu in either the Channel Tree or Element Tree. 
When you define a trend, specify up to 60 trended channels selected from the 
measured and derived channels defined in your recorder. The trending process 
supports long term event logging.
At regular intervals (the Scan Interval), TESLA records a value for each of the 
trended channels. You can set the interval from 10 seconds up to 3,600 sec-
onds.
TESLA accumulates up to 3 months of trend data and activates an alarm when 
the amount of accumulated data exceeds a specified number of days. Choose 
which contact is used in the Trend Definition display. This contact may not be 
used for any other purpose. Specify the number of days threshold and the en-
abled state of the alarm in the Utilities screen, for details see “Recording” on 
page 5-7.
Choose channels to be trended by clicking on one of the (larger) spaces in the 
trend grid. Clicking on the arrow that appears, lists all the available channels 
in the list box that appears adjacent to the space you originally clicked. Alter-
natively, use the selection tree that appears to the immediate left of the trend 
grid. Use the tree’s expansion buttons to locate the desired channel, then drag 
and drop your selection on the grid.

Phase angle readings displayed in meter groups utilize the first chan-
nel of each Channel Group as a reference channel for the angle 
measurement “Phase Angle Metering Reference” on page 6-6.
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Choose a Process Option for each trended channel. 

You can record the same channel with more than one Process Option, but you 
can not record the same channel with the same Process Option more than once.
When you have defined a trending process, a long-term event log is started au-
tomatically. If you wish to have the long-term event log without trending any 
data, define a trend without any channels in it. A daily limit of 1000 events can 
be stored in the trend log.

The Process Option is defined as follows:

Damped (default) TESLA records a value representative of the measurements during 
the interval.

Undamped TESLA records the last value measured during the interval.

Avg TESLA records the average measured value over the interval.

Min TESLA records the minimum measured value over the interval.

Max TESLA records the maximum measured value over the interval.
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Printing a Configuration

Figure 7.24:  Print a Configuration

Generate a Configuration print at any time by selecting Print Settings from the 
File menu. The printed output follows the same general layout as the Element 
Tree. Where applicable, the settings are given in secondary units. The excep-
tion is the Fault Location parameters which are given in primary units.
You can preview the printed output by selecting Print Preview from the File 
menu.
Print Config function is also available under the Config menu.

Printing a Modbus Address List
The MODBUS address equivalents shows all of the functions defined in the 
TESLA recorder (see “Modbus Functions” in Appendix D). Selecting the Print 
MODBUS settings item from the File menu generates a listing that is config-
urable—listing the full function names in Element-Function-Description for-
mat along with the equivalent MODBUS addresses.
You can preview the printed output by selecting Print MODBUS Preview from 
the File menu.
Print MODBUS function is also available under the Config menu.
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Printing a DNP Address List
The DNP point list shows all of the functions defined in the TESLA recorder, 
(see “DNP3 Reference” in Appendix E) Selecting the Print DNP settings item 
from the File menu generates a listing that is configurable—listing the full 
function names in Element-Function-Description format along with the equiv-
alent DNP points.
You can preview the printed output by selecting Print DNP Preview from the 
File menu.
Print DNP function is also available under the Config menu.
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Reference connection Appendix drawing, “AC Analog Connections” 
in Appendix H and “Specifications” in Appendix A for ratings.

Analog Input Channels
The recorder’s 18 or 36 analog inputs are generic, low level (5 V peak) non-
isolated signal inputs that take their input from external isolation modules. 
Any analog input can be connected to any isolation module. The configuration 
of a channel as a voltage or current and channel scaling is handled by channel 
definitions in the downloadable configuration.
When an input module is changed or moved to a different channel, a calibration 
should be performed (see “Analog Input Calibration” on page 8-5).

Analog Input Isolation Modules
The recorder requires the use of ERLPhase external isolation input modules for 
voltage and current inputs. The isolation modules provide scaling, isolation 
and surge protection. Module outputs are low level voltage signals which feed 
directly into the recorder’s analog inputs. The modules are mounted on DIN 
rails to make wiring easier and minimize rack space requirements.
The isolation modules can be located up to 100 feet away from the recorder. 
Shielded wire (e.g. Belden 9730 - three pair or 9728 - four pair) is recommend-
ed with the ground attached only at the recorder end.

The isolation module outputs use matched source and load impedance to min-
imize noise susceptibility.

AC Voltage Input 
Module

This ac 3 channel isolated voltage input module provides isolation and scaling 
for three ac voltage channels. Nominal voltage is 69 V RMS with a 2x over-
range capability (see “AC Voltage Input Module” in Appendix I). 
There are two models of ac voltage modules:
1   Common Neutral: (Model 401003) Four input terminals for VA, VB, VC, 

N. Use Model 401003; 69 Vac Common Neutral as the module type for an-
alog inputs using these modules.

2   Independent Neutral: (Model 401006) Six input terminals for VA, Neutral, 
VB, Neutral, VC, Neutral. Use Model 401006; 69 Vac Isolated Neutral as 
the module type for analog inputs using these modules.

All analog input modules must be grounded via the ground stud on 
the module. 

Each output channel of an isolation module should be connected to 
no more than one TESLA input channel.
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Both voltage models have two output terminals for each of the three phases. 
The positive reference polarity is marked by a dot.

AC Current Input 
Module

This ac 4 channel isolated input current module provides isolation and scaling 
for four independent ac current channels. Nominal current is 5 A RMS with a 
20x over-range capability for 1 second.
There are three models of ac current modules:
1   Model 401002: use Model 401002; 5 A ac as the module type for analog 

inputs using these modules.
2   Model 401014: Model 401014 is the same as Model 401002, but has 

improved phase angle accuracy at lower current values. Use Model 401014 
5 A ac as the module type for analog inputs using these modules.

3   Model 401020: use Model 401020; 1 A ac as the module type for analog 
inputs using these modules.

The module has input and output terminal pairs for I1 through I4. The polarity 
is marked by a dot on both the input and output terminals.

Split-Core CT (5A, 
20x)

This Split Core Current Transformer (Model 401013) is an optional input de-
vice used where it is difficult to get an outage to install in circuit ERLPhase 
current modules (Model 401002, Model 401014; 4 CT Modules). These CTs 
are designed to clamp around the secondary circuit wires from the primary cur-
rent transformers. The split core CT option installs quickly and easily. The out-
puts from the CTs are impedance matched to connect directly to the TESLA’s 
analog input connectors. 
There are two models of ac split core CTs:
1   Use Model 401013; 5 A split-core as the module type for analog inputs us-

ing these modules.
2   Use Model 401017; 1 A split-core as the module type for analog inputs us-

ing these modules

 Clamp-on CT This Clamp-on CT (Model 401012) is an optional input device used where it 
is difficult to get an outage to install in circuit ERLPhase current modules 
(Model 401002, Model 401014; 4 CT Modules). These CTs are designed to 
clamp around the secondary circuit wires from the primary current transform-
ers. The Clamp-on CT option installs quickly and easily. Use Clamp-on for 
quicker, more portable installation. The outputs from the CTs are impedance 
matched to connect directly to the TESLA’s analog input connectors. Use 
Model 401012; 5 A clamp-on as the module type for analog inputs using these 
modules.

DC Module This module is an optional input device to provide dc-coupled isolation and 
scaling for four independent dc or ac voltage or current channels. These chan-
nels have a dc to 2 kHz bandwidth but are limited to 1.5 kHz by antialiasing 
filters inside the recorder. Externally mounted resistors set the input type and 
full scale range (see “DC Input Module” in Appendix L). Use Model 401016 
DC as the module type for analog inputs using this module.
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AC Low Voltage 
Input Module

This 4 channel isolated ac voltage input module provides isolation and scaling 
for four low voltage channels. Nominal input voltage is 4 Vrms with a 7 Vrms 
overvoltage capability. Maximum input level is 12 Vrms continuous, 15 Vrms 
for 10 seconds. Use 401022; Low V as the module type for analog inputs using 
these modules (see “AC Low Voltage Input Module” in Appendix M).

External Input Channels
The recorder’s external inputs are dry inputs intended for use with signals from 
a 48 Vdc or 125 Vdc station battery. The external inputs are isolated and pro-
tected against transient surges. The external inputs activate at approximately 
18 Vdc. Other station battery voltage ranges are available.
For recorders with serial number TESLA-2000-021010-01 or later the external 
input boards have an operational voltage range from 48 Vdc to 250 Vdc. The 
external inputs activate at approximately 32 Vdc.

Alarm Contacts
The alarm contacts on the rear of the unit are dry contacts. They are isolated 
and protected against transient surges. The contacts are designated as follows:
For 18/32 channel units:

1   Recorder fail. Closed on failure (Check Note following for details.)
2   User-configurable
3   User-configurable
4   Cross-trigger, Channel Group 1

Additional, for 36/64 channel units:
1   User-configurable
2   User-configurable
3   User-configurable
4   Cross-trigger, Channel Group 2

The Cross-trigger contact is used to initiate recording on another recorder 
when this unit triggers. On 36/64 channel units, contacts 4 and 8 should be con-
nected in parallel.When activated, the cross-trigger contacts close for 0.10 sec-
onds, regardless of the duration of the triggering condition. This ensures that 
the cross-trigger function does not become blocked by a continuous trigger 
condition.

The user-configurable alarm contacts can be defined for use as part of the re-
corder’s overall configuration (see “Actions” on page 7-29).

For recorders with s/n 981103-xx or 990318-xx: Contact 1: Recorder 
fail. Open on failure. 

For recorders with s/n 991110-xx or later: Contact 1: Recorder fail. 
Closed on failure.
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IRIG-B Time Signal
The BNC connector on the rear of the unit accepts either modulated or unmod-
uled IRIG-B time signals.

Communication Ports
To access user interface and SCADA services see “Communication Ports for 
Recorder” on page 3-1 and “Communication Ports for Portable Recorder” on 
page 3-2.

Power Supply 
Model 2000 TESLA comes with a wide range power supply. The nominal operating range 

is 48 to 250 Vdc, 120 Vac, 50/60 Hz. We recommend that you use an inline 
fuse or circuit breaker with a 5 A rating to protect against possible short circuit 
in the supply. Make the chassis ground connection to ensure proper operation 
and safety. There are no power switches on the recorder. When the power sup-
ply is connected, the recorder starts its initialization process. 

Model 2000/P TESLA Portable comes with a wide range power supply. The nominal operat-
ing range is 48 to 250 Vdc, 120 Vac, 50/60 Hz. Make the chassis ground con-
nection to ensure proper operation and safety. An ac power cord is used to 
connect to the ac power source. Binding posts are used to connect to a dc power 
source. A three position power switch is used to turn the LED On or Off. You 
can select AC, Off or DC positions.

Case Grounding

You must ground TESLA to station ground using the case-grounding terminal 
at the back of the recorder or green binding post on the front of the portable 
recorder.

WARNING!

To ensure safety and proper operation you must connect the record-
er to the station ground using the rear grounding terminal on the re-
corder.

Ground the recorder even when testing.

Do not rely on the rack mounting screws to provide case grounding.
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8 External Connections and Metering
Analog Input Calibration
The Calibration Utility provides a means of calibrating the recorder’s analog 
input channels. It is accessed through the TESLA Control Panel’s Utilities tab 
as Analog Input Calibration.

Figure 8.1:  Analog Input Calibration

When To Calibrate

If the type of isolation module is changed, for example from a voltage to a cur-
rent the readings will be significantly wrong until calibration has been per-
formed.
Only the channels associated with the altered module need be re-calibrated.

AC Channel 
Calibration Process

To calibrate a channel (Main Menu>Utilities>Analog Input Calibration):
1   Select the channel or channels from the list. More than one channel of volt-

age or current can be chosen using the Control/Shift + left-click.

The recorder’s analog input channels should be re-calibrated when-
ever an analog isolation module is changed.

It is possible to calibrate multiple channels simultaneously by using 
the mouse to select a set of channels from the list. Multiple channels 
can be selected using standard Windows selection methods. 

All channels in the selected set must have the same type of input 
module.
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8 External Connections and Metering
2   Enter the voltage or current magnitude that is applied to the isolation module 
associated with the channel Applied Signal field. The signal magnitude lev-
el should be measured with a precision calibrated instrument. 

3   Press the Calibrate Offset and Gain button. If a channel has not yet been 
configured, only Calibrate Offset will be displayed.

4   Under the Offset and Gain columns the line of the channel being calibrated 
OK or No will be displayed (see “Analog Input Calibration” on page 8-5).

5   Repeat for all other channels being used.
6   Use the Save button to load the new calibration to the recorder.

DC Channel 
Calibration Process

The dc calibration procedure is a two-step procedure. When one or more com-
patible dc channels are selected, two calibration areas appear on the screen. 
You may calibrate the points in either order as is convenient. DC calibration is 
not complete until both points have been calibrated, and the associated offset 
and gain values accepted.

Out of Range An error message is displayed if the applied signal as seen by the recorder dif-
fers from the value entered in the Applied Signal field by more than 10%. This 
helps to prevent erroneous calibration.

If you change the type of isolation module associated with a channel, 
you must specify the new module type in the input channel's config-
uration before calibrating.
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8 External Connections and Metering
Metering
The recorder has a full set of real-time metering displays that provide the 
present readings from the analog and digital input channels, and the calculated 
channels.
The Metering display accessed through the Metering item in the Main Menu 
tab’s function list.

Figure 8.2:  Metering Display

Standard Metering 
Screens

The Metering display provides tabs at the bottom to select among multiple dis-
play screens. The first two tabs, Analogs and Digitals are the default tabs and 
present the readings from the analog inputs and external inputs.

User-Defined 
Metering Screens

You can define an additional ten user-defined metering screens. Setup of these 
additional screens is part of the recorder’s configuration (see “Meter Groups” 
on page 7-30).
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8 External Connections and Metering
Display Zoom The magnification of metering screens can be adjusted using the Zoom Level 
(%) button. This allows the display to be enlarged for easy viewing while com-
missioning or testing.

Figure 8.3:  Zoom Level

Freeze The Freeze button provides a means of temporarily stopping the update of the 
display. It can be used to ensure a synchronized set of readings for documen-
tation purposes. The metering display can be exported to another program us-
ing Windows built-in Alt PrintScreen key and standard paste functions.

Phase angle readings displayed in meter groups utilize the first chan-
nel of each Channel Group as a reference channel for the angle 
measurement (see “Phase Angle Metering Reference” on page 6-6).
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9 Record Management and Display

Record Listing, Transfer and Management
The record management services are available from the Records tab, accessible 
from the Main Menu.

Figure 9.1:  Record Listing 

Record Lists The left side of the Records tab shows lists of records for the current IED or-
ganized by date. Expanding a date entry shows On IED and Local headings. 
Records presently on the recorder are shown under the On IED heading. 
Records that have been previously transferred to the TESLA Control Panel are 
shown on the Local heading. The corresponding records under the On IED 
heading are shown in regular font. Records on the IED that have not been trans-
ferred to Control Panel are shown in bold-face. If working offline, only local 
records are shown.

Record Filter The list of records displayed is controlled by the Record Filter control. The fil-
ter applies to both On IED and Local record lists. The time taken to access the 
directory can be controlled by selecting an appropriate number of records in 
the Record Filter.
Note that if additional recordings are created through the Trigger Fault, Trig-
ger Swing or Trigger Both buttons, these new records do not displace the ear-
liest fetch/displayed file records in the tree.

Record Summary The right side of the Records tab shows summary information on the selected 
record. 
The summary includes the list of events which occurred during the time-span 
of the record from the recorder’s event log.
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9 Record Management and Display
Fetch Remote 
Summaries/Fetch 
Remote Events

When both Fetch Remote Summaries and Fetch Remote Event options are 
checked, Control Panel accesses and displays the corresponding recording in-
formation in the Record Summary and Events sections of the right-hand pane. 
You may eliminate the delay involved in accessing this information by dis-
abling the corresponding check-boxes.

Autopoll/Autoprint When Autopoll is checked, Control Panel will periodically (default 60 seconds) 
poll the connected TESLA recorder for new record files and automatically 
transfer them to the local computer. Newest records will be transferred first, 
and only one new record will be transferred at each poll. Checking Autoprint 
will cause each transferred (via Autopoll) record file to be automatically print-
ed on the default Windows printer using RecordGraph’s default template. 
Note that the Autopoll and Autoprint states are not persistent; if Control Panel 
is disconnected from the recorder, both Autopoll and Autoprint become un-
checked.

Graph Records can be viewed with RecordGraph, ERLPhase’s interactive graphing 
software. To launch RecordGraph, select one or more local records and select 
the Graph button. Alternatively you can launch RecordBase by double-click-
ing the desired record (see “Graphing Records” on page 10-1).

Get from IED Selecting a recorder file under On IED and then selecting the Get from IED 
button causes a record file on the IED to be transferred from the recorder to 
your local computer. More than one file can be transferred at the time using 
Windows file selection function (Control/Shift + left-click). This action will 
not remove the record from the IED.

Get from IED and 
Delete

Selecting a record file under On IED and operating the Get from IED and De-
lete button causes a record file on the IED to be transferred from the recorder 
to your local computer and then deleted from the IED. More than one file can 
be transferred at a time using Windows file selection function (Control/Shift + 
left-click). 

Save As Selecting a local record and selecting the Save As button copies a record to a 
diskette or a network drive. The .tlr file suffix should be retained. 

Export Selecting a local record and selecting the Export button launches the Export 
Utility. Records can be exported in common formats such as COMTRADE for 
use in other software or playback (see “Record Export Utility” on page 11-1).

Delete The Delete button can be used to delete records on the IED or locally. More 
than one file can be deleted at a time using Windows file selection functions 
(Ctrl/Shift + left-click).

Rename Select Rename to allow a local record file to be renamed. A file on IED cannot 
be renamed (button greyed out).

Refresh Selecting Refresh updates the Recordings screen. It checks the Local computer 
and the remote IED (if connected) for new and stored files. Then it updates 
Control Panel’s records database and refreshes the screen.
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9 Record Management and Display
Trigger Fault Operating this button causes the recorder to operate and generate a Transient 
or High Speed Record. 

Trigger Swing Select Swing Trigger to operate and generate a Swing or Low Speed Record. 
Swing records take about a minute due to long post trigger.

Trigger Both Select Trigger Both to operate and generate a combine fault and swing record.

Trigger Time (Local) Trigger time (local) depends on the time zone setting on your computer.

Recordings Stored Shows the number of remote records stored and percentage of recording space 
used.

File/Select Remote This function is available through the File menu. If you are online with your 
TESLA, this function selects all of the recording files displayed in the tree that 
has not yet been transferred to your local Recordings directory. You may then 
perform whatever command is appropriate for the selection set, such as a “Get 
from IED” or a “Get and Delete from IED” Command. 

Trend Listing, Transfer and Management
The trend manager services are available from the Logging tab, accessible 
from the Main Menu.

Figure 9.2:  Trend Listing

Range of Dates Set the time range using the two date control boxes, Set Range From and To. 
The initial setting is for the previous three days. When you change these set-
tings, the remainder of the display updates to show data pertinent to your cho-
sen period. If you are connected to a TESLA, both local and remote data are 
combined in the tree; otherwise, the display shows only data resident on your 
local computer.
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Channel List The tree on the left side of the screen shows the channel names of the trended 
data available for the period you have selected. You may select any number of 
channels from the tree for further operations.
Select more than one channel by using the Ctrl and Shift keys in conjunction 
with mouse clicks and arrow keys.

Trend Summary The Trend Summary section of the screen shows statistical information about 
the files you have selected. Local Files indicates the amount of space used by 
the selected trend files on your local computer. Remote Files indicates the 
amount of space used by the selected trend files on the IED. Transfer refers to 
files that are on the IED, but not on your local computer, and represents the to-
tal amount of bytes in stored trend files that would be transferred before further 
processing takes place.

Events The Events section of the display shows all the events recorded during the pe-
riod of interest set with the Range of dates

Transfer, Transfer/
Delete

When you click Transfer all of the trends not previously transferred are trans-
ferred to your computer. If you select Transfer/Delete, all files successfully 
transferred from the IED will also be deleted from the IED.

Graph The trend data selected via the Set Range and the Channel List is viewed with 
RecordGraph, ERLPhase’s interactive graphing software (see “Graphing 
Records” on page 10-1). Any files that are not already in your computer are 
transferred now.

Export The trend data selected via the Set Range and the Channel List is passed to the 
Export utility (see “Record Export Utility” on page 11-1). Any files that are not 
already in your computer will be transferred now.

Delete The Trend data selected is removed from your computer. If you are currently 
connected, you have the option of removing the remote files as well.

Fetch Events Each time you change the Range of Dates, Control Panel's Trend Manager soft-
ware attempts to display any events that occurred between those dates. If you 
are not interested in this action, click the checkbox so that the chicanery disap-
pears.

Today’s Trends If the currently selected Range of Dates includes data that is currently being 
recorded, some of the data may not be in a form that is suitable to be transferred 
to Control Panel. If this checkbox is selected, Control Panel will send a request 
to the TESLA to convert the most recent data so that it can be transferred. The 
time that this takes may be significant, and if you do not have a need for this 
data, the feature may be deselected by clicking the checkbox until the check 
mark disappears.

Print Events A listing of events that you see in the Events portion of your screen is printed.
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10  Graphing Records

Getting Started
RecordGraph is a tool that is used to display and analyze records from 
ERLPhase relays and recorders. Use it to graphically view the data recorded 
during fault, swing and trend modes. RecordGraph can be launched from 
RecordBase View software.

Launch 
RecordGraph from 
TESLA Control 
Panel

Method 1: Records
1   Open TESLA Control Panel by double-clicking on the TESLA icon on your 

desktop. If the application is not installed, install the application and then 
proceed.

2   Double-click on the Records item in the tree list or select Records and use 
the Enter key 

3   Using the Records tab, select a local record from the tree list.
4   Click the Graph button.

Figure 10.1:  Launching RecordGraph from TESLA Control Panel

When the Graph button is clicked from the TESLA Control Panel, Record-
Graph is launched with the selected record.

In the Records tab, select 
a local record from the tree list.

Click on Graph button to launch 
RecordGraph. 

Double-click Records 
or use Enter key.
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10 Graphing Records
Method 2: Auto Print
If the Auto Print option is checked (enabled) in the Records list view, then Re-
cordGraph will be automatically launched and prints the channels directly on 
to the Default printer. The layout and channel information is predefined in the 
<Default> or User-defined template.

Method 3: Trends
1   Double-click Trends from the Main Menu.
2   Select the record from the list. To select multiple records, press Ctrl key and 

click on the desired records.
3   Select the Graph button at bottom of screen.

Figure 10.2:  Launch from Logging (Trends/Events)

Double-click Logging 

(Trends/Events) from 

Main Menu.
Select a record.

Click the Graph button.
RecordGraph Window
10-2 TESLA User Manual 2000 Release Date: 2008 February 08



10 Graphing Records
Launch 
RecordGraph from 
Windows Explorer

1   Open Windows Explorer.
2   Select a record. (It should have valid extensions, *.lpr, *.lpl, *.tpr, *.tpt, 

*.tlr, *.bpr,*.fpr.) 
3   Right-click the selected record.
4   Choose, the RecordBaseView>Launch Graph option.

Figure 10.3:  Launching RecordGraph from Windows Explorer

Select a record (should have
valid extensions: *.lpr, *.lpl, 
*.tpr, *.tpt, *.tlr, *.bpr,*.fpr). 

Right-clicking on the record 
brings up the context menu 
with the RecordBase View 
item.
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10 Graphing Records
 RecordGraph 
Components

   •  Main menu items
   •  Tool bar buttons
   •  A drop-down box lists the templates associated with the current record’s 

IED
   •  A left-hand side pane (LHS) or tree view lists the names of records to be 

displayed or analysed
   •  A right-hand side pane (RHS) displays the graphs in various views. Initially 

a single blank screen appears.
   •  A right-click context menu on both the LHS and RHS pane.
   •  RecordGraph version is displayed in the Help>About RecordGraph.

Figure 10.4:  Components of RecordGraph Window

LHS pane 

(Tree View) 

lists records

RHS Pane shows graphic display

Template List

Tool Bar

Main Menu
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10 Graphing Records
Menus

Figure 10.5:  Menus

Set Graphs Per Page
Add Analog Graph
Add Digital Graph
Delete Graph
Move
Copy Trace
Paste Trace
Delete All Traces
Copy Trace Data to 
  Clipboard
Change Trace Color...
Active Trace Information...

Save Template
Save Template As...
Template Manager...
Print...
Print Direct
Print All
Print Preview...
Export...
Delete
Show Record Summary.
Import...
Exit

RecordGraph
File     View     Graph     Measure     Scale     Options     Help

File

View
Add...
Delete
Rename Tab
Titles...
Copy to Clipboard
Save as Metafile...
Show Channel List
Line
Toolbar

Graph

Measure
Markers
CrossHairs
Primary
Secondary
Time Alignment
Absolute Time
Fundamental RMS
True RMS
Harmonics
Symmetrical Components

Scale
Zoom X Axis +
Zoom X Axis -
Zoom Y Axis +
Zoom Y Axis -
Undo Zoom
Reset Zoom
Change Scale (Y-Axis)

Options
Calculate Derived Channels Now...
Show Grid
Show X Axis Ticks
Show Legends
Show Trigger Markers
Lock Markers
Extend Print Range
Set Phase Colors...
Set Precision

Help
User Manual
About RecordGraph...
Show Hotkeys...
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10 Graphing Records
RecordGraph Menu Items
File Menus File>Save Template

Figure 10.6:  Save Template

Use this option to save the current graphical layout information to a file (see 
“Templates” on page 10-56 for further explanations on templates and their role 
in graphical analysis).
When this option is chosen and if there are no templates in the template list, 
then a Save As Template dialog box is displayed. Otherwise, the current layout 
information is saved in a file as shown in the template list box.

File>Save Template As…

Figure 10.7:  Save Template As

Save the current graphical layout information in a different file. A dialog box 
is displayed to choose the template file name. The check box, save as default 
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10 Graphing Records
template, if checked, saves the current template as a user-defined default tem-
plate (see “Templates” on page 10-56).

File>Template Manager

Figure 10.8:  Template Manager

Rename, duplicate, save as, import or delete template files. A dialog box is dis-
played to manage the template files (see “Templates” on page 10-56).

File>Print

Figure 10.9:  Print

Print the active (visible) view. Use this option to select the type of the printer 
and other configurations associated with it through the standard print dialog 
box options.
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File>Print Direct

Figure 10.10:  Print Direct

Send the active view directly to the default printer. When this option is chosen, 
the standard print dialog box is not displayed. The active view is sent directly 
to the default printer for printing, but you can cancel the printing if the print 
status dialog box is displayed.

File>Print All

Figure 10.11:  Print All

Send all the pages of all the views to the default printer. Select this option to 
print multiple views (visible and invisible) to the default printer. 

Multiple Views
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File>Print Preview

Figure 10.12:  Print Preview

Display the print preview window of the active view page.

File>Export

Figure 10.13:  Export

Export the selected record to a user-defined format (see “Record Export Utili-
ty” on page 11-1).

File>Delete
Delete the currently selected record from the tree view. This option does not 
clear the view associated with the record.
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File>Show Record Summary

Figure 10.14:  Show Record Summary

Display the record summary and the event list of the active record in a dialog 
box.

File>Import

Figure 10.15:  Import

Choose this option to import a COMTRADE file and display a standard open 
file dialog box to select *.cfg COMTRADE files.

File>Exit
Exit the RecordGraph application. Save your graphical layout information be-
fore selecting this option.
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View Menus View>Add
Create a new view and add it to the existing layout (see “Views” on page 10-
32).

View>Delete

Figure 10.16:  Delete

Delete an active view from the layout. When you select this option, a dialog 
box appears to confirm the deletion of the view. If accepted, the current view 
is deleted from the layout.

View>Rename Tab

Figure 10.17:  Rename Tab

Replaces the name on the active view tab with one of your choice. A dialog box 
appears to enter the name.

Renames this tab
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10 Graphing Records
View>Titles

Figure 10.18:  Titles

Select graph and view titles options to compile titles and various options (see 
“View and Graph Titles” on page 10-62).

View>Copy to Clipboard
Copy an active view to the clipboard for import to another program such as MS 
Word or Excel (see “Record Export Utility” on page 11-1).

View>Save As Metafile
Save an active view page as a Windows metafile (see “Record Export Utility” 
on page 11-1).
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10 Graphing Records
View>Show Channel List

Figure 10.19:  Show Channel List

Hide or show the channel list displayed in the tree view.

View>Line

Figure 10.20:  Line

Place a reference line on the graph (for Impedance and Differential views 
only). Use Line in conjunction with the CrossHair measurement for quick 
readouts. When you choose this option free form zooming is disabled. Clear 
the line to enable free form zooming.

View>Tool Bar
Show or hide tool bar from the main window.
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Graph Menus Graph>Set Graphs Per Page

Figure 10.21:  Set Graphs Per Page

Set up the number of graphs per view; up to eight graphs are allowed using the 
Set Graphs Per Page option. Timeline, Overlay and Trend Views allow a max-
imum of 36 graphs. Use Add Analog Graph or the Insert key to add one graph 
at a time.

Graph>Add Analog Graph

Figure 10.22:  Add Analog Graph

Add an analog graph to the existing view or use the Insert key.
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Graph>Add Digital Graph

Figure 10.23:  Add Digital Graph

Add a digital graph to the existing view. This graph shows the digital status in-
formation in the form of thick or thin stacked traces. You can plot up to 32 trac-
es in a single graph.

Graph>Delete Graph

Figure 10.24:  Delete Graph

Delete an active graph (click any graph to make it active) from the existing 
view or use the Delete key.
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Graph>Move

Figure 10.25:  Move

Rearrange the relative position of the graphs in the active view page. First se-
lect the graph and use either the Move>Up or Move>Down option to change 
the position of the graph. 

Graph>Copy Trace

Figure 10.26:  Copy Trace

Copy an active trace from the selected graph. Use this option in conjunction 
with the paste trace option. You need at least one channel on a graph to use the 
copy operation.

Copies this trace
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10 Graphing Records
Graph>Paste Trace

Figure 10.27:  Paste Trace

Add or replace an existing trace in the selected graph. In Timeline View an an-
alog graph supports one trace per graph. In an Overlay View you can select up 
to 32 traces per graph. If you use the paste operation in Timeline View, and if 
the graph has a trace, it is replaced with the one just copied or adds the trace if 
there is no trace. In Overlay View it adds the trace to the existing graph.

Graph>Delete Trace

Figure 10.28:  Delete Trace

Select a graph and the trace to be deleted and use Delete Trace to delete from 
the active graph. In the case of Overlay View a graph can have multiple traces. 
You can select a trace by clicking on the channel name and use delete trace op-
tion to delete the selected trace. 

Trace copied

Trace pasted

Delete Trace removes 
this trace from the graph
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10 Graphing Records
Graph>Delete All Traces

Figure 10.29:  Delete All Traces

Deletes all the traces from the active graph. In an Overlay view this action re-
moves all the traces.

Graph>Copy Trace Data to Clipboard
Copy trace data from the active graph to the clipboard (see “Exporting Channel 
Data” on page 10-73).

Graph>Change Trace Color

Figure 10.30:  Change Trace Color

Change the trace color of the selected trace. In the Overlay View this option 
only changes the color of the active trace.

All traces are removed 
from the graph

Color of this trace is changed
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10 Graphing Records
Graph>Active Trace Information

Figure 10.31:  Active Trace Information

Display the trace information of the active graph.

Measure Menus Measure>Markers

Figure 10.32:  Markers

Set or clear markers X and O on all graphs in the active view. If the markers 
are out of range, double-click the time axis to bring them back into the view. 
When markers are placed, depending on the type of measurements option, 
readouts appear on the right hand side as shown corresponding to the positions 
of X and O marker. In case of multiple traces, the readout refers to the currently 
active (selected) trace. 

Amplitude readouts 
corresponding to X & O

Time display corresponding 
to X & O
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Measure>CrossHair

Figure 10.33:  CrossHair

Set or clear crosshair cursor measurement by dragging the mouse (left-click 
and move) anywhere on the graph to display the readout. The difference be-
tween the marker and crosshair readout is that the marker values correspond to 
the data values, whereas the crosshair measurement corresponds to the x and y 
coordinates. When this option is selected, you can measure coordinates of any 
graph in the active view.

Measure>Primary

Figure 10.34:  Primary

Set scale to primary values (depending on the scale factors CT/PT ratios) on all 
the graphs in the currently active view. The current choice (primary or second-
ary) is displayed on the status bar.

CrossHair 
measurements

Primary Scale
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Measure>Secondary

Figure 10.35:  Secondary

Set scale to secondary values (depending on the scale factor of CT/PT ratios) 
on all the graphs in the currently active view. The current choice (primary or 
secondary) is displayed on the status bar.

Measure>Time Alignment
Offset X axis (trigger time alignment) for the currently active trace on the 
graph (see “Readouts and Measurements” on page 10-64).

Measure>Absolute Time
Display absolute time (actual recorded time) measurements for the active trace 
of the graph (see “Readouts and Measurements” on page 10-64).

Measure>Fundamental RMS
Display fundamental RMS measurement for the active trace of the graph (see 
“Readouts and Measurements” on page 10-64).

Measure>True RMS
Display true RMS measurement for the active trace of the graph (see “Read-
outs and Measurements” on page 10-64).

Measure>Harmonics
Display harmonics measurement – up to 5th order and THD expressed in per-
cent with reference to the fundamental (up to 25 harmonics depending on the 
sample rate) for the active trace of the graph (see “Readouts and Measure-
ments” on page 10-64).

Measure>Symmetrical Components
Display symmetrical components measurement for the active graph.You must 
select a, b and c phase quantities in Overlay View to enable this option (see 
“Readouts and Measurements” on page 10-64).

Secondary Scale
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10 Graphing Records
Scale Menus Scale>Zoom X Axis +

Figure 10.36:  Zoom X Axis +

Select this option to decrease the x axis range by 25% of the current zoom 
range.

Scale>Zoom X Axis -

Figure 10.37:  Zoom X Axis -

Select this option to decrease the x axis range by 25% of the current zoom 
range.
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Scale>Zoom Y Axis +

Figure 10.38:  Zoom Y Axis +

Select this option to decrease the y axis range by 25% of the current zoom 
range.

Scale>Zoom Y Axis -

Figure 10.39:  Zoom Y Axis -

Select this option to increase the y axis range by 25% of the current zoom 
range.
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Scale>Undo Zoom

Figure 10.40:  Undo Zoom

Display the previous zoom level.

Scale>Reset Zoom

Figure 10.41:  Reset Zoom

Reset the graphs to the initial zoom level.

Reset zoom levels
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10 Graphing Records
Scale>Change Scale (Y axis)

Figure 10.42:  Change Scale (Y axis)

Change Y axis to a desired minimum and maximum value using the dialog box 
to set the new values. If the manual scale option is checked, the y axis is not 
rescaled to new data values; the trace is displayed within the selected range. 
You can set the desired scaling, save the options in the template and recall the 
template for other recordings (see “Templates” on page 10-56).
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Options Menus Options>Calculate Derived Channels Now
Use this option to calculate the derived channels and append to the record as 
virtual channels. For TESLA records the data is written back to the original 
record so that the next time the record is viewed all the derived channel infor-
mation is readily available (see “Calculated Channels” on page 10-71).

Options>Show Grid

Figure 10.43:  Show Grid

Turn grid on or off on all graphs.

Options>Show X Axis Ticks

Figure 10.44:  Show X Axis Ticks

Show X axis ticks on all graphs.
10-26 TESLA User Manual 2000 Release Date: 2008 February 08



10 Graphing Records
Options>Show Legends

Figure 10.45:  Show Legends

Show or hide legends on all the graphs.

Options>Show Trigger Marker

Figure 10.46:  Show Trigger Marker

Show or hide trigger marker on the active graph and active curve.
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Options>Lock Markers

Figure 10.47:  Lock Markers

Lock or unlock X and O markers.

Options>Extend Print Range

Figure 10.48:  Extend Print Range

Print all the channels of the view for the entire data range in the current zoom 
level.

X and O markers 
are locked

Entire data is printed in multiple 
pages at the current zoom level
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Options>Set Phase Colors

Figure 10.49:  Set Phase Colors

Use this option to select user-defined colors for A, B and C phase voltages and 
currents. When the colors are selected, the channels are automatically identi-
fied based on the color. The default values for A, B and C phase quantities are 
red, blue and green respectively.

Options>Set Precision

Figure 10.50:  Set Precision

Set the precision (number of decimal places) for the readouts. In Symmetrical 
Component and Harmonic Views, the phase angle readout precision is always 
zero (no decimal places are used).

These readouts have 
4 decimal places
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Help Menus Help>User Manual
Select to display an electronic version of the user manual.

Help>About RecordGraph
Display program information, version number and copyright.

Help>Show Hot Keys
Lists the available hot keys or short cuts.

Tool Bar Buttons

Figure 10.51:  Tool Bar Buttons

In the Tree View, you can expand a loaded record to identify the recorded and 
calculated channels (if configured). A right-click menu is available to manip-
ulate the tree items. Most of the tool bar buttons work in a similar way to that 
of the menu items explained in the previous sections.

RecordGraph

File View Graph Measure Scale Options Help

<Default>

Save Template

Show Record Summary

Export...

Print

Add a View

Titles

Add Digital Graph

Add Analog Graph

Set Graphs Per Page

Show/Hide Trigger Marker

Markers

Move Graph Down

Move Graph Up

Zoom X Axis +

Zoom X Axis -

Time Alignment

Zoom Y Axis +

Zoom Y Axis -

Reset Zoom

Show/Hide Legends 

Trace Information

Show/Hide Tree View (Channel List)

Paste Trace

Copy Trace

Change Scale (Y-Axis)

Increase Left Margin

Decrease Left Margin

Line

CrossHair

Recorder Data and Impedance Options

Delete Graph

Tool Bar Buttons

Save Template Save template file on the disk.

Show Record Summary Displays record summary (events, trigger time, 
etc.)

Export Brings up export module.
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Print Prints record.

Add a View Adds a graph view that displays the fault infor-
mation.

Titles Places a title above graph for all views (see 
“View Title Options” on page 10-63).

Impedance Creates an R-X plot before, during and after 
fault.

Markers Displays vertical lines "x" and "o" to find the 
coordinate values on the graph.

Show/Hide Trigger Marker Displays/hides zero trigger marker.

Set Graphs Per Page Sets number of graphs per page.

Add Analog Graph Add an analog graph.

Add Digital Graph Add a digital graph.

Delete Delete a graph.

Zoom X Axis + Enlarges the trace range on X axis.

Zoom X Axis - Reduces the trace range on X axis.

Zoom Y Axis + Enlarges the trace range on Y axis.

Zoom Y Axis - Reduces the trace range on Y axis.

Reset Zoom Resets zoom control.

Move Graph Up Vertically moves graph upwards.

Move Graph Down Vertically moves graph downwards.

Time Alignment Offset X axis time value. 

Change Scale (Y Axis) Scale Y axis minimum and maximum range.

CrossHair Displays X and Y coordinate values.

Line Available only for impedance view, draws a ref-
erence line.

Copy Trace Copies a trace to another location.

Paste Trace Pastes a trace.

Show/Hide Legends Displays/hides legends the traces. 

Trace Information Displays/hides channel information: Date, Sta-
tion Name, RecordName, Channel Name.

Show/Hide Tree View 
Channel List

Expands and minimizes RHS of the screen.

Decrease Left Margin Decreases left margin.

Decrease Right Margin Decreases right margin.
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Views 
The view screen graphically displays information from the record. A view is 
associated with a tab at the bottom of the screen which can be renamed using 
the Rename tab. You can create a maximum of 15 view tabs.

 Add a View Add new view to layout.
1   Select the View>Add... from the top menu bar or the Add... button from the 

tool bar.
2   Select the desired view from the shortcut menu.
3   Click OK.

Figure 10.52:  Add a View

Delete a View Clears active view from layout.
1   Select the View>Delete from top menu bar. A shortcut menu asks you to 

confirm the deletion. 
2   Click OK to confirm. Click Cancel to stop deletion.

The Add View… option lists Impedance View only if the selected 
record is from an L-PRO, TESLA or COMTRADE record.

Select View>Add... or 

click the Add button 

to create a view type.

Select desired view 

and select OK.

View Tabs
10-32 TESLA User Manual 2000 Release Date: 2008 February 08



10 Graphing Records
Rename a View Use this option to rename the active tab which is displayed at the bottom of the 
view.
1   Select the View>Rename Tab from top menu bar or right-click on the graph 

to bring up the context menu and select Rename Tab.
2   A dialog box appears with the old name. Modify and click OK to rename 

the view.

Figure 10.53:  Rename Dialog Box

Show Channel List Displays or hides the channel list on the left-hand side of the screen to allow 
more space for the graphs.

Toolbar Displays or hides the toolbar on the left-hand side of the screen to allow more 
space for the graphs.
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Graphs
The graph is an area or space in a view where each channel of analog or digital 
information is shown. The information is shown as X-Y data with X = time and 
Y = magnitude. 

Adding Graphs 1   Select Graph>Set Graphs Per Page or right-click on the graph to bring up 
the context menu and select Set Graphs Per Page to add selected number 
of graphs to the Timeline View.

2   Select Graph>Add Analog Graph or right-click on the graph to bring up the 
context menu and select Add Analog Graph to add an analog graph to the 
Timeline View.

3   Select Graph>Add Digital Graph or right-click on the graph to bring up the 
context menu and select Add Digital Graph to add an digital graph to the 
Timeline View.

A maximum of 36 graphs (analog and digital) can be created for each Timeline 
View, Overlay View and Trend View.

Adding Channels 1   Click the desired channel to be displayed on the graph.
OR

2   Drag a channel and drop it onto the desired graph.
3   Depending on the view type following action takes place:

   •  In a Timeline View the existing channel is replaced and only one chan-
nel is allowed per graph.

   •  In an Overlay View up to 32 traces can be placed per graph.
   •  In a Trend View the existing channel is replaced and only one channel 

is allowed per graph.
   •  External or digital channel should be placed on a digital graph to stack 

the traces. A maximum of 32 traces can be specified per graph.

Channel Tool-tip When the cursor is moved over the channel name, following information is dis-
played in the tool-tip window.
   •  Device – name of the device (example, TESLA)
   •  Record – name of the record
   •  Max – channel maximum value along with the unit 
   •  Min – channel minimum value along with the unit
   •  X – Offset-whether the x-axis has offset (time alignment)
   •  Samples – number of samples 
   •  Sample rate –samples /second
   •  IRIG-B status indicator
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Figure 10.54:  Tool-tip

Zoom Using the 
Mouse

1   Left-click on any graph and drag to form a small box around the graph area.
2   When you release the mouse, the trace assumes new zoom position deter-

mined by the area of the zoom coordinates. 

Figure 10.55:  Select a Section of the Graph to Zoom

Tool-tip window

Drag a box around the 

graph area to be 

zoomed.
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Figure 10.56:  Portion of Zoomed Graph

Follow the procedure 1 and 2 for further zooming.

Zoom Using the Tool 
Buttons

You can also use Zoom X axis +, Zoom X axis -, Zoom Y axis + and Zoom Y 
axis - on the tool bar buttons to quick zoom in and zoom out (25%).
Repeat step 1 to zoom further.

Zoom only X or Y 
Axis

To zoom only the X axis, select Ctrl key and use the mouse to draw a box on 
the graph.
To zoom only the Y axis, select shift key down and use mouse to draw a box 
on the graph.

Undo Zoom on 
Graphs

1   Right-click on the graph to the context menu.
2   Select the UndoZoom option.
3   Graphs are redrawn to the previous zoom level.
4   Select Reset Zoom option to reset the graphs to the initial zoom level. This 

can be chosen at any stage.
10-36 TESLA User Manual 2000 Release Date: 2008 February 08



10 Graphing Records
Pan Graph Zoom the graph (if not zoomed) to a required zoom level.
You should hold the “Thumb track” and move it along the scroll bar. To have 
fine control click on the right arrow scroll bar button or press Ctrl and click on 
the right arrow scroll button.

Figure 10.57:  Thumb Track

Keyboard Functions The keyboard is also available for zooming, setting markers and positioning 
graphs. To display the keyboard hot key menu right-click on the graph and 
bring up the context menu, select Hot keys option.

Figure 10.58:  Hot Keys

Thumb Track - move right/left to pan graph
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Right-click Context 
Menu

Figure 10.59:  Right-click Context Menu
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Timeline View

Figure 10.60:  Timeline View

   •  Timeline View is designed to “stack” channels and has single time line axis 
common for all the graphs. 

   •  Each analog graph in this view can hold only one trace. 
   •  Each digital graph in this view can hold 32 traces (8 traces are preferred). 
   •  Selecting a channel from the LHS tree view while the same graph is active 

replaces the existing channel with the currently selected one. 
   •  A maximum of 32 graphs (analog and digital) can be added per view. 
   •  You can mix and match channels from different records and/or IEDs. 
   •  Time line view displays read-out (if markers are on) on the RHS and chan-

nel information on its LHS. 
   •  Read-out corresponds to the currently selected channel type and the scale 

(primary/secondary) which is displayed on the status bar. 

Channel Information

Tool Tip

Record Information

Read-out Markers
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Overlay View

Figure 10.61:  Overlay View

   •  Overlay View is designed to “overlay” channels and has single time line 
common axis for all the graphs. 

   •  Each analog graph in a overlay view can hold 6 traces. 
   •  Each digital graph in this view can hold 32 traces (8 traces are preferred). 
   •  Selecting a channel from the LHS tree view while the same graph is active 

overlays the channel on the selected graph. 
   •  A maximum of 32 graphs can be added per view. 
   •  You can mix and match channels from different records and/or IEDs. Time 

line view displays read-out (if markers are on) on the RHS and channel in-
formation on its LHS. 

   •  Read-out corresponds to the currently selected channel type and the scale 
(primary/secondary) which is displayed on the status bar. 

Channel Information
Record Information
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s

t

Symcom View

Figure 10.62:  Symcom View

   •  Symcom View is designed to analyse symmetrical components of voltage 
or current channels.

   •  You must load 3 voltage or current channels to view the components and 
associated phasor plots from the same record.

   •  The view displays: analog channels, positive, negative, zero sequence 
phasors and corresponding table which contains numerical values of these 
components and phase angle.

   •  All the components are calculated in RMS values.
   •  Channel instantaneous values are displayed on the RHS of the analog 

graph.
   •  Markers are permanently set on the graph one-cycle apart.
   •  Grab the marker and move (on the time line axis) to display new set of com-

ponents and phasor values.

A, B, C Phase Analog Channel

Phasor and Symmetrical

Component Graph

Diplay of Phases (A, B, C)

Channel Names

Record Title

Markers locked one cycle apar

Time Display

Instantaneous Channel 
Amplitude Display
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rt
Harmonic View

Figure 10.63:  Harmonic View

   •  Harmonic View is designed to analyse harmonics associated with analog 
channels.

   •  A maximum of 3 traces can be analysed per view.
   •  The view displays: analog channels, a bar graph of harmonics and a table 

which contains RMS values of the harmonics with phase angle.
   •  A maximum of 25 harmonics (order) can be displayed.
   •  Channel instantaneous values are displayed on the RHS of the analog 

graph.
   •  Markers are permanently set on the graph one-cycle apart.
   •  Grab the marker and move (on the time line axis) to display a new set of 

harmonics.

All harmonic phase angles are compensated and referenced with re-
spect to A-phase voltage in relays and a configured channel in TES-
LA recorder. For COMTRADE records phase voltage is the analog 
channel considered as the reference phase.

Analog Graph

Bar Graph of
Harmonics
Amplitude

Table displays

Harmonic Amplitude

with corresponding 

Phase Angles 

Channel Names

Record Title

Markers locked one cycle apa

Time Display

Instantaneous Channel
Amplitude
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Impedance View Impedance View is an R-X plot. The R-X quantities are calculated over the en-
tire data range from the recorded analog voltage and current channels. R-X plot 
is useful in analyzing the performance of L-PRO relays and swing disturbances 
from the TESLA recorders. Since the information to be displayed involves 
time as a third dimension, this view provides meticulous cursor and zoom con-
trol over the data points being viewed. Optionally it supports superimposition 
of the relay characteristics (Zone 1, Zone 2, Line, Blinders, etc.) from L-PRO 
records or files generated from any L-PRO Offliner settings program. 
The following table summarizes the types of channels from which impedance 
(R and X values) is derived along with the supported product. RecordGraph 
displays these channels on the left hand side in the tree view. Depending on the 
product, the following basic quantities are used the respective impedance chan-
nels.
In impedance calculation, a threshold limit is used based on the fundamental 
RMS value of the current to include or exclude the R and X values for plotting. 
This limit depends on the CT module used for the relay or recorder application. 
For 1A CT module, 0.02 A is the limit whereas for a 5A CT module, 0.1 A is 
used as the limit. When the data is copied to the clipboard, the discarded values 
of R and X values are not exported.

To add an Impedance view select View>Add.. or the Add a View tool bar but-
ton. From the dialog box select Impedance View.

Sl. No. Channel Types Quantities Supported Products

1 High Speed (HS) Voltage and Current L-PRO, TESLA, 
COMTRADE

2 High Speed (HS) Positive Sequence Voltage 
and Current

TESLA

3 Low Speed (LS) Voltage and Current TESLA

4 Low Speed (LS) Watts, Vars and Voltage 
(Phase and Sequence)

L-PRO, TESLA

5 Low Speed (LS) Positive Sequence Voltage 
and Current

L-PRO, TESLA

6 Low Speed (LS) Impedance (Phase and 
Sequence)

L-PRO, TESLA
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Figure 10.64:  View>Add> Impedance

When the Impedance View option is selected, following initial screen is dis-
played.

Figure 10.65:  Opening Impedance Screen

The Add View… dialog box lists the Impedance View only if the se-
lected record is from L-PRO or TESLA or COMTRADE records de-
pending on the record type.

(1) View Title 

(2) Basic channel names 
and derived impedance type 

(5) Time Window width 
and position control (4) Time Window 

(6) X and O markers 

(3) Graph Zoom control 
(x-y axis zooming) 
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Components and Controls
(1) A text component displays the title at the top of the Impedance View shown 
in Figure 10.65: Opening Impedance Screen. The title is compiled from items 
in the Title Options dialog box. Default title is the file name and trigger event.
(2) The basic channel names are displayed below the title, refer to table “Chan-
nel Types” on page 10-43.
(3) The graph zoom is controlled using the sliding control on the right side of 
the window. The R-X plot aspect ratio is maintained under all zooming tools. 
The graph zoom control offers a 10x zoom factor between minimum and max-
imum amplitude of the data (R and X coordinates). 
(4)The Time Window control provides a means to select the range of data for 
better presentation of R-X values. For example, if the voltage and current chan-
nels are recorded from 0.0 to 0.2 seconds with 1000 data points, using this con-
trol, you can choose to view only 0.1 second data (500 points). 
(5) Time window width and position control can be used for the precise data 
analysis. 
(6) Control the X and O markers.

Create Impedance View with an TESLA Record
1   Launch RecordGraph with an TESLA high speed (fault) record and expand 

the channels in the tree view. 
2   Create an Impedance View using View>Add… or use the tool bar option.
3   Select line voltages A, B and C, and corresponding line currents A, B and 

C from the tree view. Impedance (R and X) corresponding to Zab, Zbc and 
Zca phase-phase are calculated internally and displayed.

Figure 10.66:  Create Impedance View with an TESLA Record

Actual channel names 
(as selected from the 
tree view)

Phases of the  basic 
voltage and currents

Resolved impedance 
name

Time Window
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Each channel name is divided into three parts:
   •  the basic quantity (voltage or current) used in the calculation of the imped-

ance
   •  the name of the actual channel selected
   •  the resolved impedance name with the configuration (phase-phase or 

phase-ground)
The Time Window control shows the minimum and maximum time of the data 
viewed. In the above example, the full range data is viewed.
Use the graph zoom control to zoom the x and y axis.

Figure 10.67:  Example of graph zoom control

When you move the mouse near the edge of the Time Window control, the cur-
sor shape changes from normal arrow to two headed arrow as shown in the di-
agram. Now you can resize the thumb track to a desired level of data range. In 
the example, the data starts at position -0.200 and ends at (-0.200 + 1.383), 
where 1.383 is the width (total data range). Therefore, only small portion of the 
data can be viewed. 

The thumb track is moved 
from top to the position 
indicated and the traces 
are zoomed in.
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Figure 10.68:  Example of using Time Window control

If you move the thumb track (not resize) to the extreme end, then the traces are 
rendered in the new data range.

Figure 10.69:  Time Window control moved to new location

In the above case, the data is included from range 0.007 to 0.007 + 1.176, 
where 1.176 is the data width. The 1.176 width remains same. If you resize the 

Time Window control 
is resized to include 
only portion of the data

Time Window enlarged

Time Window control is 
moved to include 
different range of the data

Time Window enlarged
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thumb track, then the width can be controlled; or you can double-click near the 
number 1.176 to get a dialog box to enter the data range precisely.

Figure 10.70:  Indicate data range

A dialog box appears to enter the width or data range, which is indicated by the 
size of the thumb track. The scale indicates the step by which the data is incre-
mental. For example, when the spin control arrow is clicked (after closing the 
dialog box), if an up arrow is clicked, the data is incremental from present po-
sition to present position + 5%. On the other hand, if the down arrow is clicked, 
the data is detrimental by 5%.

Example to Superimpose the L-PRO Relay Characteristics

Figure 10.71:  Superimpose the L-PRO Relay Characteristics

When you select the Relay data & impedance options button, a dialog box ap-
pears. The parameter required, such as k0 factor, the line sequence impedance 
values, the system voltage data and the other required information is initialized 
through this dialog box initialization. All these values are read from the set-
tings file opened through the impedance option dialog box.

A dialog box pops-up to enter
the width or data range
indicated by the size of the 
thumb track. The scale
indicates the step by which 
the data is incremented.

Click this button to 
apply L-PRO relay
characteristics through
the impedance options 
dialog box
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In the Relay data and impedance options dialog box check the Zone 1 to Zone 
4 boxes and select the Apply button. All the four zone characteristics are super-
imposed on the calculated phase impedances (note that the characteristics are 
zoomed using free-form zoom to get a better resolution).

Relay data and impedance options

L-PRO settings file Radio button to select relay characteristics from the current 
record. If an L-PRO record is selected, this button is enabled. 

Current record  If a TESLA or COMTRADE record is selected, this button is 
enabled.

File Displays the settings file (full path name) from which the relay 
data is extracted to plot the impedance characteristics.

Browse Gives an option to select the settings file from any other location. 
The file type filter reads or selects only *.lps file type, if L-PRO 
setting file is selected.

Impedance Options Impedance configuration option includes a number of other 
options, such as, Phase-Phase, Phase-Neutral, radio button. 
Depending on this option and the type of channel, different 
impedance options (check buttons) are enabled.

Configuration Zpos (positive sequence impedance 3 phase basis)

Zan, Zbn or Zcn

Zab, Zbc, or Zca

Other Impedance

Z-Line Displays the line angle (can be checked or unchecked)

Z-Load Displays the coordinate of the load impedance (can be checked 
or unchecked)

Blinders Available only if the Phase-Phase option is chosen.

Directional

Zones to display Phase-Ground or Phase-Phase

Zone 1 to 4 Zone1-Zone4 displays the respective zones impedance charac-
teristics (can be checked or unchecked)

Apply Redraws the display with the currently selected options.

Launch Launches the setting file through the Offliner settings program. 
Note that the L-PRO Offliner setting program should be installed 
for this to work successfully.

Close Closes the dialog box.
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Figure 10.72:  Example superimposing the zone characteristics

In the above example phase-phase impedances Zab, Zbc and Zca are selected, 
indicated by a check mark, but only Zca is in the zoom range. 
All the four zones mho characteristics are superimposed. You can see that the 
Zca impedance has entered the Zone 2 and Zone 3. You can use a combination 
of zoom and time window control to analyze the precise time at which the im-
pedance enters the zones.

Figure 10.73:  Example showing the Line and Blinder impedances

Check the Z-Line and Blinder boxes; then select the Apply button to superim-
pose the line and blinder impedances.

Line Impedance

Blinder Impedance
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Figure 10.74:  Example illustrating the use of the CrossHair measurement

Select the CrossHair button. When you drag the mouse (left button down and 
move) on any point on the trace, the R, X and the Z corresponding values are 
displayed.
You can move the cursor anywhere on the graph to get the measurement. When 
this feature is enabled, free form zooming is disabled; but you can use the 
graph zoom control to get a closer look at the trace.

Figure 10.75:  Example of the Line feature

Set a reference line to measure the data using the Line feature. This line is a 
reference line and not associated with the data values.

Select this button to 
enable CrossHair 
measurement feature

CrossHair 
measurements

Select this button to 
set an arbitrary line

Arbitrary line for the
reference purpose
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When the line option is enabled, the free form box zooming is disabled. Dis-
able the CrossHair measurement to resize and move the reference line; then en-
able the CrossHair option to measure the values.

Figure 10.76:  Example of the Legends feature

Use the legend feature to distinguish relay characteristics from the calculated 
impedances. You can move the legend box and resize to the desired level. You 
can hide the legend box by re-selecting the legend option again.

Figure 10.77:  Legends features moved and enlarged

Legend feature button

Legend box with all the 
relay characteristics 
impedance names

Resized legend box showing
all the relay characteristics 
impedance names
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Figure 10.78:  Example illustrating the use of data markers

Select the marker option to set the markers. Select the desired channel name 
for the required measurement. For example, the channel associated with Zca is 
chosen (click this channel name for the selection). Move the marker by sliding 
it to the desired location. When you change the data range (using Time Win-
dow control), the cursors may disappear from the traces indicating that the 
markers are always associated with the data.

Figure 10.79:  Example of TESLA swing record choosing positive sequence voltage and 
current

Select a TESLA swing record and expand the channels. Click the positive se-
quence voltage and current; RecordGraph automatically calculates and dis-
plays the positive sequence impedance.

Cursor corresponding 
to marker O

Marker button

Cursor corresponding 
to marker X

Marker X and O Marker X and O 
readouts

Select channel name

Positive sequence 
impedance trajectory
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Figure 10.80:  Example of TESLA swing record choosing watt, var and positive se-
quence voltage channels

Select an TESLA swing record and expand the channels as shown. Click the 
watt, var and positive sequence voltage; RecordGraph automatically evaluates 
and displays the positive sequence impedance.

Figure 10.81:  Example of TESLA swing record choosing impedance channel

Select an TESLA swing record and expand the channels as shown. Click the 
impedance channel; RecordGraph automatically displays the positive se-
quence impedance trajectory.
As you select the desired channels, the impedance (R-X characteristics) are su-
perimposed on the existing relay characteristics. To select new set of voltage 
and current channels use the Delete trace(s) option from the right-click context 
menu and select new channels. If desired, you can modify or re-apply the im-
pedance options.
Drag the thumb track on the scroll bar to zoom in or zoom out the axis range. 
In the Time Window control + click the arrow buttons or drag the thumb track 
to scroll the window of visible data in the time domain.

Positive sequence 
impedance trajectory

Positive sequence 
impedance trajectory
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To place the X and O markers use the tool bar or the right-click context menu 
or the View>Markers option, dragging a marker to the right or left moves cor-
responding marker. If the Time Window control does not show the data, then 
the markers are shown as small triangles on the left or right sides. If you click 
the triangle, corresponding data cursor is displayed and the time range is auto-
matically adjusted.
You can save all the impedance display options to a template file (File> Save 
template

Trend View

Figure 10.82:   Trend View

   •  Trend View is designed to display “trend” data.
   •  It has a special x-axis, common to all the graphs to display the data in the 

“date” format. When zoomed, the scale automatically changes depending 
on the date range. (For example: years/months or months/days or days/
hours or hours/minutes or minutes/seconds).

   •  Each analog graph in a trend view can display one trace.
   •  A maximum of 32 graphs can be added per view.
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Templates

Figure 10.83:  Template List

Template contains user-defined layout information including:
   •  Views – graphs and their location along with the traces (channels)
   •  Markers position (X, O and trigger marker, T)
   •  Views and graphs title options
   •  X axis scaling (zooming information)
   •  Y axis scaling (zooming information)
   •  X axis shift (time alignment) of each channel
   •  Measurement (readout) options
   •  Left Margin
Template stores the easy-to-manage layout information in a file based on prod-
uct type (B-PRO, F-PRO, L-PRO, T-PRO, TESLA, COMTRADE).
When the template information is stored, it can be applied to any recording 
(normally from same IED or product) for which the template is valid. For ex-
ample, if a template has 3 views with 3 graphs per view, and has 1, 2 and 3 an-
alog channels displayed with various options, this information can be applied 
to any record with that common framework. The concept is to re-use the com-
mon layout information and update the data information with the new recorded 
channels thus reducing the graph re-creation processing time.
These flexible and user-defined templates can be shared among different users. 
Normally (under default installation options), templates are stored on the local 
hard disk in a sub-folder where the RecordGraph application resides, for exam-
ple, c:\Program Files\NxtPhase\RecordGraph\template

Templates associated with a record.

Left Margin
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The template graphical layout file contains information about fixed views, 
graphs, traces, marker positions, read-out, scaling and zoom range. You can 
analyze a system disturbance recorded at different times and at different loca-
tions using the template.
When a template is opened, the predefined layout information is automatically 
applied based on the new record (or set of records). You can save time by view-
ing the data recorded without manually loading the traces again. Templates are 
the first step in generating a visual report.
You automatically form a template when you create views and graphs. To re-
apply the template to a different recording from the same or different recorder, 
you must save this layout information in a file. You can extend or alter tem-
plates by manipulating views, graphs and traces.
Templates are not saved automatically, but must be saved using the File>Save 
Template option. Template files can be shared and customized. The list of tem-
plates is dynamically created and displayed in the tool bar. When a record is 
added to RecordGraph, an automatic scan search is done to list the templates 
corresponding to the record loaded. This list may have both single or multi-
record templates, if the record loaded is a part of multi-recorder template. If no 
match is found, a <Default> template is loaded. You can define any number of 
templates based on a single recorder or multiple recorders.

Default Templates Hard coded, static default templates are created whenever you open the Re-
cordGraph application. These are not stored in the file, but are dynamically 
created and displayed as <Default> in the list box.
You can override this <Default> template by saving any other template as a de-
fault template. 
The user-defined default template path is stored in the registry key based on the 
product and the type of recording (applicable for all products).
For example:
   •  TESLA/HS - high speed
   •  TESLA/LS - low speed
   •  TESLA/Trend - slow recordings
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Managing Template 
Files

Whenever a new record file is loaded into the RecordGraph, it automatically 
loads the relevant template file names in a list box attached to the main tool bar. 
The template files are filled or updated based on certain rules:
   •  Templates are stored based on product type.
   •  If a user-defined default template is available, it is loaded as the first item 

in the list box, otherwise, a static <Default> template is listed as the first 
item.

   •  Template files are matched based on IED (serial number) in the case of 
TESLA recorders and are common in case of relay products (B-PRO, F-
PRO, L-PRO, T-PRO.

If template files for a TESLA recorder are created and stored (for example, 
with serial number TESLA-2000-981103-07), these template files can not be 
applied to another recorder with different serial number such as TESLA-2000-
981103-08. On the other hand, if template files are created for relay products 
such as L-PRO, this template can be applied to any relay IED B-PRO, F-PRO, 
L-PRO or T-PRO). Hence, templates are IED-based (serial number-based) in 
case of recorders and product-based in case of relays.
Double-click (or use the Enter key) on the currently active record in the Re-
cordGraph tree list (displayed in bold) to apply the template or pick any desired 
template from the template list box. 
Templates can be renamed, duplicated or deleted using template manager from 
within the RecordGraph.
There is no limitation on the number of template files used (as long as the hard 
disk space is available).

Create New 
Template File

1   Modify the existing template layout information and save the modified tem-
plate into a new file.

2   Create new views and graphs by deleting the views from the existing layout 
and saving new ones into a new the template file.

If the template file is created from multiple records, all the records should be 
pre-loaded into RecordGraph to successfully apply the layout information.
Layout information is applied one at a time. If the template involves more than 
one record, apply template (double-click on each record) to fill respective 
channels. The name of the recorder IED in the template file are displayed in the 
tool-tip list box window when the mouse cursor is moved over it. The tool-tip 
also displays the product name and the user-defined default template file name, 
if one exists.
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Templates Menus Save Template 
Displays a dialog box only if <Default> template is currently displayed in the 
template list box. Since <Default> template name is reserved for hard coded 
templates, you must save the template information with a new name. If any 
other template file name is displayed, other than <Default>, the layout infor-
mation is updated without the dialog box being displayed.

Save Template As...
Displays a dialog box to save the template. The option Save as default tem-
plate, if checked, saves the template as user-defined default template. Refer 
previous section for more explanation on the user defined default template.

Template Manager...

Figure 10.84:  Template Manager

Brings up the template manager dialog box which lists all the templates cur-
rently available.

Rename
Renames the currently selected template. 

Duplicate
Copies the contents of the selected template into another file.

Delete
Deletes currently selected template.
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Template - Tool Tip 

Template tool tip information displays:
   •  IED name
   •  User-defined default template associated with that IED
   •  Serial number of the IED which is used as the unique feature to match the 

templates.

Template - Single 
IED

1   Open a record from the desired IED (B-PRO, F-PRO, L-PRO, T-PRO or 
TESLA).

2   Create or modify the existing layout information.
3   Use Save Template as... option to save the new layout information with a 

desired template name.

Template Tool Tip

A single IED template is saved/matched based on its serial number. 
Any record from the IED with the same serial number can use or 
share the template (layout) information.
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Template - Multiple 
IED

Figure 10.85:  Multiple IEDs

1   Open records from two or more desired IEDs (different TESLAs or different 
relays).

2   Create or modify the existing layout information (create graphs by selecting 
channels from different IEDs).

3   Use Save Template as... option to save the new layout information with a 
desired template name.

When all IED records are pre-loaded into the RecordGraph, multiple 
IED templates are saved/matched based on serial number. If the 
record is loaded one at a time, then double-clicking on each record 
reapplys the template filling the respective channels.
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View and Graph Titles
When a new record is loaded, the information corresponding to the options se-
lected is compiled and the updated information is displayed in the View Title. 

Figure 10.86:  View and Graph Titles

View Title View Title is the title on the top of each record view. When a new record is 
loaded, the information corresponding to the options selected is compiled and 
the updated information is displayed in the View Title. You can choose any of 
four options by clicking the arrows to move the items in the list. The option is 
saved into the template. This option is not available for the Symcom or Har-
monic Views. 
The option choices are:
   •  Record Name
   •  Station Name
   •  Location
   •  Trigger Time
   •  UnitID or Recorder
   •  Product Type
   •  Serial Number
   •  Trigger Event
   •  System Frequency
   •  Priority

View TitleGraphTitle
10-62 TESLA User Manual 2000 Release Date: 2008 February 08



10 Graphing Records
Figure 10.87:  View Title Options

Graph Title Graph Title is the information that appears on the left margin of each graph. 
Graph Title is a combination of various options. When a new record is loaded, 
the information corresponding to the options selected is compiled and the up-
dated information is displayed in the Graph Title dialog box. You can choose 
any four options by clicking the arrows to move the items in the list. The option 
is saved into the template. This option is not available for the Overlay View.
The option choices are:
   •  Channel name
   •  Trigger time
   •  Station name
   •  Record name
   •  Location
   •  UnitID or recorder
   •  Sample rate
   •  Equipment ID

Figure 10.88:  Graph Title Options
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Readouts and Measurements
The Measure menu consists of the following:
   •  Markers
   •  Primary/Secondary
   •  Time Alignment
   •  Absolute Time
   •  Fundamental RMS
   •  True RMS
   •  Harmonics
   •  Symmetrical Components

Figure 10.89:  Readouts and Measurements

Markers Selecting Measure>Markers or using the tool bar button places the “X” and 
“O” markers on the graph, as well as, automatically placing markers on all new 
graphs. If the markers are out of view range, double-click on the timeline graph 
to bring back the markers to the desired location. Marker positions are saved 
into the template. Readout corresponding to the option chosen is displayed on 
the right side of the graph. Selecting trigger marker, T, displays the trigger time 
of the record.

Primary Selecting Measure>Primary multiplies the channel data by the primary scal-
ing factor and redraws the y-axis for all graphs.

Secondary Selecting Measure>Secondary multiplies the channel data by the secondary 
scaling factor and redraws the y-axis of all graphs.

Fundamental RMS

Time Alignment

Absolute Time

True RMS

Trigger

Harmonics

Markers
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Time Alignment Use this option to offset or align the trigger time of channels (normally from 
different locations) or shift the x-axis time. This feature offsets the x-axis time 
data by a precise value as desired.
1   A trace (channel) must first exist on the graph. Click the graph that you want 

to show time alignment.
2   Select the Graph>Time Alignment menu option or the Time Alignment but-

ton on the tool bar.
3   Use the “spin” control (up and down arrows) to increase or decrease the off-

set.
4   Double-click the value to bring up a dialog box to enter the new offset value 

and offset scale. Offset scale is the percent by which the increment is re-
quired.

5   Clear this option, by a second click on the Time Alignment button on the tool 
bar or by selecting the Graph>Time Alignment menu option a second time.

Figure 10.90:  Time Alignment

Spin control to quickly
vary the offset value

Time alignment toolbar button

Edit box to change the offset value.
Note: Double-click here to change 
the offset value and the offset 
scale (increment)
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Absolute Time This option displays the absolute time—the actual time of the recorded chan-
nels.
1   A trace (channel) must first exist on the graph. Click the graph that you want 

to show absolute time measurement.
2   Select the Measure>Markers menu option or the Markers button on the tool 

bar to place the markers on the graph. Markers are automatically placed if 
not selected.

3   Select Measure>Absolute Time menu option.
4   Readout corresponding to the markers is displayed on the right-hand side of 

the graph including:
   •  Year, Month, Day of the recording (yyyy/mm/dd)
   •  Absolute Time corresponding to marker X
   •  Absolute Time corresponding to markers O
   •   Difference in the Absolute Time between marker X and marker O

Figure 10.91:  Absolute Time

Absolute Time
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Fundamental RMS This option displays the RMS measurement of the fundamental (60 or 50 Hz) 
between the two markers (X and O) of the selected channel.
1   A trace (channel) must first exist on the graph. Click the graph that you want 

to show absolute time measurement.
2   Select the Measure>Markers menu option or the Markers button on the tool 

bar to place the markers on the graph. Markers are automatically placed if 
not selected.

3   Select Measure>Fundamental RMS menu option.
4   Readout corresponding to the markers is displayed on the right-hand side of 

the graph including:
   •  RMS (fundamental frequency) Title
   •  Minimum RMS
   •  Maximum RMS
   •  Average RMS

Figure 10.92:  Fundamental RMS

Fundamental RMS
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True RMS This option displays true RMS measurement values of all the harmonics (up to 
25 order—including the fundamental), depending on the sample rate of the re-
corded channel. 
1   A trace (channel) must first exist on the graph. Click the graph that you want 

to show absolute time measurement.
2   Select the Measure>Markers menu option or the Markers button on the tool 

bar to place the markers on the graph. Markers are automatically placed if 
not selected.

3   Select Measure>True RMS menu option.
Readout corresponding to the markers is displayed on the right-hand side of the 
graph including:

   •  True RMS Title
   •  Minimum True RMS
   •  Maximum True RMS
   •  Average True RMS

Figure 10.93:  True RMS

True RMS
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Harmonics This option displays the harmonic contents (magnitude) of the desired channel 
along with the Total Harmonic Distortion (THD) in percentage. 
1   A trace (channel) must first exist on the graph. Click the graph that you want 

to show absolute time measurement.
2   Select the Measure>Markers menu option or the Markers button on the tool 

bar to place the markers on the graph. Markers are automatically placed if 
not selected.

3   Select Measure>Harmonics menu option.
4   Readout corresponding to the markers is displayed on the right-hand side of 

the graph including:
   •  Harmonics Title
   •  2nd Harmonic
   •  3rd Harmonic
   •  4th Harmonic
   •  5th Harmonic
   •  THD% of fundamental (up to 25 harmonics) depending on the sample 

rate.

Figure 10.94:  Harmonics

Harmonics
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Symmetrical 
Components

This measurement option displays the magnitudes of the positive, negative and 
zero sequence components of 3-phase voltage or current channel. 
1   Create an Overlay View— you must have a 3-phase voltage or current chan-

nel.
2   Place three phase voltage or current channels on the graph.
3   Select the Measure>Markers menu option or the Markers button on the tool 

bar to place the markers on the graph. Markers are automatically placed if 
not selected.

4   Readout corresponding to the markers is displayed on the right-hand side of 
the graph including:

   •  SymCom Title
   •  Positive sequence component magnitude
   •  Negative sequence magnitude
   •  Zero sequence magnitude

Figure 10.95:  Symmetrical Components

Symmetrical Components
10-70 TESLA User Manual 2000 Release Date: 2008 February 08



10 Graphing Records
Calculated Channels
Calculated channels are virtual channels derived from the original recorded 
channels. They are calculated based on the configuration information. In the 
TESLA recorder, all the calculated channels are added to the original record 
only once, but are available any time for the view with the RecordGraph appli-
cation. Calculated channels differ widely depending on the product. They are 
classified under high and low speed categories. 

High Speed Calculated channels
   •  Summation
   •  Positive sequence
   •  Negative sequence
   •  Zero sequence
   •  Watts (single and three phase)

Low Speed Calculated channels
   •  Summation
   •  Positive sequence
   •  Watts (single or three phase)
   •  Vars (single or three phase)
   •  Impedance
   •  External
Type and number of channels available for the view depends on the configura-
tion information. 
Choose Options>Calculate Derived Channels Now to add the calculated chan-
nels. If this option is disabled, then the calculated channels are already avail-
able.

Figure 10.96:  Calculated Channels

Calculated Channels
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Exporting Views
Export active visible views to windows standard clipboard or to an enhanced 
metafile. Following options are available:
   •  Copy To ClipBoard
   •  Save As MetaFile

Figure 10.97:  Export Views

Copy to Clipboard Copies view to the clipboard in order to copy into another document, for ex-
ample Microsoft Word.
1   To copy to clipboard select View>Copy to Clipboard or right-click on the 

graph to bring up the context menu and select Copy to Clipboard.
2   Open any other software package, which supports the “pasting” facility 

from the clipboard (for example Excel or Microsoft Word) and paste the 
view.

Save View as 
Metafile

Saves the view to a Metafile format *.emf.
1   To save to as a Metafile select View>Save to Metafile... or right-click on the 

graph to bring up the context menu and select Save to Metafile. 
2   A dialog box appears prompting you to save the file in a selected folder.

Figure 10.98:  Save to Metafile

Copy to Clipboard

Save to Metafile
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Exporting Channel Data
Any channel data can be exported to the clipboard from the active view. If a 
graph has multiple channels, all the channel data is exported to the clipboard.
This option copies the trace data to the clipboard and using Edit>Paste to paste 
into other applications like Microsoft Word or Excel.

Figure 10.99:  Copy Trace to Clipboard

Pasting exported data using Microsoft Excel
1   Open Microsoft Excel.
2   Choose Edit>Paste Special.

Figure 10.100:  Paste Special using Excel

Copy Trace Data to Clipboard
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Pasting exported data using Microsoft Excel
Choose csv (comma separated variable) format and click OK.

Figure 10.101:  Choose csv

Pasting exported data using Microsoft Excel
Domain: normally time data, it can be date YYYY/mm/dd in case of trend data.

Figure 10.102:  Past to Excel
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Record Summary
1   Click the record name to enable this feature.
2   Choose File>Show Record Summary… to display the record summary.

Figure 10.103:  Show Record Summary

Digital Channel Status Indicator
Highlight digital channel which change state (with different icons), and list 
only configured channels in the tree view. A mimic screen shot of the icons is 
shown below. The <default> template automatically displays the digital chan-
nels which changes the state.

Figure 10.104:  Digital Channel Status Indicator

Icon with changes
in the digital status

Icon with no changes
in the digital status
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10 Graphing Records
 IRIG-B Input Status Display
IRIG-B input status (synchronized, unsynchronized or unknown) is displayed 
in the tool tip window when you place the mouse on the channel name or use 
Active Trace Information.

Figure 10.105:  IRIG-B Input Status Indicator

Derived Digital Swing Channels for TESLA Swing Recordings
TESLA recordings do not record External Input channels for the swing 
records. A facility to view these channels in the RecordGraph is provided. Re-
cordGraph automatically displays these channels (if configured) under low 
speed channel group. Events with the same element are grouped together to 
form a channel. This facility is backward compatible.

Derived Channels for L-PRO, F-PRO High Speed Recordings
For L-PRO and F-PRO high-speed records, Main and Aux individual phase 
summation channels are added to the existing derived summation channels. 
This facility is backward compatible.

IRIG-B status indicator
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COMTRADE Import
COMTRADE (Common Format for Transient Data Exchange) is an industry 
standard record format used to share data between tools and to replay faults 
through a test set. The import utility supports viewing of both ASCII and bina-
ry COMTRADE formats (1991 and 1999). When the COMTRADE file is im-
ported into the RecordGraph, all its functionality can be seamlessly used to 
analyze the record.
1   RecordGraph application must be running to access this facility. If not, 

launch RecordGraph via TESLA Control Panel, RecordBase View or Win-
dows Explorer.

2   Choose File>Import.
3   Browse to select desired file.
4   Double-click on the COMTRADE record to apply <Default> template or 

select it from the templates list box.

Figure 10.106:  Import COMTRADE File

Import file
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Figure 10.107:  Select COMTRADE File

Figure 10.108:  Apply <Default> Template

Choose COMTRADE File
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Print Options
The following options are available:
   •  Print... – pops-up a print option dialog box to select paper size, orientation 

and other options.
   •  PrintDirect – sends active view directly to the default printer.
   •  PrintAll – sends all the views directly to the default printer.
   •  Print Preview…– displays standard preview window.
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11 Record Export Utility

The record export utility lets you convert records into a number of different 
formats for use with other software tools.

COMTRADE
Common Format for Transient Data Exchange is an industry standard record 
format used to share data between tools and to replay faults through a test set. 
The export utility supports both ASCII and binary COMTRADE formats and 
creates output that complies with the latest (1999) or older version (1991) of 
the standard.

PTI
Power Technologies Incorporated produces widely used power system model-
ling tools. TESLA records can be exported in a PTI-compliant format for im-
port into PTI tools. The export utility supports ASCII format and creates output 
that complies with PTI version 1 or version 2 formats.

Excel (CSV)
TESLA records can be exported in basic comma separated values (also known 
as comma-delimited) ASCII format suitable for importing into standard tools 
such as Microsoft Excel.
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Launch the Export 
Utility

To launch the export utility:
1   Double-click Records from the Main Menu.
2   Select a local record from the record list.
3   Select the Export button to launch the Export window.
4   Select the desired export output format and select OK.

Figure 11.1:  Select Export File Type

Step 2: Select a record 

from the list.

Step 3: Click on the

Export button to 

launch export window.
Step 4: Choose export

type and OK.

Step 1: Double-click 

Records from the 

Main Menu
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11 Record Export Utility
COMTRADE Format

Figure 11.2:  COMTRADE Settings

The COMTRADE format (IEEE C37.111) defines a common format for stor-
ing digital data records of transient and dynamic swing events.
COMTRADE export consists of up to four output files with the same base 
name and different file extensions: configuration files (.cfg), header files 
(.hdr), data files (.dat) and optional information files (.inf). COM-TRADE ex-
port produces the configuration, header and data files.
With reference to Figure 11.2: COMTRADE Settings,

Name Function

Export to.. The base filename and directory of the output files are set using 
the Export to. option. 
By default the base filename is the same as the record you are 
exporting. 
You can edit this or use the Browse button to set a new direc-
tory and/or base filename.

Station Name and 
Identification 

The Station Name and Identification fields are set by default 
using the unit’s Station which are written as the first line in 
the.cfg output file. 

Header Text The Header Text field contains the text written into the COM-
TRADE header (.hdr) file. By default, the field contains the 
Location, Name, Number and the Unit ID of the unit that pro-
duced the record. 
This text can be modified, deleted or extended as desired.

Version The Version field lets you select the revision of COMTRADE 
standard to produce. COMTRADE has been an evolving stand-
ard and a number of changes have been made over the years. 
1991 and 1999 COMTRADE versions are supported.
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Format The Format field specifies that the data in the COMTRADE file 
(ASCII or BINARY format).
ASCII data has the advantage of being usable by simple text 
editor and spreadsheet programs, but results in a significantly 
larger record relative to binary format. 
BINARY format is therefore recommended if the software pack-
age you will be using the data in supports binary format COM-
TRADE.

Selecting Channels 
(Exported Channels)

You must select the channels from the record that you want to 
include in the output file. 
For convenience, the digital data recorded is classified into:
• High Speed (5760/sec): Analog and external digital input 

channels sampled at the high speed transient data rate.
• High Speed (480/sec): Analog and internal logic channels pro-

duced 8 times per cycle.
• Low Speed (60/sec): Analog input channels sampled at the 

low speed swing data rate.
Select the desired channel from the list with a left-click. 
Multiple channels can be selected using standard Windows 
selection actions (click + Ctrl or Shift keys).

 Place selected channels in the Exported Channels list box. 

Place all channels into the Exported Channels list box. 

Delete a channel from the Exported Channel list box.

Delete all channels from the Exported Channel list box.

 Offset negative start 
times to begin at zero

When checked, this option shifts the negative time to start from 
zero.

Name Function

>

>>

<

<<
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11 Record Export Utility
 PTI Format 

Figure 11.3:  PTI Settings

The PTI file format is used to import records into the Power Technologies In-
corporated system modelling software.
Output File PTI export produces a single output file with an .asc extension.

Name Title

Export to.. The base filename and directory of the output files are set using 
the Export to.. option. 
By default the base filename is the same as the record you are 
exporting. 
You can edit this or use the Browse button to set a new directory 
and/or base filename.

Station Name and Identifi-
cation

The Station Name field is set by default using the unit’s Station 
Name setting. It is written as the third line in the output file.
If desired, you can edit this text. 
The Identification field is not written to the PTI output file.

Header Text The Header Text field contains the text that is written as a single 
line in the fourth line in the output file. 
By default, the field contains the Location, Name, Number and 
Unit ID of the recorder that produced the record. 
This text can be modified, deleted or extended as desired.

Version The Version field lets you select between PTI version 1 and ver-
sion 2. Please refer to PTI documentation for details on the dif-
ferences of these versions. 
Format Only ASCII format output files are available.

Format ASCII is the only format option for PTI.
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Channel Selection Use Channel Selection to select channels to export. 
You must select the channels from the record that you want to 
include in the output file. 
For convenience, the digital data recorded is classified into:
• High Speed (5760/sec): Analog and external digital input chan-

nels sampled at the high speed transient data rate.
• High Speed (480/sec): Analog and internal logic channels pro-

duced 8 times per cycle.
• Low Speed (60/sec): Analog input channels sampled at the 

low speed swing data rate.
Select the desired channel from the list with a left-click.
Multiple channels can be selected using standard Windows 
selection actions (click + Ctrl or Shift keys).

 Place selected channels in the Exported Channels list box. 

Place all channels into the Exported Channels list box. 

Delete a channel from the Exported Channel list box.

Delete all channels from the Exported Channel list box.

 Offset negative start 
times to begin at zero

When checked, this option shifts the negative time to start from 
zero.

Name Title

>

>>

<

<<
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Excel (CSV) Format

Figure 11.4:  Excel (CSV) Settings

The Excel CSV (Comma Separated Value) format is used to import records 
into a Microsoft Excel spreadsheet. This format is also known as comma de-
limited ASCII and can generally be used by most programs that import data ar-
rays.
Excel CSV export produces a single output file with a .csv extension, which is 
recognized by Excel. Excel is automatically launched when you double-click 
on file. 

Name Function

Export to.. The base filename and directory of the output files are set using 
the Export to.. option. 
By default the base filename is the same as the record you are 
exporting. 
You can edit this or use the Browse button to set a new direc-
tory and/or base filename.

Station Name and Unit ID The Station Name and Identification fields are not written to the 
Excel CSV format output file. 

Header Text There is no header text written to the Excel CSV format output 
file.

Version There are no version options for the Excel CSV output.

Format ASCII is the only format options for the Excel CSV output.
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Channel Selection You must select the channels from the record that you want to 
include in the output file. 
For convenience, the digital data recorded is classified into:
• High Speed (5760/sec): Analog and external digital input 

channels sampled at the high speed transient data rate.
• High Speed (480/sec): Analog and internal logic channels pro-

duced 8 times per cycle.
• Low Speed (60/sec): Analog input channels sampled at the 

low speed swing data rate.
Select the desired channel from the list with a left-click. Multiple 
channels can be selected using standard Windows selection 
actions (click + Ctrl or Shift keys).

 Place selected channels in the Exported Channels list box. 

Place all channels into the Exported Channels list box. 

Delete a channel from the Exported Channel list box.

Delete all channels from the Exported Channel list box.

 Offset negative start 
times to begin at zero

When checked, this option shifts the negative time to start from 
zero.

Name Function

>

>>

<

<<
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12 The Event Log

Event Log
The event log services are available from the Events tab, accessible from the 
Main Menu.

Figure 12.1:  Event Log Display

The recorder maintains a log of time-stamped events. Event messages can be 
produced by any of the recorder’s detectors if configured to do so.

Circular Storage The Event Log stores up to 250 events with automatic overwrite of the oldest 
event. The trending module, accessed through the “logging” tab, preserves 
events, up to 1000 events can be saved in the daily event log.

Event Messages The text of an event message is derived from the configuration of the detector 
that generates it.
The general format for event message is:
date time ElementName.Type.Description Detector State
where:
   •  ElementName is the user-assigned name of the element associated with this 

input
   •  ChannelType describes the member of the element or the type of channel 

which the detector is monitoring
   •  Description is user-assigned text available to further identify the detector
   •  Detector is the type of detector

A copy of all Event messages that correspond to the time frame of a 
given record is also stored in each record and displayed as part of the 
record summary
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12 The Event Log
   •  State indicates whether the detector is picking up or dropping out. In the 
case of external inputs this text is user-assigned to accommodate different 
external devices.

Example of an Event message from an External Input detector 
e.g. 2000 Jan 19 00:57:16.000 Line245.EI.BkrA detector pickup
Example of an Event message from a high analog level detector: 
e.g. 2000 Jan 19 00:57:16.000 Line245.Va. High Mag active

Printing Event Log You may print or copy to clipboard all the events that are in the Event Log. 
Right-click or choose from the menu bar to print Event logs while logged on 
to remote IED (recorder).

Controls The event display is a static snapshot of the contents of the log.
You can use the buttons at the bottom or a right-click to access these functions. 
In addition, print commands are available under the File menu, a copy com-
mand is available under the Edit menu, and a refresh command is available un-
der the View menu.

Copy Copies the event list to clipboard for pasting to other programs,

Refresh Updates Event List by getting a new list from remote IED and updates 
the Event List screen.

Erase Removes all events from remote IED.

Print (bottom button only) Prints all the events (up to 250 events) to a local 
printer.
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13 Error Handling and Maintenance

The recorder has hardware and software self-check and error detection capa-
bilities that work to keep it running and to provide a clear indication if a failure 
occurs. 

Status Indicators
Recorder Functional 
LED

Normally active green LED on the front panel is turned on by the self-checking 
hardware with approximately 35 seconds after power up. If a firm failure has 
been detected, it turns off. The LED state corresponds directly with the rear-
panel failure contact (see below).

Test Mode LED Normally inactive red LED on the front panel turns on immediately on power 
up and remains on until the self-test has been completed (approximately 45 to 
60 seconds). It may blink briefly during the self-test process.

Alarm LED Activation of this red LED indicates a failure has been detected by the soft-
ware. The presence of the Alarm LED means much of the system is functioning 
and can be accessed for diagnosis, described below.

Failure Contact Output Contact #1 on the rear panel. Driven by the sanity hardware, this con-
tact provides a hardware-based failure indication that corresponds with the Re-
corder Functional LED.
For units with serial numbers before 990318-xx, failure is indicated by an open 
contact.
For units with serial numbers after 991110-xx, failure is indicated by a closed 
contact.

Trend Alarm Contact If configured, one of contacts 2, 3, 5, 6, or 7. The contact closes when the num-
ber of days of accumulated trend data exceeds a user-selectable threshold (see 
“Recording Settings” on page 5-5). When sufficient data is deleted so that the 
number of days of accumulated trend data is below the threshold, the contact 
opens.

Recording Alarm 
Contact

If configured, one of contacts 2, 3, 5, 6, or 7. The contact closes when the num-
ber of recordings exceeds a user-selectable percentage of the total allowable 
(see “Recording Settings” on page 5-5). When sufficient records are deleted so 
that this value is below the threshold, the contact opens.
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13 Error Handling and Maintenance
TESLA States

Startup Sequence
On power up, the unit goes through the following startup sequence:
1   Startup State The Test Mode LED turns on immediately. The microproces-

sors perform initial self-check and program loading.
2   Verification State Approximately 35 seconds after power-up, the supervi-

sory software is in control of the system. It activates the front panel LEDs 
and conducts further self-checks.

   •  The Recorder Functional LED turns on.
   •  The Recorder Fail contact opens (Output Contact #1 on the rear panel). 
   •  The Test Mode LED may blink once.
   •  If the unit has any records on its hard disk, the Records Stored LED turns 

on.
3   Normal State Approximately 10 seconds later, if the supervisory software 

determines that the system is functioning correctly, it turns off the Test 
Mode LED.

State Description Front Panel LEDs Failure Contact

Startup Initial power-up. Low-level self-test 
and program load

Recorder Functional
Test Mode
Alarm

Off
On
Off

Active

Verification System self-test Recorder Functional
Test Mode
Alarm

On
On
Off

Active

Normal Normal operation Recorder Functional
Test Mode
Alarm

On
Off
Off

Inactive

Reset Hardware reset (induced by 
watchdog hardware or supervisor 
software)

Recorder Functional
Test Mode
Alarm

On
On
Off

Inactive (unless error 
occurred on unit startup)

Detected 
Error

Hard fault detected by software. Recorder Functional
Test Mode
Alarm

Off
Off
On

Active

Watchdog Hard fault detected by watchdog 
(supervisor software not running)

Recorder Functional
Test Mode
Alarm

Off
On 
Off

Active
13-2 TESLA User Manual 2000 Release Date: 2008 February 08



13 Error Handling and Maintenance
Error Handling
Supervisory software continually checks all system processes. If a failure is de-
tected an attempt is made to correct the problem through a software restart. A 
software restart takes place quickly and does not activate any of the external 
indicators.

Figure 13.1:  Error Handling

If the failure persists, an attempt is made to correct the problem through a full 
hardware reset. External indicators are those described above for the Reset 
state. If the problem is not cleared by repeated resets, the unit enters the De-
tected Error state as described above.
If a fundamental hardware failure occurs that prevents the unit supervisory 
software itself from running, the self-checking hardware will initiate a reset. 
After four consecutive resets, the sanity hardware will assert the Recorder Fail-
ure contact and enter the Watchdog state as described above.

Normal 

Operation

Software 

Restart

Hardware 

Reset

Detected 

Error Mode

First Detected Error

Problem Cleared

Problem Still Present
Problem Persists After

 Repeated Reset Attempts

Problem Cleared

Problem Cleared
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13 Error Handling and Maintenance
Failure Modes

Maintenance Menu
The TESLA has a set of utilities that provide diagnostic, recovery and TCP/IP 
services. These utilities are available through a Maintenance Menu accessed 
with a VT-100 terminal connection to the recorder's serial ports, modem or 
Ethernet LAN. For security purposes, any utilities that can modify the TESLA 
are disabled when connecting remotely. To access these utilities you must con-
nect to the recorder using the front panel serial port.
Any terminal program that fully supports VT-100 emulation and provides z-
modem file transfer services can be used. HyperTerminal, which is included 
with Microsoft Windows, is used here as an example.
1   Determine how you want to connect to the recorder. 

   •  A direct serial link connects your computer’s serial port to the recorder’s 
front panel Port 1. Port 1 is set up so that a standard, straight-through, 
male-to-female serial cable can be used.

   •  If both the recorder and your computer have modems, you can access 
the Maintenance Menu through the telephone system.

   •  If both the recorder and your computer are on the same LAN or WAN, 
you can access the Maintenance Menu through your network.

2   Configure your terminal program as described in the table below. 
   •  For a direct serial link, the baud rate must be same as that of the record-

er’s serial port. The default baud rate for Port 1 is 38,400. The baud rate 
can be viewed and changed in the Utilities>Communication tab of 
TESLA Control Panel. 

Failure Indication Action

No active front panel LEDS on 
power up

Check power external connection. 
For dc supply sources, check polarity. 
Is the voltage level correct?
Open front panel. Check for loose cables

Test Mode LED stays on for 
more than 5 minutes on startup

Open front panel. 
Check that sanity disable jumpers have not been inadvert-
ently left on the MPB. 
Remove if present and allow unit to cycle through reset. 
(Temporary installation of these jumpers is done as part of 
the firmware update process).
Attempt to log in to the diagnostics menu (see below).
If login is possible, the System Diagnostics log could be 
viewed (or sent to ERLPhase Customer Support) to help 
pinpoint the problem.

Alarm LED active Wait 2 minutes.
If the system fault can be cleared without intervention, the 
system will automatically revert to the Normal state.
If the condition persists, the System Diagnostics log could 
be viewed (or sent to ERLPhase Customer Support) to 
help pinpoint the problem. 
See Diagnostic Tools, below.
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13 Error Handling and Maintenance
   •  For a modem link, the baud rate and other communication parameters 
only determine how your computer talks to your modem. Usually, the 
fastest possible baud rate is chosen to maximize your modem's com-
pression capabilities. 

   •  For a network link, only the Emulation and Font settings from the table 
are relevant. 

3   Select the device on your PC you will communicate through. In HyperTer-
minal, this is done in the Connect Using field of its Properties control. 
   •  For a direct serial link, select an available serial port
   •  For a modem link, select the appropriate modem
   •  For a network link, select “TCP/IP (Winsock)” (available with Hyper-

Terminal v1.2 or greater) 
4    Initiate the connection. The TESLA will respond with a login prompt

   •  In HyperTerminal, use the Call button or menu command to initiate the 
connection.

5   At the login prompt, log in as “maintenance”
   •  Lower case
   •  No password is required. If you are asked for one, there is a mistake in 

the login name. Press Enter to get another Login prompt and try again.

Terminal Program Setup

Baud rate For a direct serial link, the baud rate must match that of the recorder 
serial port. Port 1 default baud rate is 38,400.
For a modem link, the baud rate refers only to the link between your 
computer and its own modem. 

Data bits 8

Parity None

Stop bits 1

Flow control Hardware or Software. 
Hardware flow control is recommended. The recorder automatically 
supports both on all its serial ports.

Function, arrow 
and control keys Terminal keys

Emulation VT100

Font A font that supports line drawing (e.g. Terminal or MS Line Draw).
If the menu appears outlined in odd characters, the font you have 
selected is not supporting line drawing characters.
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13 Error Handling and Maintenance
The Maintenance Menu appears as below.

Figure 13.2:  Maintenance Menu

Modify IP Address, subnet 
mask and default gateway

When equipped with an optional Internal 10Base-T Ethernet 
card, this utility can modify the LAN IP address, default sub-
net mask and default gateway.

View system diagnostic Displays the TESLA’s internal status log.

Retrieve system diagnostics Automatically packages up the internal status log plus 
setting and setup information and downloads it in 
compressed form to your computer. This file can then be 
sent to ERLPhase customer support to help diagnose a 
problem.

Restore settings If you suspect a problem due to the unit’s settings, calibra-
tion and/or setup parameters, you can use the menu to force 
the system back to default values.

Force hardware reset Manually initiates a hardware reset. Note that the communi-
cation link is immediately lost and cannot be re-established 
until the unit completes its start-up.

View network statistics View IP, TCP and UDP statistics when equipped with inter-
nal 10BaseT Ethernet card.

Monitor SCADA Shows real time display of SCADA data.

Enable/Disable internal 
modem

Enables or disables the optional internal modem.

Save Recent Trend Data Saves any accumulated Trend Data that hasn’t yet been 
saved to disk. This should be executed prior to [7] Force 
Hardware Reset.

Exit
13-6 TESLA User Manual 2000 Release Date: 2008 February 08



Appendix A   Specifications
TESLA Recorder (model 2000)

Item Quantity/Specs Note

General:

Nominal Frequency 50 or 60 Hz

Power Supply Nominal Range: 48–250 Vdc, 120 Vac Full Operat-
ing Range: 40–300 Vdc

Other ranges available

Input Types The unit accepts ac or dc low voltage analog signals 
on its rear terminals. These inputs are non-isolated 
and require external isolation in the form of CTs, PTs 
or dc isolation circuits.
The following DIN rail mounted modules are availa-
ble to provide connection input signals:
   •  PT module: AC voltage input, 69 V or 115 V nom-

inal, linear to 138 V.
   •  CT module: AC current input, 1 A or 5 A nominal, 

linear to 20 x nominal. No damage to 20 A contin-
uous, 100 A for 1 second/hour

   •  DC Module: DC or AC voltage or current input, 
100 mV to 1 kV full scale or 1 mA to 100 mA full 
scale nominal. Range is set by resistors mounted 
on outside of module.

Measurement Accuracy Sampling Resolution: 12 bits plus sign
Amplitude Measurement Accuracy: ± 0.1% of full 
scale
Phase Measurement Accuracy: ± 1 degree
Frequency Measurement Accuracy: ± 0.01 Hz @ 60 
Hz

Response Transient Response: Rise time <400  second (10 to 
90%) with <5% overshoot
AC Amplitude Response: ± 2 dB from 10 to 1550 Hz
AC Phase Response: ± 1 degree from 10 to 2880 Hz
DC Amplitude Response: ± 2 dB from 0 to 1000 Hz

Noise Signal to Noise ratio: 66 dB at full scale
Common mode rejection: 66 dB at full scale
Crosstalk: -66 dB

Burden AC Input Module - Voltage: < 0.15 VA @ 69 V
AC Input Module - Current: < 0.25 VA @ 5 A
DC Input Module: Dependent on configuration (see 
“DC Input Module” in Appendix L)

Analog Input Sampling Fixed at 96 samples/cycle
Global to all analog input channels
All input channels sampled within 45 microseconds 
of each other (within 1 degree @ 60 Hz)

Recording:

Recording Rate: 
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Appendix A Specifications
Transient Fault 96 samples/cycle Up to 10 seconds per record

Dynamic Swing 1 sample/cycle Up to 3 minutes per record

Analog Input Accuracy +/- 0.1% of FS amplitude
+/- 1.0 degree phase

Record Storage Up to 1000 fault, swing or combined records 2 Gigabyte hard disk standard
Larger capacity or flash disk options

A/D Resolution 13 bits, 8192 counts full scale

Channels and Triggers:

Analog Inputs High and low threshold, positive and negative rate of 
change, harmonic level, THD level, sags, swells

All triggers have independent controls for 
delay, logging, transient or swing record 
initiation, alarm contact activation and 
cross triggering. Assigned a priority.

Summations High/low threshold, +/- rate of change 2 or 3 input channel

Positive Sequence High/low threshold, +/- rate of change

Negative Sequence High level

Zero Sequence High level

Watts/VARs High/low threshold, +/- rate of change

Frequency High/low threshold, +/- rate of change

Impedance Positive sequence circle

External Inputs (digital) Rising edge, falling edge or both

Logic Rising edge, falling edge or both

Fault Locator Triggered by internal or external events

Chatter Detection The chatter detection applicable to other detectors 
applies also to sags and swells.  Chatter detection 
reduces the number of event messages in a situa-
tion where there is substantial possibility of rapid re-
triggering.

Sags and Swells Sag and swell detection can be enabled on any ana-
log input channel configured as a voltage.

Thresholds The minimum sag level is configurable from 90% to 
50% of nominal. The maximum sag level is fixed at 
10% of nominal.  To be reported, the measured volt-
age must start and end above the minimum sag 
level.  As well, all measurements in between must be 
above the maximum threshold (10%).

The minimum swell level is configurable from 110% 
to 150% of nominal. The maximum swell level is 
fixed at 180% of nominal. To be reported, the meas-
ured voltage must start and end below the swell min-
imum level.  As well, all measurements in between 
must be below the maximum threshold (180%).

TESLA Recorder (model 2000)

Item Quantity/Specs Note
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Appendix A Specifications
Duration Sags or swells with duration—0.5 cycle and 1 minute 
are reported. This range is not configurable.

Message Data The minimum voltage (in the case of sags) or the 
maximum voltage (swells) during the episode is be 
reported.

Input & Output:

Analog Input Channels 36 or 18 Rating: In = 5 A or 1 A, Vn = 69 V
Continuous: 3x In, 2x Vn
One Second: 20x In without distortion

External Inputs (digital) 64 or 32 40 - 150 Vdc, externally wetted

Alarm Output Relays (con-
tacts)

8 or 4 Make: 8 A
Carry: 8 A
Break: 0.15 A at 125 Vdc
0.10 A at 250 Vdc

Interface & Communication:

Front Panel Indicators 6 LEDs Recorder Functional, IRIG-B Functional, 
Recorder Triggered, Records Stored, Test 
Mode, Alarm

Serial User Interface Port 1 and 2 RS-232 ports to 115 K baud Port 2 can support an external modem

Internal Modem 33.6 Kbps, V.32 bis Optional on TESLA 2000

Network 10BaseT Ethernet port Optional on TESLA 2000

SCADA Interface DNP3 (RS-232 or Ethernet) or Modbus (RS-232) Rear port

Configurable Alarms 5 contacts Normally open

Cross-trigger 2 contacts Normally open

Self Checking/Recorder 
Inoperative

1 contact Normally closed

Time Sync IRIG-B, BNC connector Modulated or unmodulated

Environmental:

Ambient Temperature 
Range

0°C–55°C IEC 60068-2-1/IEC 60068-2-2

Humidity Up to 95% without condensation IEC 60068-2-30

Insulation Test (Hi-Pot) Power supply, analog inputs (through external isola-
tion modules), external inputs, output contacts -1.5 
kV, 50/60 Hz, 1 minute.

IEC 60255-5

Electrical Fast Transient ANSI/IEEE C37.90.1-1989

Oscillatory Transient ANSI/IEEE C37.90.1-1989

RFI Withstand ANSI/IEEE C37.90.2, IEC 255-22-3

Shock and Bump IEC 60255-21-2 Class 1

TESLA Recorder (model 2000)

Item Quantity/Specs Note
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Physical:

Weight 12 kg 26.5 lbs

Dimension 3U high (5.25"), 19" wide, 12" deep Rack mount

Input Modules 4 input current or 3 input voltage modules available DIN rail mount, up to 100' away from 
recorder chassis. Clamp-on CT available. 
Contact ERLPhase for details.

Modularity Two standard channel set options are available:
   •  18 analog inputs, 32 digital inputs and 4 output 

contacts
   •  36 analog inputs, 64 digital inputs and 8 output 

contacts

Analog inputs utilize external isolation and 
signal translation circuits as required (e.g. 
DIN rail mounted CT or PT).

Terminal Direct-wire terminal strips with tightening screws on 
the input module. External CT and PT transformers 
have screw-down terminal that accept ring or fork 
crimps.

Front Panel Indicators 6 LEDs: Recorder Functional, IRIG-B Functional, 
Recorder Triggered, Records Stored, Test Mode, 
Alarm

Communications 
Hardware

Port 1, RS-232 serial port to 115 K baud (front panel)
Port 2, RS-232 serial port to 115 K baud (rear of unit) 
- unavailable with optional internal modem
Port 3, RS-232 serial port for SCADA (rear of unit) - 
33.6 kbd

Optional Internal modem 33.6 Kbps, V.32 bis
10BaseT Ethernet port

External Inputs

Number 32 or 64 channels

External Input Thresholds Standard (covers 48 and 125 V systems):
Will turn on: >=38.4 V
Will not turn on: <=17.0 V
Maximum input: <160 V
High range (covers 125 and 250 V systems)
Will turn on: >=110.0 V
Will not turn on: +30.0 V
Maximum input: <295 V

Will turn on: >=38 V
Will not turn on: <=25 V
Maximum input: <300 V

For recorders with serial number TESLA-
2000-021010-01 or later the external input 
boards have an operational voltage range 
from 48 Vdc to 250 Vdc. The external 
inputs activate at approximately 32 Vdc.

Burden Burden Resistance: >10 kilo-ohm

Sample Rate Same as selected for the analog input channels 
(synchronized)

Terminals Direct-wire terminal strips with tightening screw

Output Contacts

TESLA Recorder (model 2000)

Item Quantity/Specs Note
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Number 4 or 8

Function 1: Recorder Failure - normally closed
2: User-definable - Pick-up <1.0 s, latch 1.0 s
3: User-definable - Pick-up <1.0 s, latch 1.0 s
4: Channel Group 1 cross trigger output - Pick-up 
<10 ms, latch 100 ms
The following additional contacts are available on 
the 36 channel version only:
5: User definable - Pick-up <1.0 s, latch 1.0 s
6: User definable - Pick-up <1.0 s, latch 1.0 s
7: User definable - Pick-up <1.0 s, latch 1.0 s
8: Channel Group 2 cross trigger output - Pick-up 
<10 ms, latch 100 ms

Dry Contact Rating 5 A @ 150 Vdc make and continuous
300 mA @ 150 Vdc break

Carry: 8 A
Make: 8 A
Break: 0.15 A at 125 Vdc
           0.10 A at 250 Vdc

Terminals Direct-wire terminal strips with tightening screws

Record Length

Transient Record Length normal 0.2 to 5 seconds
auto extend to 10 seconds

Swing Record Length normal 10 to 120 seconds
auto extend 180 seconds

Total Records Stored 1000 records

Event Log Record 250 events 

Time Synchronization and Accuracy

External Time Source The recorder can be synchronized using modulated 
or unmodulated IRIG-B. IEEE 1344 is supported.

Free Running Accuracy In the absence of an external time source, the 
recorder maintains time with a maximum 1 part per 
million drift.
The recorder can detect loss or re-establishment of 
external time source and switch between internal 
and external time.

Synchronization Accuracy Sampling clocks synchronized with the time source 
(internal or external)
All time stamping accurate to 45 microseconds 
(equivalent to 1 degree @ 60 Hz)

Trends

Available trend channels Any of the recorder’s existing configured analog 
channels (input or calculated) can be trended.  Eval-
uated phasor magnitude and angle quantities will be 
recorded as separate channels.

TESLA Recorder (model 2000)

Item Quantity/Specs Note
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Accumulation mode Each channel can be configured to accumulate data 
in one or more of the following modes. 

Accumulation Mode Description

Minimum Smallest reading seen over the interval

Maximum Largest reading seen over the interval

Average Average of all readings seen over the inter-
val

Damped Single zero low pass filter, with a time con-
stant preset to one-half the user-selected 
Sample Interval.

Undamped Last reading in the interval

Data is accumulated at a rate of 100 (50 Hz sys-
tems) or 120 (60 Hz systems) samples/second and 
is produced and stored at the selected trend sample 
interval. 

Sample Interval User selectable sample interval from 10 seconds to 
1 hour in 1 second increments. All channels produce 
trend data simultaneously at the selected rate.

Maximum number of 
channels

Up to 60 channels can be trended simultaneously. A 
channel with multiple accumulation modes is treated 
as multiple channels (e.g. the trending of minimum, 
maximum and average readings of a selected input 
would require 3 trend channels). 

Trend storage on the 
recorder

The recorder can store 90 days of data from each 
trend channel, regardless of the sample rate or the 
number of configured trend channels. This is a non-
configurable parameter. 

Accumulation mode Accumulation of trend data can be configured to 
either stop or recycle when the trend log is full. In 
recycle mode, the oldest data is overwritten.

Trend “full” indicator An alarm contact can be activated when the oldest 
data in the trend log reaches a specified age. The 
alarm level is configurable from 10 to 90 days in daily 
steps. Once activated, the alarm will remain on until 
the user removes the data (via TESLA Control 
Panel) or the configured alarm level is increased. 

Scaling Data is always stored in primary quantities

Change of configuration The configuration of the recorder can be changed 
without loss of previously accumulated trend data. If 
the new configuration stops the trending of a chan-
nel, previously accumulated data for that channel 
remains available until it reaches the 90- day storage 
limit or until it is removed by the user.

Event Storage The storage capacity for Trend events is set at a 
maximum of 1000 events/day and is retained for the 
same period as Trend data.

TESLA Recorder (model 2000)
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TESLA Portable Recorder (model 2000/P)

Item Quantity/Specs Note

General:

Nominal Frequency 50 or 60 Hz

Power Supply Nominal Range: 48–250 Vdc, 120 Vac Full Operat-
ing Range: 40–300 Vdc

Other ranges available

Input Types The unit accepts ac or dc low voltage analog signals 
on its terminals. These inputs are non-isolated and 
require external isolation in the form of CTs, PTs or 
dc isolation circuits.
The following DIN rail mounted modules are availa-
ble to provide connection input signals:
   •  PT module: AC voltage input, 69 V or 115 V nom-

inal, linear to 138 V.
   •  CT module: AC current input, 1 A or 5 A nominal, 

linear to 20 x nominal. No damage to 20 A contin-
uous, 100 A for 1 second/hour

   •  DC Module: DC or AC voltage or current input, 
100 mV to 1 kV full scale or 1 mA to 100 mA full 
scale nominal. Range is set by resistors mounted 
on outside of module.

Measurement Accuracy Sampling Resolution: 12 bits plus sign
Amplitude Measurement Accuracy: ± 0.1% of full 
scale
Phase Measurement Accuracy: ± 1 degree
Frequency Measurement Accuracy: ± 0.01 Hz @ 60 
Hz

Response Transient Response: Rise time <400  second (10 to 
90%) with <5% overshoot
AC Amplitude Response: ± 2 dB from 10 to 1550 Hz
AC Phase Response: ± 1 degree from 10 to 2880 Hz
DC Amplitude Response: ± 2 dB from 0 to 1000 Hz

Noise Signal to Noise ratio: 66 dB at full scale
Common mode rejection: 66 dB at full scale
Crosstalk: -66 dB

Burden AC Input Module - Voltage: < 0.15 VA @ 69 V
AC Input Module - Current: < 0.25 VA @ 5 A
DC Input Module: Dependent on configuration (see 
“DC Input Module” in Appendix L).

Analog Input Sampling Fixed at 96 samples/cycle
Global to all analog input channels.
All input channels sampled within 45 microseconds 
of each other (within 1 degree @ 60 Hz)

Recording:

Recording Rate: 

Transient Fault 96 samples/cycle Up to 10 seconds per record
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Dynamic Swing 1 sample/cycle Up to 3 minutes per record

Analog Input Accuracy +/- 0.1% of FS amplitude
+/- 1.0 degree phase

Record Storage Up to 1000 fault, swing or combined records 1 gigabyte flash disk standard

A/D Resolution 13 bits, 8192 counts full scale

Channels and Triggers:

Analog Inputs High and low threshold, positive and negative rate of 
change, harmonic level, THD level, sags, swells

All triggers have independent controls for 
delay, logging, transient or swing record 
initiation, alarm contact activation and 
cross triggering. Assigned a priority.

Summations High/low threshold, +/- rate of change 2 or 3 input channel

Positive Sequence High/low threshold, +/- rate of change

Negative Sequence High level

Zero Sequence High level

Watts/VARs High/low threshold, +/- rate of change

Frequency High/low threshold, +/- rate of change

Impedance Positive sequence circle

External Inputs (digital) Rising edge, falling edge or both

Logic Rising edge, falling edge or both

Fault Locator Triggered by internal or external events

Chatter Detection The chatter detection applicable to other detectors 
applies also to sags and swells.  Chatter detection 
reduces the number of event messages in a situa-
tion where there is substantial possibility of rapid re-
triggering.

Sags and Swells Sag and swell detection can be enabled on any ana-
log input channel configured as a voltage.

Thresholds The minimum sag level is configurable from 90% to 
50% of nominal. The maximum sag level is fixed at 
10% of nominal.  To be reported, the measured volt-
age must start and end above the minimum sag 
level.  As well, all measurements in between must be 
above the maximum threshold (10%).

The minimum swell level is configurable from 110% 
to 150% of nominal. The maximum swell level is 
fixed at 180% of nominal. To be reported, the meas-
ured voltage must start and end below the swell min-
imum level.  As well, all measurements in between 
must be below the maximum threshold (180%).

Duration Sags or swells with duration—0.5 cycle and 1 minute 
are reported. This range is not configurable.

TESLA Portable Recorder (model 2000/P)
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Appendix A Specifications
Message Data The minimum voltage (in the case of sags) or the 
maximum voltage (swells) during the episode is be 
reported.

Input & Output:

Analog Input Channels 18 Rating: In = 5 A or 1 A, Vn = 69 V
Continuous: 3x In, 2x Vn
One Second: 20x In without distortion

External Inputs (digital) 32 40 - 150 Vdc, externally wetted

Alarm Output Relays (con-
tacts)

4 Make: 8 A
Carry: 8 A
Break: 0.15 A at 125 Vdc
0.10 A at 250 Vdc

Interface & Communication:

Front Panel Indicators 8 Status LEDs, 32 external inputs and 4 outputs Power On, Wetting On, Recorder Func-
tional, IRIG-B Functional, Recorder Trig-
gered, Records Stored, Test Mode, Alarm

Serial User Interface RS-232 ports up to 115 K baud Port 2 can support an external modem

Internal Modem 33.6 Kbps, V.32 bis

Network 10BaseT Ethernet port

SCADA Interface DNP3 (RS-232 or Ethernet) or Modbus (RS-232) Port 3

Configurable Alarms 2 contacts Normally open

Cross-trigger 1 contact Normally open

Self Checking/Recorder 
Inoperative

1 contact Normally closed

Time Sync IRIG-B, BNC connector Modulated or unmodulated

Environmental:

Ambient Temperature 
Range

-10°C–55°C IEC 60068-2-1/IEC 60068-2-2

Humidity Up to 95% without condensation IEC 60068-2-30

Insulation Test (Hi-Pot) Power supply, analog inputs (through external isola-
tion modules), external inputs, output contacts -1.5 
kV, 50/60 Hz, 1 minute.

IEC 60255-5

Electrical Fast Transient ANSI/IEEE C37.90.1-1989

Oscillatory Transient ANSI/IEEE C37.90.1-1989

Physical:

Weight 14.97 kg 33 lbs

Dimension 29.21 cm high, 44.45 cm wide, 46.99 cm deep 11.5" high, 17.5" wide, 18.5" deep

TESLA Portable Recorder (model 2000/P)

Item Quantity/Specs Note
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Appendix A Specifications
Input Modules 4 input current or 3 input voltage modules available
3 input voltage and 12 split core

Modularity Two standard channel set options are available:
   •  18 analog inputs, 32 digital inputs and 4 output 

contacts

Analog inputs utilize external isolation and 
signal translation circuits as required (e.g. 
DIN rail mounted CT or PT)

Terminal External CT and PT transformers have screw-down 
terminal that accept ring or fork crimps

Front Panel Indicators 6 LEDs: Recorder Functional, IRIG-B Functional, 
Recorder Triggered, Records Stored, Test Mode, 
Alarm

Communications 
Hardware

Port 1, RS-232 serial port to 115 K baud
Port 2, RS-232 serial port to 115 K baud
Port 3, RS-232 serial port for SCADA 
 - 33.6 kbd

Port 2 is only available if the internal 
modem is disabled

Internal modem 33.6 Kbps, V.32 bis
10BaseT Ethernet port

External Inputs

Number 32 channels

External Input Thresholds Will turn on: >=38 V
Will not turn on: <=25 V
Maximum input: <300 V

Burden Burden Resistance: >10 kilo-ohm

Sample Rate Same as selected for the analog input channels 
(synchronized)

Terminals Binding posts

Wetting Supply 48 Vdc fused 1/4 A Capable of driving all 32 external inputs

Output Contacts

Number 4 or 8

Function 1: Recorder Failure - normally closed
2: User-definable - Pick-up <1.0 s, latch 1.0 s
3: User-definable - Pick-up <1.0 s, latch 1.0 s
4: Channel Group 1 cross trigger output - Pick-up 
<10 ms, latch 100 ms

Dry Contact Rating 5 A @ 150 Vdc make and continuous
300 mA @ 150 Vdc break.

Carry: 8 A
Make: 8 A
Break: 0.15 A at 125 Vdc
           0.10 A at 250 Vdc

Terminals Binding posts

Record Length

Transient Record Length normal 0.2 to 5 seconds
auto extend to 10 seconds

TESLA Portable Recorder (model 2000/P)
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Appendix A Specifications
Swing Record Length normal 10 to 120 seconds
auto extend 180 seconds

Total Records Stored 1000 records

Event Log Record 250 events 

Time Synchronization and Accuracy

External Time Source The recorder can be synchronized using modulated 
or unmodulated IRIG-B. IEEE 1344 is supported.

Free Running Accuracy In the absence of an external time source, the 
recorder maintains time with a maximum 1 part per 
million drift.
The recorder can detect loss or re-establishment of 
external time source and switch between internal 
and external time.

Synchronization Accuracy Sampling clocks synchronized with the time source 
(internal or external)
All time stamping accurate to 45 microseconds 
(equivalent to 1 degree @ 60 Hz)

Trends

Available trend channels Any of the recorder’s existing configured analog 
channels (input or calculated) can be trended.  Eval-
uated phasor magnitude and angle quantities will be 
recorded as separate channels.

Accumulation mode Each channel can be configured to accumulate data 
in one or more of the following modes. 

Accumulation Mode Description

Minimum Smallest reading seen over the interval

Maximum Largest reading seen over the interval

Average Average of all readings seen over the inter-
val

Damped Single zero low pass filter, with a time con-
stant preset to one-half the user-selected 
Sample Interval.

Undamped Last reading in the interval

Data is accumulated at a rate of 100 (50 Hz sys-
tems) or 120 (60 Hz systems) samples/second and 
is produced and stored at the selected trend sample 
interval. 

Sample Interval User selectable sample interval from 10 seconds to 
1 hour in 1 second increments. All channels produce 
trend data simultaneously at the selected rate.

TESLA Portable Recorder (model 2000/P)
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Maximum number of 
channels

Up to 60 channels can be trended simultaneously. A 
channel with multiple accumulation modes is treated 
as multiple channels (e.g. the trending of minimum, 
maximum and average readings of a selected input 
would require 3 trend channels). 

Trend storage on the 
recorder

The recorder can store 90 days of data from each 
trend channel, regardless of the sample rate or the 
number of configured trend channels. This is a non-
configurable parameter. 

Accumulation mode Accumulation of trend data can be configured to 
either stop or recycle when the trend log is full. In 
recycle mode, the oldest data is overwritten.

Trend “full” indicator An alarm contact can be activated when the oldest 
data in the trend log reaches a specified age. The 
alarm level is configurable from 10 to 90 days in daily 
steps. Once activated, the alarm will remain on until 
the user removes the data (via TESLA Control 
Panel) or the configured alarm level is increased. 

Scaling Data is always stored in primary quantities

Change of configuration The configuration of the recorder can be changed 
without loss of previously accumulated trend data. If 
the new configuration stops the trending of a chan-
nel, previously accumulated data for that channel 
remains available until it reaches the 90- day storage 
limit or until it is removed by the user.

Event Storage The storage capacity for Trend events is set at a 
maximum of 1000 events/day and is retained for the 
same period as Trend data.

TESLA Portable Recorder (model 2000/P)
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Appendix B   TESLA Hardware Description
The TESLA is a modular high-quality power system recording system. It is 
available in 18 and 36 channel models.

External Input 
Boards #1 and #2

The 18 channel TESLA and the Portable TESLA has 32 external inputs and 4 
contact outputs, provided by External Input Board #1. Inputs are optically iso-
lated and factory preset to the customer’s requested voltage level.
The 36 channel TESLA has a second bank of 32 external inputs and 4 contact 
outputs provided by External Input Board #2 for a total of 64 external inputs.
Connection to the board is provided by removable screw terminal strips. Posts 
are mounted on the Portable TESLA and the rack binding. Terminal strips on 
the rack mounted units are keyed to ensure that the correct terminal strip is in-
stalled into the correct bank.

Analog Input Board The TESLA’s analog input channels to the recorder are provided by the Ana-
log Input Board. The 18 channel TESLA and Portable TESLA has only half of 
the board populated.
Connection to the board is provided by removable screw terminal strips on the 
rack-mounted TESLA and binding posts on the Portable TESLA. Terminal 
strips are keyed, to ensure that the correct terminal strip is installed into the cor-
rect bank.

Comm Board The Comm Board provides the TESLA with two RS-232 ports, IRIG-B time 
synchronization input, network or telephone connection. The RS-232 ports are 
female DB-9S connectors, IRIG-B is a male BNC, and network or telephone 
is a female RJ-45 modular jack.

Power Supply The Power Supply conditions and converts the input power for use by the in-
ternal electronics. A wide input power supply provides the TESLA with the 
ability to operate from 40 to 300 Vdc or 120 Vac ± 20% 50/60 Hz.

PC-104 CPU Board A 100 MHz 486-class CPU with 36 MB of RAM provides data storage, infor-
mation management, housekeeping, and communications for the TESLA. The 
486 runs QNX®, a POSIX-compliant real-time operating system optimized for 
high speed, high precision computing. The 486 provides sophisticated facilities 
for communications and field software updates. Local and wide area network-
ing is supported by QNX, providing the TESLA with a path to future network-
ing capability. 

Main Processor 
Boards #1 and #2

The 18 channel TESLA and the Portable TESLA has one Main Processor 
Board (MPB) to service its 18 analog and 32 external inputs. The 36 channel 
TESLA uses a second MPB for another 18 analog and 32 external inputs.
Each MPB has analog data acquisition, high-speed digital signal processing for 
triggering and data conversion, communications and interface logic to perform 
the core functions of the TESLA recorder.
The Main Processor Board has:
   •  24 channels of high-speed 12 bit-plus-sign analog-to-digital conversion
   •  512 KB of high speed cache memory for the DSP
   •  Re-programmable flash memory for the DSP allows field software up-

grades
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Appendix B TESLA Hardware Description
   •  50 MHz TMS320C32 32-bit floating point Digital Signal Processor (DSP) 
for fast capture and manipulation of data

   •  3 FIFO-enabled 16550 serial RS-232 communications ports
   •  High speed 512 word FIFO in both directions between DSP and 486 proc-

essors
   •  Time synchronism processor with automatic detection of modulated and 

unmodulated IRIG-B
   •  Sophisticated fault detection and recovery “watchdog” hardware

Hard Disk Data storage for the TESLA recorder is a high capacity hard disk drive. The 
Portable TESLA uses a 1 GB solid state flash IDE drive.

Front Panel Board The Front Panel Board provides visual indication of the status of the TESLA 
recorder and a front-panel RS-232 port. The RS-232 port is female DB-9S con-
nector.

Wetting Supply The Wetting Supply is available only on the Portable TESLA. It supplies 
enough power to wet all 32 external input contacts.

External Input

Board #1

Analog

Input Board

Power Supply

PC-104 

CPU Board

Main Processor 

Board #2 

(Optional)

Comm Board 

(Underneath)

Main 

Processor 

Board #1

Front Panel 

Board

Hard Disk 

(Underneath)

External Input 

Board #2 

(Optional)
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Appendix C   Glossary
AC Analog Input An ac current or voltage that is obtained from a current transformer or a voltage trans-

former connected to an element on the power system.

AC Analog Summation Configuration of TESLA allows two AC analog quantities to be summed. For example, 
currents from two parallel lines can be summed to produce a set of combined currents.

AC Input Module This device takes in the voltage or current quantities (4 currents or 3 voltages, dependent 
on model), modifies these input quantities into low level signals that are suitable for input 
into the TESLA recorder back panel. The conversion ratio is stated on the module. Out-
puts from these modules can be connected to any of the Analog Input terminals on 
TESLA

COMTRADE Common Format for Transient Data Exchange. IEEE standard C37.111-1991, IEEE 
Standard Common Format for Transient Data Exchange (COMTRADE) for Power Sys-
tems, which describes a common format for exchange of recorded power systems data 
between different manufacturers’ recorders.

DC Input Module An external input module that can be scaled to accept a wide range of voltage or current 
signals. The model provides galvanic isolation and accepts dc signals or ac signals up to 
2 kHz.

DCE Data Communications Equipment, an RS-232 term for modems and similar equipment. 
DCEs generally have a female DB connector.

DST Daylight Savings Time. A seasonal adjustment of time applied in many jurisdictions to 
compensate for varying day lengths. Most often, an hour is added to the system time 
from 2 AM on the first Sunday in April, until 3 AM / 2 AM on the last Sunday in October.

DTE Data Terminal Equipment, an RS-232 term for a terminal or computer. DTEs generally 
have a male DB connector.

DUN Dial-Up Networking, a facility in Windows providing dial-up access to Internet and other 
networks. DUN is provided with the Windows distribution.

EIA RS-232C Electronics Industries Association recommended standard 232, revision C, Interface 
between Data Terminal Equipment and Data Communication Equipment Employing 
Serial Binary Data Interchange. Defines the most popular electrical connection for serial 
binary data interchange, available on almost all computer systems.

Element A component in the power system that conveys bulk power within the power system. 
Control Panel provides for a naming convention that groups real and calculated channels 
with a given element name. Has three voltages and three currents associated with it. For 
example, a transmission line, or a transformer.

External Input A contact status brought into TESLA from the outside world. This contact must be exter-
nally wetted with a voltage from 30 to 150 Vdc. Correct polarity must be observed.

IED Intelligent Electronic Device, referring to a power system substation device which com-
munications on a substation network, such as Modbus.

IEEE 1344 IEEE 1344 is an enhancement to the basic IRIG-B time code that embeds information 
such as the year, the UTC/local offset (under certain conditions only) and daylight sav-
ings time into the time stream. IEEE standard 1344-95, IEEE Standard for Synchro-
phasors for Power Systems, outlines the implementation and use of accurate time 
standards for power systems relaying and recording. Annex F describes an IRIG-B 
extension (using previously unused control bits in the signal) which provides extensive 
information beyond that of standard IRIG-B.

IRIG-B Inter-Range Instrumentation Group time code format type B, see Range Commanders 
Council Telecommunications and Timing Group, IRIG standard 200-95, IRIG Serial Time 
Code Formats. Describes an implementation for distribution of precise timing informa-
tion, especially to power systems relays and recorders. IRIG-B is typically provided by a 
satellite clock (e.g. GPS or GOES).
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Modbus Modbus is a network using a master/slave protocol often used in power system substa-
tions. Its function was developed and is defined by Modicon, Inc., North Andover, MA, 
USA. Refer to Modbus Protocol Reference Guide, Modicon document PI-MBUS-300.

PTI Power Technologies Incorporated

Trigger A situation that can initiate a recording.

UTC Universally Coordinated Time. Approximately equivalent to Greenwich Mean Time 
(GMT). A universal time maintained by time standards bodies worldwide. All local times 
are expressed as an offset from UTC.
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Appendix D   Modbus Functions
The TESLA recorder operates as a slave device on the Modbus network, with 
an address of 1 to 247 (decimal), 0x01 to 0xF7. The Point List can be printed 
through TESLA Control Panel to display the point names as they are config-
ured. Please refer to “Printing a Modbus Address List” on page 7-33.
For further information on Modbus, please refer to your Modbus master device 
manual, or obtain Modicon’s Modbus Protocol Reference Guide, document PI-
MBUS-300.

Read Coil Status (Function Code 01, 0X References)

Channel Address Value

Hold Readings 00001 0: Readings not held 1:Readings held

Reserved 00257 Reserved

Contact 2 00513 0: Contact open (inactive) 1: Contact closed (active)

Contact 3 00514 0: Contact open (inactive) 1: Contact closed (active)

Contact 4 00515 0: Contact open (inactive) 1: Contact closed (active)

Contact 5 00516 0: Contact open (inactive) 1: Contact closed (active)

Contact 6 00517 0: Contact open (inactive) 1: Contact closed (active)

Contact 7 00518 0: Contact open (inactive) 1: Contact closed (active)

Contact 8 00519 0: Contact open (inactive) 1: Contact closed (active)

Logic Detector 1 00769 0: Off (inactive) 1: On (active)

Logic Detector 2 00770 0: Off (inactive) 1: On (active)

Logic Detector 3 00771 0: Off (inactive) 1: On (active)

Logic Detector 4 00772 0: Off (inactive) 1: On (active)

Logic Detector 5 00773 0: Off (inactive) 1: On (active)

Logic Detector 6 00774 0: Off (inactive) 1: On (active)

Logic Detector 7 00775 0: Off (inactive) 1: On (active)

Logic Detector 8 00776 0: Off (inactive) 1: On (active)

Logic Detector 9 00777 0: Off (inactive) 1: On (active)

Logic Detector 10 00778 0: Off (inactive) 1: On (active)

Logic Detector 11 00779 0: Off (inactive) 1: On (active)

Logic Detector 12 00780 0: Off (inactive) 1: On (active)

Logic Detector 13 00781 0: Off (inactive) 1: On (active)

Logic Detector 14 00782 0: Off (inactive) 1: On (active)

Logic Detector 15 00783 0: Off (inactive) 1: On (active)

Logic Detector 16 00784 0: Off (inactive) 1: On (active)

Logic Detector 17 00785 0: Off (inactive) 1: On (active)

Logic Detector 18 00786 0: Off (inactive) 1: On (active)

Logic Detector 19 00787 0: Off (inactive) 1: On (active)
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Logic Detector 20 00788 0: Off (inactive) 1: On (active)

Logic Detector 21 00789 0: Off (inactive) 1: On (active)

Logic Detector 22 00790 0: Off (inactive) 1: On (active)

Logic Detector 23 00791 0: Off (inactive) 1: On (active)

Logic Detector 24 00792 0: Off (inactive) 1: On (active)

Logic Detector 25 00793 0: Off (inactive) 1: On (active)

Logic Detector 26 00794 0: Off (inactive) 1: On (active)

Logic Detector 27 00795 0: Off (inactive) 1: On (active)

Logic Detector 28 00796 0: Off (inactive) 1: On (active)

Logic Detector 29 00797 0: Off (inactive) 1: On (active)

Logic Detector 30 00798 0: Off (inactive) 1: On (active)

High/low speed recording 
active

01025 0: Off (inactive) 1: On (active)

High/low speed recording 
space nearly full alarm

01026 0: Off (inactive) 1: On (active)

Trend Recording Active 01281 0: Off (inactive) 1: On (active)

Trend Recording Accumula-
tion Alarm

01282 0: Off (inactive) 1: On (active)

Read Input Status (Function Code 02, 1X References)

Channel Address Value

External I/P 1 10001 0: Off (inactive) 1: On (active)

External I/P 2 10002 0: Off (inactive) 1: On (active)

External I/P 3 10003 0: Off (inactive) 1: On (active)

External I/P 4 10004 0: Off (inactive) 1: On (active)

External I/P 5 10005 0: Off (inactive) 1: On (active)

External I/P 6 10006 0: Off (inactive) 1: On (active)

External I/P 7 10007 0: Off (inactive) 1: On (active)

External I/P 8 10008 0: Off (inactive) 1: On (active)

External I/P 9 10009 0: Off (inactive) 1: On (active)

External I/P 10 10010 0: Off (inactive) 1: On (active)

External I/P 11 10011 0: Off (inactive) 1: On (active)

External I/P 12 10012 0: Off (inactive) 1: On (active)

External I/P 13 10013 0: Off (inactive) 1: On (active)

External I/P 14 10014 0: Off (inactive) 1: On (active)

External I/P 15 10015 0: Off (inactive) 1: On (active)

External I/P 16 10016 0: Off (inactive) 1: On (active)

External I/P 17 10017 0: Off (inactive) 1: On (active)

External I/P 18 10018 0: Off (inactive) 1: On (active)

External I/P 19 10019 0: Off (inactive) 1: On (active)
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External I/P 20 10020 0: Off (inactive) 1: On (active)

External I/P 21 10021 0: Off (inactive) 1: On (active)

External I/P 22 10022 0: Off (inactive) 1: On (active)

External I/P 23 10023 0: Off (inactive) 1: On (active)

External I/P 24 10024 0: Off (inactive) 1: On (active)

External I/P 25 10025 0: Off (inactive) 1: On (active)

External I/P 26 10026 0: Off (inactive) 1: On (active)

External I/P 27 10027 0: Off (inactive) 1: On (active)

External I/P 28 10028 0: Off (inactive) 1: On (active)

External I/P 29 10029 0: Off (inactive) 1: On (active)

External I/P 30 10030 0: Off (inactive) 1: On (active)

External I/P 31 10031 0: Off (inactive) 1: On (active)

External I/P 32 10032 0: Off (inactive) 1: On (active)

External I/P33 10033 0: Off (inactive) 1: On (active)

External I/P 34 10034 0: Off (inactive) 1: On (active)

External I/P 35 10035 0: Off (inactive) 1: On (active)

External I/P 36 10036 0: Off (inactive) 1: On (active)

External I/P 37 10037 0: Off (inactive) 1: On (active)

External I/P 38 10038 0: Off (inactive) 1: On (active)

External I/P 39 10039 0: Off (inactive) 1: On (active)

External I/P 40 10040 0: Off (inactive) 1: On (active)

External I/P 41 10041 0: Off (inactive) 1: On (active)

External I/P 42 10042 0: Off (inactive) 1: On (active)

External I/P 43 10043 0: Off (inactive) 1: On (active)

External I/P 44 10044 0: Off (inactive) 1: On (active)

External I/P 45 10045 0: Off (inactive) 1: On (active)

External I/P 46 10046 0: Off (inactive) 1: On (active)

External I/P 47 10047 0: Off (inactive) 1: On (active)

External I/P 48 10048 0: Off (inactive) 1: On (active)

External I/P 49 10049 0: Off (inactive) 1: On (active)

External I/P 50 10050 0: Off (inactive) 1: On (active)

External I/P 51 10051 0: Off (inactive) 1: On (active)

External I/P 52 10052 0: Off (inactive) 1: On (active)

External I/P 53 10053 0: Off (inactive) 1: On (active)

External I/P 54 10054 0: Off (inactive) 1: On (active)

External I/P 55 10055 0: Off (inactive) 1: On (active)

External I/P 56 10056 0: Off (inactive) 1: On (active)

External I/P 57 10057 0: Off (inactive) 1: On (active)

External I/P 58 10058 0: Off (inactive) 1: On (active)

External I/P 59 10059 0: Off (inactive) 1: On (active)
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External I/P 60 10060 0: Off (inactive) 1: On (active)

External I/P 61 10061 0: Off (inactive) 1: On (active)

External I/P 62 10062 0: Off (inactive) 1: On (active)

External I/P 63 10063 0: Off (inactive) 1: On (active)

External I/P 64 10064 0: Off (inactive) 1: On (active)

External I/P1 Change latch 10257 0: Off (no change) 1: On (change) 

External I/P 2 Change latch 10258 0: Off (no change) 1: On (change) 

External I/P 3 Change latch 10259 0: Off (no change) 1: On (change) 

External I/P 4 Change latch 10260 0: Off (no change) 1: On (change) 

External I/P 5 Change latch 10261 0: Off (no change) 1: On (change) 

External I/P 6 Change latch 10262 0: Off (no change) 1: On (change) 

External I/P 7 Change latch 10263 0: Off (no change) 1: On (change) 

External I/P 8 Change latch 10264 0: Off (no change) 1: On (change) 

External I/P 9 Change latch 10265 0: Off (no change) 1: On (change) 

External I/P 10 Change latch 10266 0: Off (no change) 1: On (change) 

External I/P 11Change latch 10267 0: Off (no change) 1: On (change) 

External I/P 12 Change latch 10268 0: Off (no change) 1: On (change) 

External I/P 13 Change latch 10269 0: Off (no change) 1: On (change) 

External I/P 14 Change latch 10270 0: Off (no change) 1: On (change) 

External I/P 15 Change latch 10271 0: Off (no change) 1: On (change) 

External I/P 16 Change latch 10272 0: Off (no change) 1: On (change) 

External I/P 17 Change latch 10273 0: Off (no change) 1: On (change) 

External I/P 18 Change latch 10274 0: Off (no change) 1: On (change) 

External I/P 19 Change latch 10275 0: Off (no change) 1: On (change) 

External I/P 20 Change latch 10276 0: Off (no change) 1: On (change) 

External I/P 21 Change latch 10277 0: Off (no change) 1: On (change) 

External I/P 22 Change latch 10278 0: Off (no change) 1: On (change) 

External I/P 23 Change latch 10279 0: Off (no change) 1: On (change) 

External I/P 24 Change latch 10280 0: Off (no change) 1: On (change) 

External I/P 25 Change latch 10281 0: Off (no change) 1: On (change) 

External I/P 26 Change latch 10282 0: Off (no change) 1: On (change) 

External I/P 27 Change latch 10283 0: Off (no change) 1: On (change) 

External I/P 28 Change latch 10284 0: Off (no change) 1: On (change) 

External I/P 29 Change latch 10285 0: Off (no change) 1: On (change) 

External I/P 30 Change latch 10286 0: Off (no change) 1: On (change) 

External I/P 31 Change latch 10287 0: Off (no change) 1: On (change) 

External I/P 32 Change latch 10288 0: Off (no change) 1: On (change) 

External I/P 33 Change latch 10289 0: Off (no change) 1: On (change) 

External I/P 34 Change latch 10290 0: Off (no change) 1: On (change) 

External I/P 35 Change latch 10291 0: Off (no change) 1: On (change) 
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External I/P 36 Change latch 10292 0: Off (no change) 1: On (change) 

External I/P 37 Change latch 10293 0: Off (no change) 1: On (change) 

External I/P 38 Change latch 10294 0: Off (no change) 1: On (change) 

External I/P 39 Change latch 10295 0: Off (no change) 1: On (change) 

External I/P 40 Change latch 10296 0: Off (no change) 1: On (change) 

External I/P 41 Change latch 10297 0: Off (no change) 1: On (change) 

External I/P 42 Change latch 10298 0: Off (no change) 1: On (change) 

External I/P 43 Change latch 10299 0: Off (no change) 1: On (change) 

External I/P 44 Change latch 10300 0: Off (no change) 1: On (change) 

External I/P 45 Change latch 10301 0: Off (no change) 1: On (change) 

External I/P 46 Change latch 10302 0: Off (no change) 1: On (change) 

External I/P 47 Change latch 10303 0: Off (no change) 1: On (change) 

External I/P 48 Change latch 10304 0: Off (no change) 1: On (change) 

External I/P 49 Change latch 10305 0: Off (no change) 1: On (change) 

External I/P 50 Change latch 10306 0: Off (no change) 1: On (change) 

External I/P 51 Change latch 10307 0: Off (no change) 1: On (change) 

External I/P 52 Change latch 10308 0: Off (no change) 1: On (change) 

External I/P 53 Change latch 10309 0: Off (no change) 1: On (change) 

External I/P 54 Change latch 10310 0: Off (no change) 1: On (change) 

External I/P 55 Change latch 10311 0: Off (no change) 1: On (change) 

External I/P 56 Change latch 10312 0: Off (no change) 1: On (change) 

External I/P 57 Change latch 10313 0: Off (no change) 1: On (change) 

External I/P 58 Change latch 10314 0: Off (no change) 1: On (change) 

External I/P 59 Change latch 10315 0: Off (no change) 1: On (change) 

External I/P 60 Change latch 10316 0: Off (no change) 1: On (change) 

External I/P 61 Change latch 10317 0: Off (no change) 1: On (change) 

External I/P 62 Change latch 10318 0: Off (no change) 1: On (change) 

External I/P 63 Change latch 10319 0: Off (no change) 1: On (change) 

External I/P 64 Change latch 10320 0: Off (no change) 1: On (change) 

Read Holding Register (Function Code 03, 4X References

Channel Address Value Scaled up by

Tesla Clock Time (UTC). Read all in same query to ensure consistent time reading data

Milliseconds Now 40001 0-999 1

Seconds Now 40002 0-59 1

Minutes Now 40003 0-59 1

Hours Now 40004 0-23 1

Day of Year Now 40005 1-365 (up to 366 if leap year) 1
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Years since 1900 40006 90-137 1

Sync’d to IRIG-B 40007 0: No, 1: Yes 1

Time of Acquisition (UTC). Read all in same query to ensure consistent time reading data

Milliseconds Acquisition 40008 0-999 1

Seconds Acquisition 40009 0-59 1

Minutes Acquisition 40010 0-59 1

Hours Acquisition 40011 0-23 1

Day of Year Acquisition 40012 1-365 (up to 366 if leap year) 1

Years since 1900 40013 90-137 1

Acquisition Time Sync’d 
to IRIG-B

40014 0: No
1: Yes

1

Offset of UTC to IED 
Local Time

40015 2’s complement half hours, North America is 
negative

1

Analog Magnitude and Angle Metering Channels

Channel Address Value Scaled up by

AI1 Magnitude 40257 0 to 3276.7 units 10

AI1 Angle 40258 -180° to 180° 10

AI2 Magnitude 40259 0 to 3276.7 units 10

AI2 Angle 40260 -180° to 180° 10

AI3 Magnitude 40261 0 to 3276.7 units 10

AI3 Angle 40262 -180° to 180° 10

AI4 Magnitude 40263 0 to 3276.7 units 10

AI4 Angle 40264 -180° to 180° 10

AI5 Magnitude 40265 0 to 3276.7 units 10

AI5 Angle 40266 -180° to 180° 10

AI6 Magnitude 40267 0 to 3276.7 units 10

AI6 Angle 40268 -180° to 180° 10

AI7 Magnitude 40269 0 to 3276.7 units 10

AI7 Angle 40270 -180° to 180° 10

AI8 Magnitude 40271 0 to 3276.7 units 10

AI8 Angle 40272 -180° to 180° 10

AI9 Magnitude 40273 0 to 3276.7 units 10

AI9 Angle 40274 -180° to 180° 10

AI10 Magnitude 40275 0 to 3276.7 units 10

AI10 Angle 40276 -180° to 180° 10

AI11 Magnitude 40277 0 to 3276.7 units 10

AI11 Angle 40278 -180° to 180° 10

AI12 Magnitude 40279 0 to 3276.7 units 10
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AI12 Angle 40280 -180° to 180° 10

AI13 Magnitude 40281 0 to 3276.7 units 10

AI13 Angle 40282 -180° to 180° 10

AI14 Magnitude 40283 0 to 3276.7 units 10

AI14 Angle 40284 -180° to 180° 10

AI15 Magnitude 40285 0 to 3276.7 units 10

AI15 Angle 40286 -180° to 180° 10

AI16 Magnitude 40287 0 to 3276.7 units 10

AI16 Angle 40288 -180° to 180° 10

AI17 Magnitude 40289 0 to 3276.7 units 10

AI17 Angle 40290 -180° to 180° 10

AI18 Magnitude 40291 0 to 3276.7 units 10

AI18 Angle 40292 -180° to 180° 10

AI19 Magnitude 40293 0 to 3276.7 units 10

AI19 Angle 40294 -180° to 180° 10

AI20 Magnitude 40295 0 to 3276.7 units 10

AI20 Angle 40296 -180° to 180° 10

AI21 Magnitude 40297 0 to 3276.7 units 10

AI21 Angle 40298 -180° to 180° 10

AI22 Magnitude 40299 0 to 3276.7 units 10

AI22 Angle 40300 -180° to 180° 10

AI23 Magnitude 40301 0 to 3276.7 units 10

AI23Angle 40302 -180° to 180° 10

AI24 Magnitude 40303 0 to 3276.7 units 10

AI24 Angle 40304 -180° to 180° 10

AI25 Magnitude 40305 0 to 3276.7 units 10

AI25 Angle 40306 -180° to 180° 10

AI26 Magnitude 40307 0 to 3276.7 units 10

AI26 Angle 40308 -180° to 180° 10

AI27 Magnitude 40309 0 to 3276.7 units 10

AI27 Angle 40310 -180° to 180° 10

AI28 Magnitude 40311 0 to 3276.7 units 10

AI28 Angle 40312 -180° to 180° 10

AI29 Magnitude 40313 0 to 3276.7 units 10

AI29 Angle 40314 -180° to 180° 10

AI30 Magnitude 40315 0 to 3276.7 units 10

AI30 Angle 40316 -180° to 180° 10

AI31 Magnitude 40317 0 to 3276.7 units 10

AI31 Angle 40318 -180° to 180° 10

AI32 Magnitude 40319 0 to 3276.7 units 10
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AI32 Angle 40320 -180° to 180° 10

AI33 Magnitude 40321 0 to 3276.7 units 10

AI33 Angle 40322 -180° to 180° 10

AI34 Magnitude 40323 0 to 3276.7 units 10

AI34 Angle 40324 -180° to 180° 10

AI35 Magnitude 40325 0 to 3276.7 units 10

AI35 Angle 40326 -180° to 180° 10

AI36 Magnitude 40327 0 to 3276.7 units 10

AI36 Angle 40328 -180° to 180° 10

Total Harmonic Distortion, Single Harmonic Level, DC Metering Channels

* not supported yet

AI1 THD 40513 0 to 327.67% 100

AI1 SHL 40514 0 to 327.67% 100

AI1 DC* 40515 -3276.8 to 3276.7 units 10

AI2 THD 40516 0 to 327.67% 100

AI2 SHL 40517 0 to 327.67% 100

AI2 DC* 40518 -3276.8 to 3276.7 units 10

AI3 THD 40519 0 to 327.67% 100

AI3 SHL 40520 0 to 327.67% 100

AI3 DC* 40521 -3276.8 to 3276.7 units 10

AI4 THD 40522 0 to 327.67% 100

AI4 SHL 40523 0 to 327.67% 100

AI4 DC* 40524 -3276.8 to 3276.7 units 10

AI5 THD 40525 0 to 327.67% 100

AI5 SHL 40526 0 to 327.67% 100

AI5 DC* 40527 -3276.8 to 3276.7 units 10

AI6 THD 40528 0 to 327.67% 100

AI6 SHL 40529 0 to 327.67% 100

AI6 DC* 40530 -3276.8 to 3276.7 units 10

AI7 THD 40531 0 to 327.67% 100

AI7 SHL 40532 0 to 327.67% 100

AI7 DC* 40533 -3276.8 to 3276.7 units 10

AI8 THD 40534 0 to 327.67% 100

AI8 SHL 40535 0 to 327.67% 100

AI8 DC* 40536 -3276.8 to 3276.7 units 10

AI9 THD 40537 0 to 327.67% 100

AI9 SHL 40538 0 to 327.67% 100

AI9 DC* 40539 -3276.8 to 3276.7 units 10

AI10 THD 40540 0 to 327.67% 100

AI10 SHL 40541 0 to 327.67% 100
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AI10 DC* 40542 -3276.8 to 3276.7 units 10

AI11 THD 40543 0 to 327.67% 100

AI11 SHL 40544 0 to 327.67% 100

AI11 DC* 40545 -3276.8 to 3276.7 units 10

AI12 THD 40546 0 to 327.67% 100

AI12 SHL 40547 0 to 327.67% 100

AI12 DC* 40548 -3276.8 to 3276.7 units 10

AI13 THD 40549 0 to 327.67% 100

AI13 SHL 40550 0 to 327.67% 100

AI13 DC* 40551 -3276.8 to 3276.7 units 10

AI14 THD 40552 0 to 327.67% 100

AI14 SHL 40553 0 to 327.67% 100

AI14 DC* 40554 -3276.8 to 3276.7 units 10

AI15 THD 40555 0 to 327.67% 100

AI15 SHL 40556 0 to 327.67% 100

AI15 DC* 40557 -3276.8 to 3276.7 units 10

AI16 THD 40558 0 to 327.67% 100

AI16 SHL 40559 0 to 327.67% 100

AI16 DC* 40560 -3276.8 to 3276.7 units 10

AI17 THD 40561 0 to 327.67% 100

AI17 SHL 40562 0 to 327.67% 100

AI17 DC* 40563 -3276.8 to 3276.7 units 10

AI18 THD 40564 0 to 327.67% 100

AI18 SHL 40565 0 to 327.67% 100

AI18 DC* 40566 -3276.8 to 3276.7 units 10

AI19 THD 40567 0 to 327.67% 100

AI19 SHL 40568 0 to 327.67% 100

AI19 DC* 40569 -3276.8 to 3276.7 units 10

AI20 THD 40570 0 to 327.67% 100

AI20 SHL 40571 0 to 327.67% 100

AI20 DC* 40572 -3276.8 to 3276.7 units 10

AI21 THD 40573 0 to 327.67% 100

AI21 SHL 40574 0 to 327.67% 100

AI21 DC* 40575 -3276.8 to 3276.7 units 10

AI22 THD 40576 0 to 327.67% 100

AI22 SHL 40577 0 to 327.67% 100

AI22 DC* 40578 -3276.8 to 3276.7 units 10

AI23 THD 40579 0 to 327.67% 100

AI23 SHL 40580 0 to 327.67% 100

AI23 DC* 40581 -3276.8 to 3276.7 units 10
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AI24 THD 40582 0 to 327.67% 100

AI24 SHL 40583 0 to 327.67% 100

AI24 DC* 40584 -3276.8 to 3276.7 units 10

AI25 THD 40585 0 to 327.67% 100

AI25 SHL 40586 0 to 327.67% 100

AI25 DC* 40587 -3276.8 to 3276.7 units 10

AI26 THD 40588 0 to 327.67% 100

AI26 SHL 40589 0 to 327.67% 100

AI26 DC* 40590 -3276.8 to 3276.7 units 10

AI27 THD 40591 0 to 327.67% 100

AI27 SHL 40592 0 to 327.67% 100

AI27 DC* 40593 -3276.8 to 3276.7 units 10

AI28 THD 40594 0 to 327.67% 100

AI28 SHL 40595 0 to 327.67% 100

AI28 DC* 40596 -3276.8 to 3276.7 units 10

AI29 THD 40597 0 to 327.67% 100

AI29 SHL 40598 0 to 327.67% 100

AI29 DC* 40599 -3276.8 to 3276.7 units 10

AI30 THD 40600 0 to 327.67% 100

AI30 SHL 40601 0 to 327.67% 100

AI30 DC* 40602 -3276.8 to 3276.7 units 10

AI31 THD 40603 0 to 327.67% 100

AI31 SHL 40604 0 to 327.67% 100

AI31 DC* 40605 -3276.8 to 3276.7 units 10

AI32 THD 40606 0 to 327.67% 100

AI32 SHL 40607 0 to 327.67% 100

AI32 DC* 40608 -3276.8 to 3276.7 units 10

AI33 THD 40609 0 to 327.67% 100

AI33 SHL 40610 0 to 327.67% 100

AI33 DC* 40611 -3276.8 to 3276.7 units 10

AI34 THD 40612 0 to 327.67% 100

AI34 SHL 40613 0 to 327.67% 100

AI34 DC* 40614 -3276.8 to 3276.7 units 10

AI35 THD 40615 0 to 327.67% 100

AI35 SHL 40616 0 to 327.67% 100

AI35 DC* 40617 -3276.8 to 3276.7 units 10

AI36 THD 40618 0 to 327.67% 100

AI36 SHL 40619 0 to 327.67% 100

AI36 DC* 40620 -3276.8 to 3276.7 units 10

Summation Metering Channels
Appendix D-10 TESLA User Manual 2000 Release Date: 2008 February 08



Appendix D Modbus Functions
SUM1 Magnitude 40769 0 to 3276.7 units 10

SUM1 Angle 40770 -180° to 180° 10

SUM2 Magnitude 40771 0 to 3276.7 units 10

SUM2 Angle 40772 -180° to 180° 10

SUM3 Magnitude 40773 0 to 3276.7 units 10

SUM3 Angle 40774 -180° to 180° 10

SUM4 Magnitude 40775 0 to 3276.7 units 10

SUM4 Angle 40776 -180° to 180° 10

SUM5 Magnitude 40777 0 to 3276.7 units 10

SUM5 Angle 40778 -180° to 180° 10

SUM6 Magnitude 40779 0 to 3276.7 units 10

SUM6 Angle 40780 -180° to 180° 10

SUM7 Magnitude 40781 0 to 3276.7 units 10

SUM7 Angle 40782 -180° to 180° 10

SUM8 Magnitude 40783 0 to 3276.7 units 10

SUM8 Angle 40784 -180° to 180° 10

SUM9 Magnitude 40785 0 to 3276.7 units 10

SUM9 Angle 40786 -180° to 180° 10

SUM10 Magnitude 40787 0 to 3276.7 units 10

SUM10 Angle 40788 -180° to 180° 10

SUM11 Magnitude 40789 0 to 3276.7 units 10

SUM11 Angle 40790 -180° to 180° 10

SUM12 Magnitude 40791 0 to 3276.7 units 10

SUM12 Angle 40792 -180° to 180° 10

SUM13 Magnitude 40793 0 to 3276.7 units 10

SUM13 Angle 40794 -180° to 180° 10

SUM14 Magnitude 40795 0 to 3276.7 units 10

SUM14 Angle 40796 -180° to 180° 10

SUM15 Magnitude 40797 0 to 3276.7 units 10

SUM15 Angle 40798 -180° to 180° 10

SUM16 Magnitude 40799 0 to 3276.7 units 10

SUM16 Angle 40800 -180° to 180° 10

SUM17 Magnitude 40801 0 to 3276.7 units 10

SUM17 Angle 40802 -180° to 180° 10

SUM18 Magnitude 40803 0 to 3276.7 units 10

SUM18 Angle 40804 -180° to 180° 10

SUM19 Magnitude 40805 0 to 3276.7 units 10

SUM19 Angle 40806 -180° to 180° 10

SUM20 Magnitude 40807 0 to 3276.7 units 10

SUM20 Angle 40808 -180° to 180° 10
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SUM21 Magnitude 40809 0 to 3276.7 units 10

SUM21 Angle 40810 -180° to 180° 10

SUM22 Magnitude 40811 0 to 3276.7 units 10

SUM22 Angle 40812 -180° to 180° 10

SUM23 Magnitude 40813 0 to 3276.7 units 10

SUM23 Angle 40814 -180° to 180° 10

SUM24 Magnitude 40815 0 to 3276.7 units 10

SUM24 Angle 40816 -180° to 180° 10

SUM25 Magnitude 40817 0 to 3276.7 units 10

SUM25 Angle 40818 -180° to 180° 10

SUM26 Magnitude 40819 0 to 3276.7 units 10

SUM26 Angle 40820 -180° to 180° 10

SUM27 Magnitude 40821 0 to 3276.7 units 10

SUM27 Angle 40822 -180° to 180° 10

SUM28 Magnitude 40823 0 to 3276.7 units 10

SUM28 Angle 40824 -180° to 180° 10

SUM29 Magnitude 40825 0 to 3276.7 units 10

SUM29 Angle 40826 -180° to 180° 10

SUM30 Magnitude 4827 0 to 3276.7 units 10

SUM30 Angle 40828 -180° to 180° 10

Sequence Metering Channels

SEQ1 Positive 41025 0 to 3276.7 units 10

SEQ1 Negative 41026 0 to 3276.7 units 10

SEQ1 Zero 41027 0 to 3276.7 units 10

SEQ2 Positive 41028 0 to 3276.7 units 10

SEQ2 Negative 41029 0 to 3276.7 units 10

SEQ2 Zero 41030 0 to 3276.7 units 10

SEQ3 Positive 41031 0 to 3276.7 units 10

SEQ3 Negative 41032 0 to 3276.7 units 10

SEQ3 Zero 41033 0 to 3276.7 units 10

SEQ4 Positive 41034 0 to 3276.7 units 10

SEQ4 Negative 41035 0 to 3276.7 units 10

SEQ4 Zero 41036 0 to 3276.7 units 10

SEQ5 Positive 41037 0 to 3276.7 units 10

SEQ5 Negative 41038 0 to 3276.7 units 10

SEQ5 Zero 41039 0 to 3276.7 units 10

SEQ6 Positive 41040 0 to 3276.7 units 10

SEQ6 Negative 41041 0 to 3276.7 units 10

SEQ6 Zero 41042 0 to 3276.7 units 10

SEQ7 Positive 41043 0 to 3276.7 units 10
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SEQ7 Negative 41044 0 to 3276.7 units 10

SEQ7 Zero 41045 0 to 3276.7 units 10

SEQ8 Positive 41046 0 to 3276.7 units 10

SEQ8 Negative 41047 0 to 3276.7 units 10

SEQ8 Zero 41048 0 to 3276.7 units 10

SEQ9 Positive 41049 0 to 3276.7 units 10

SEQ9 Negative 41050 0 to 3276.7 units 10

SEQ9 Zero 41051 0 to 3276.7 units 10

SEQ10 Positive 41052 0 to 3276.7 units 10

SEQ10 Negative 41053 0 to 3276.7 units 10

SEQ10 Zero 41054 0 to 3276.7 units 10

SEQ11 Positive 41055 0 to 3276.7 units 10

SEQ11 Negative 41056 0 to 3276.7 units 10

SEQ11 Zero 41057 0 to 3276.7 units 10

SEQ12 Positive 41058 0 to 3276.7 units 10

SEQ12 Negative 41059 0 to 3276.7 units 10

SEQ12 Zero 41060 0 to 3276.7 units 10

Watts/Vars Metering Channels

WV1 P 41281 -3276.8 to 3276.7 W 10

WV1 Q 41282 -3276.8 to 3276.7 Var 10

WV1 S 41283 0 to 3276.7 VA 10

WV2 P 41284 -3276.8 to 3276.7 W 10

WV2 Q 41285 -3276.8 to 3276.7 Var 10

WV2 S 41286 0 to 3276.7 VA 10

WV3 P 41287 -3276.8 to 3276.7 W 10

WV3 Q 41288 -3276.8 to 3276.7 Var 10

WV3 S 41289 0 to 3276.7 VA 10

WV4 P 41290 -3276.8 to 3276.7 W 10

WV4 Q 41291 -3276.8 to 3276.7 Var 10

WV4 S 41292 0 to 3276.7 VA 10

WV5 P 41293 -3276.8 to 3276.7 W 10

WV5 Q 41294 -3276.8 to 3276.7 Var 10

WV5 S 41295 0 to 3276.7 VA 10

WV6 P 41296 -3276.8 to 3276.7 W 10

WV6 Q 41297 -3276.8 to 3276.7 Var 10

WV6 S 41298 0 to 3276.7 VA 10

WV7 P 41299 -3276.8 to 3276.7 W 10

WV7 Q 41300 -3276.8 to 3276.7 Var 10

WV7 S 41301 0 to 3276.7 VA 10

WV8 P 41302 -3276.8 to 3276.7 W 10
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WV8 Q 41303 -3276.8 to 3276.7 Var 10

WV8 S 41304 0 to 3276.7 VA 10

WV9 P 41305 -3276.8 to 3276.7 W 10

WV9 Q 41306 -3276.8 to 3276.7 Var 10

WV9 S 41307 0 to 3276.7 VA 10

WV10 P 41308 -3276.8 to 3276.7 W 10

WV10 Q 41309 -3276.8 to 3276.7 Var 10

WV10S 41310 0 to 3276.7 VA 10

WV11 P 41311 -3276.8 to 3276.7 W 10

WV11 Q 41312 -3276.8 to 3276.7 Var 10

WV11S 41313 0 to 3276.7 VA 10

WV12 P 41314 -3276.8 to 3276.7 W 10

WV12 Q 41315 -3276.8 to 3276.7 Var 10

WV12S 41316 0 to 3276.7 VA 10

WV13 P 41317 -3276.8 to 3276.7 W 10

WV13 Q 41318 -3276.8 to 3276.7 Var 10

WV13S 41319 0 to 3276.7 VA 10

WV14 P 41320 -3276.8 to 3276.7 W 10

WV14 Q 41321 -3276.8 to 3276.7 Var 10

WV14S 41322 0 to 3276.7 VA 10

WV15 P 41323 -3276.8 to 3276.7 W 10

WV15 Q 41324 -3276.8 to 3276.7 Var 10

WV15S 41325 0 to 3276.7 VA 10

WV16 P 41326 -3276.8 to 3276.7 W 10

WV16 Q 41327 -3276.8 to 3276.7 Var 10

WV16S 41328 0 to 3276.7 VA 10

WV17 P 41329 -3276.8 to 3276.7 W 10

WV17 Q 41330 -3276.8 to 3276.7 Var 10

WV17S 41331 0 to 3276.7 VA 10

WV18 P 41332 -3276.8 to 3276.7 W 10

WV18 Q 41333 -3276.8 to 3276.7 Var 10

WV18S 41334 0 to 3276.7 VA 10

Frequency Metering Channels

Channel Group 1 Frequency 41537 5/6 f_nominal to 7/6 nominal fre-
quency

100

Channel Group 2 Frequency 41538 5/6 f_nominal to 7/6 nominal fre-
quency

100

Impedance Metering Channels

Impedance 1Magnitude 41793 0 to 3276.7 ohm 10

Impedance 1 Angle 41794 -180° to 180° 10

Impedance2 Magnitude 41795 0 to 3276.7 ohm 10
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Impedance 2 Angle 41796 -180° to 180° 10

Impedance 3 Magnitude 41797 0 to 3276.7 ohm 10

Impedance 3 Angle 41798 -180° to 180° 10

Impedance 4 Magnitude 41799 0 to 3276.7 ohm 10

Impedance 4 Angle 41800 -180° to 180° 10

Impedance 5 Magnitude 41801 0 to 3276.7 ohm 10

Impedance 5 Angle 41802 -180° to 180° 10

Impedance 6 Magnitude 41803 0 to 3276.7 ohm 10

Impedance 6 Angle 41804 -180° to 180° 10

Impedance 7 Magnitude 41805 0 to 3276.7 ohm 10

Impedance 7 Angle 41806 -180° to 180° 10

Impedance 8 Magnitude 41807 0 to 3276.7 ohm 10

Impedance 8 Angle 41808 -180° to 180° 10

Impedance 9 Magnitude 41809 0 to 3276.7 ohm 10

Impedance 9 Angle 41810 -180° to 180° 10

Impedance 10 Magnitude 41811 0 to 3276.7 ohm 10

Impedance 10 Angle 41812 -180° to 180° 10

Impedance 11 Magnitude 41813 0 to 3276.7 ohm 10

Impedance 11 Angle 41814 -180° to 180° 10

Impedance 12 Magnitude 41815 0 to 3276.7 ohm 10

Impedance 12 Angle 41816 -180° to 180° 10

Impedance 13 Magnitude 41817 0 to 3276.7 ohm 10

Impedance 13 Angle 41818 -180° to 180° 10

Impedance 14 Magnitude 41819 0 to 3276.7 ohm 10

Impedance 14 Angle 41820 -180° to 180° 10

Impedance 15 Magnitude 41821 0 to 3276.7 ohm 10

Impedance 15 Angle 41822 -180° to 180° 10

Impedance 16 Magnitude 41823 0 to 3276.7 ohm 10

Impedance 16 Angle 41824 -180° to 180° 10

Impedance 17 Magnitude 41825 0 to 3276.7 ohm 10

Impedance 17 Angle 41826 -180° to 180° 10

Impedance 18 Magnitude 41827 0 to 3276.7 ohm 10

Impedance 18 Angle 41828 -180° to 180° 10

Event Information  (See “Accessing 
TESLA Event Information” in Appendix 
D)

42052 – 42144

Length (in 16 bit registers) of the cur-
rent event message 

42052

Event Identification  42053

Event Message 42054–42137

Fault Locator ID 42138

Fault Type 42139
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Fault Distance 42140 10

Fault Time 42141 – 42144

Power Factor Function 1 Level 42305 0.0 to 1.0 100

Power Factor Function 2 Level 42306 0.0 to 1.0 100

Power Factor Function 3 Level 42307 0.0 to 1.0 100

Power Factor Function 4 Level 42308 0.0 to 1.0 100

Power Factor Function 5 Level 42309 0.0 to 1.0 100

Power Factor Function 6 Level 42310 0.0 to 1.0 100

Power Factor Function 7 Level 42311 0.0 to 1.0 100

Power Factor Function 8 Level 42312 0.0 to 1.0 100

Power Factor Function 9 Level 42313 0.0 to 1.0 100

Power Factor Function 10 Level 42314 0.0 to 1.0 100

Power Factor Function 11 Level 42315 0.0 to 1.0 100

Power Factor Function 12 Level 42316 0.0 to 1.0 100

Power Factor Function 13 Level 42317 0.0 to 1.0 100

Power Factor Function 14 Level 42318 0.0 to 1.0 100

Power Factor Function 15 Level 42319 0.0 to 1.0 100

Power Factor Function 16 Level 42320 0.0 to 1.0 100

Power Factor Function 17 Level 42321 0.0 to 1.0 100

Power Factor Function 18 Level 42322 0.0 to 1.0 100

High/low speed recording space used 42561 0.0 to 100.0 10

Trend Recording Days Accumulated 42817 0 to 90 1

Read Input Register (Function Code 04)

No input registers supported. Response from IED indicates “ILLEGAL FUNCTION.”

Force Single Coil (Function Code 05)

Only the “hold readings” coil can be forced. When active, this coil locks all coil, input and holding register readings simul-
taneously at their present values. When inactive, coil, input and holding register values will read their most recently avail-
able state.

Channel Type Address Value

Hold Readings Read/Write 01 0000: Readings update normally (inactive)
FF00: Hold readings (active)
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   •  The TESLA IED model number is 2000.
   •  Version and issue will each be positive integers, say X and Y.
   •  The TESLA is defined as “Model 2000, Version X Issue Y”

Preset Single Register (Function Code 06)

Channel Address Value Scaled Up By

Event Information (See “Accessing TESLA Event Infor-
mation” in Appendix D)

42099 – 42051

Refresh event list 42049 No data required N/A

Acknowledge the current event and get the next event 42050 No data required N/A

Get the next event (without acknowledge) 42051 No data required N/A

Diagnostic Subfunctions (Function Code 08)

Return Query Data (Subfunction 00) This provides an echo of the submitted message.

Restart Comm. Option (Subfunction 01) This restarts the Modbus communications process.

Force Listen Only Mode (Subfunction 04) No response is returned. IED enters “Listen Only” mode. 
This mode can only be exited by the “Restart Comm. 
Option” command.

Report Slave ID (Function Code 17/0x11)

A fixed response is returned by the IED, including system model, version and issue numbers.

Channel Type Bytes Value

Model Number Read Only 0 and 1 0x07D00 = 2000 decimal

Version Number Read Only 2 and 3 Version number

Issue Number Read Only 4 and 5 Issue number

Accessing TESLA Event Information

All TESLA detector event messages displayed in the Event Log are available via Modbus. This includes fault location information. 
The following controls are available.

Refresh Event List (Function Code 6, address 42049): Fetches the latest events from the TESLA's event log and 
makes them available for Modbus access. The most recent event becomes the current event 
available for reading.

Acknowledge Current Event 
and Get Next Event

(Function Code 6, address 42050): Clears the current event from the read registers and 
places the next event into them. An acknowledged event is no longer available for reading.

Get Next Event (Function Code 6, address 42051): Places the next event in the read registers without 
acknowledging the current event. The current event will reappear in the list when Refresh 
Event List is used.
Release Date: 2008 February 08 TESLA User Manual 2000 Appendix D-17



Appendix D Modbus Functions
Size of Current Event 
Message

(Function Code 3, address 42052): Indicates the number of 16 bit registers used to contain 
the current event. Event data is stored with two characters per register. A reading of zero indi-
cates that there are no unacknowledged events available in the current set. (NB. The Refresh 
Event List function can be used to check for new events that have occurred since the last 
Refresh Event List.)

Fault Location Event Preset 
When Set to 0x464C

(Function Code 3, address 42053): Identifies fault location events. These events are identified 
by “FL” (0x464C) in this register. Non-fault location events contain “ ” in this location.

Read Event Message (Function Code 3, addresses 42054 - 42137): Contains the current event message. Two 
ASCII characters are packed into each 16 bit register. All unused registers in the set are set to 
0.

Fault Location – Fault Locator 
ID

(Function Code 3, address 42138): If the current event is a fault location event, this register 
contains the ID of the fault locator. The numbers from 1 to 5 are used for 18-channel record-
ers; the numbers from 1 to 10 are used for 36-channel recorders.

Fault Information – Type (Function Code 3, address 42139): If the current event is a fault location event, this register 
contains the type of the fault. 
The following type bitmap:
0x0001 - Phase A
0x0002 - Phase B
0x0004 - Phase C
0x0008 - Ground
Any number of the flags may be set for a given fault. If recorder could not determine the fault 
type, then the register will not have any flags set and will read 0x0000.

Fault Information – Fault 
Distance

(Function Code 3, address 42140): If the current event is a fault location event, this register 
contains the distance to the fault.  It is scaled up by a factor of 10. The units are the same as 
the units set in the relay configuration.

Fault Information –Time of 
Fault

(Function Code 3, addresses 42141 and 42144): If the current event is a fault location event, 
these registers contain the time of the fault in seconds since 1970. Each of these 16-bit regis-
ters contains an 8-bit portion of a 32-bit time value. Register 42141 contains the upper 16 bits, 
register 42144 contains the lower 16 bits.

Register Value Meaning

High Byte Low Byte

42052 0x00 0x1B Event text size = 27 (0x1B hex)

42053 0x46 0x4C ‘F,L’ - Fault locator event

42054 0x32 0x30 ‘2’, ‘0’

42055 0x30 0x30 ‘0’, ‘0’

42056 0x53 0x65 ‘S’, ‘e’

42057 0x70 0x32 ‘p’, ‘2’

42058 0x31 0x20 ‘1’, ‘ ’

42059 0x32 0x30 ‘2’, ‘0’

42060 0x3A 0x31 ‘:’, ‘1’

42061 0x36 0x3A ‘6’, ‘:’

42062 0x31 0x36 ‘1’, ‘6’
Appendix D-18 TESLA User Manual 2000 Release Date: 2008 February 08



Appendix D Modbus Functions
42063 0x2E 0x39 ‘.’, ‘9’

42064 0x36 0x36 ‘6’, ‘6’

42065 0x20 0x3A ‘ ’, ‘:’

42066 0x20 0x4C ‘ ’, ‘L’ 

42067 0x69 0x6E ‘i’, ‘n’ 

42068 0x65 0x20 ‘e’, ‘ ‘

42069 0x31 0x36 ‘1’, ‘6’

42070 0x3A 0x46 ‘:’, ‘F’

42071 0x4C 0x6F ‘L’, ‘o’

42072 0x63 0x20 ‘c’, ‘ ‘

42073 0x42 0x47 ‘B’, ‘G’

42074 0x20 0x33 ‘ ’, ‘3’

42075 0x39 0x2E ‘9’, ‘.’

42076 0x37 0x20 ‘7’, ‘ ‘

42077 0x6D 0x69 ‘m’, ‘i’

42078 0x6C 0x65 ‘l’, ‘e’

42079 0x73 0x00 ‘s’

Register Value Meaning
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Appendix E  DNP3 Reference
The SCADA port supports DNP3. All metering values available through the 
terminal user interface are available by DNP3 protocol. Included are the device 
profile, implementation table and the point list for the DNP3 protocol.

Device Profile

Vendor Name: NxtPhase Corporation Device Name: Recorder Model #

Highest DNP Level Supported: Device Function:

  For Requests: 2   _ Master
  For Responses: 2   x Slave

Maximum Data Link Frame Size (octets): Maximum Application Fragme Size (octets):

  Transmitted: 292   Transmitted: 2048
  Received: 292   Received: 2048

Maximum Data Link Re-tries: Maximum Application Layer Re-tries:

  _ None   x None
  x  Fixed at 3   _ Configurable, range  __ to __

  _ Configurable, range  __ to __

Requires Data Link Layer Confirmation: Requires Application Layer Confirmation:
  _ Never   _ Never

  _ Always   _ Always (not recommended)

  _ Sometimes   x  When reporting Event Data (Slave)

  x Configurable, either always or never   x  When sending multi-fragment  responses   
      (Slave)

  _ Sometimes

  _ Configurable
Timeouts (in seconds) while waiting for:

Data Link Confirm __None x   Fixed at 2

Complete Application Fragment x   None __Fixed at 2
Application Confirm __None x   Fixed at 5

Complete Application Response x   None __Fixed at 2

Others__________________________
Select to execute delay __None x   Fixed at 10

Sends/Executes Control Operations:

WRITE Binary Outputs  x   Never __Always
SELECT/OPERATE __Never x   Always

DIRECT OPERATE __Never x   Always

DIRECT OPERATE  No ACK __Never x   Always
Count > 1 x   Never __Always

Pulse On __Never x   Always

Pulse Off x   Never __Always
Latch On __Never x   Always

Latch Off __Never x   Always

Queue x   Never __Always
Clear Queue x   Never __Always

Maximum number of control objects per request: 16

Notes:
Control Trip/Close - Code Combination supported:
  Latch On/NUL
  Latch Off/NUL
  Pulse On/NUL (Pulse duration fixed at 1 s)

Report Binary Input Change Events when no spe-
cific variation requested:

Reports time-tagged  Binary Input Change 
Events when no specific variation requested

 __Never  __Never

 __Only time-tagged  x   Binary Input Change with Time

 x   Only non-time-tagged  _ Binary Input Change with Relative Time
 _ Configurable to send both, one or the other  _ Configurable

Sends Unsolicited Response: Sends Static Data in Unsolicited Responses:

 x Never  x Never
 _ Configurable  _ When Device Restarts

 _Only certain objects  _ When Status Flags Change

 _ Sometimes No other options are permitted.
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Implementation 
Table

 _ ENABLE/DISABLE UNSOLICITED Function 
    codes supported

Default Counter Object/Variation: Counters Roll Over at:

 x No Counter Reported  x No Counters Reported
 _ Configurable _ Configurable 

 _ Default Object  ________________  _ 16 Bits

 _ Default Variation _______________ _ 32 Bits 
 _ Point-by-point list attached _ Other Value  __________________

_ Point-by-point list attached

Object Request Response

Grp Var Description Function 
Codes Qualifier Codes Function 

Codes Qualifier Codes

1 0 Binary Input -All Variations 1(read) 0x00, 0x01, 0x06, 0x07,0x08, 0x17,0x28

1 1 Binary Input (default) 1(read) 0x00, 0x01, 0x06, 0x07,0x08, 0x17,0x28 129 (response) 0x00

1 2 Binary Input with status 1(read) 0x00, 0x01, 0x06, 0x07,0x08, 0x17,0x28 129 (response) 0x00

2 0 Binary Input Change - All Varia-
tions

1(read) 0x06, 0x07,0x08

2 1 Binary Input Change without Time 1(read) 0x06, 0x07,0x08 129 (response) 0x17

2 2 Binary Input Change with Time 
(default)

1(read) 0x06, 0x07,0x08 129 (response) 0x17

2 3 Binary Input Change with Relative 
Time

1(read) 0x06, 0x07,0x08 129 (response) 0x17

10 0 Binary Output - All Variations 1(read) 0x00, 0x01, 0x06, 0x07,0x08, 0x17,0x28

10 2 Binary Output Status (default) 1(read) 0x00, 0x01, 0x06, 0x07,0x08, 0x17,0x28 129 (response) 0x00

30 0 Analog Input - All Variations 1(read) 0x00, 0x01, 0x06, 0x07,0x08, 0x17,0x28 129 (response) 0x01

30 1 32-bit Analog Input 1(read) 0x00, 0x01, 0x06, 0x07,0x08, 0x17,0x28

30 2 16-bit Analog Input 1(read) 0x00, 0x01, 0x06, 0x07,0x08, 0x17,0x28 129 (response) 0x01

30 3 32-bit Analog Input without flag 1(read) 0x00, 0x01, 0x06, 0x07,0x08, 0x17,0x28 129 (response) 0x01

30 4 16-bit Analog Input without flag 
(default)

1(read) 0x00, 0x01, 0x06, 0x07,0x08, 0x17,0x28 129 (response) 0x01

32 0 Analog Input Change Event - All 
Variations 

1(read) 0x06, 0x07,0x08 129 (response) 0x28

32 1 Analog Input Change Event - 32-bit 
without Time

1(read) 0x06, 0x07,0x08 129 (response) 0x28

32 2 Analog Input Change Event - 16-bit 
without Time

1(read) 0x06, 0x07,0x08 129 (response) 0x28

32 3 Analog Input Change Event - 32-bit 
with Time

1(read) 0x06, 0x07,0x08 129 (response) 0x28

32 4 Analog Input Change Event - 16-bit 
with Time (default)

1(read) 0x06, 0x07,0x08 129 (response) 0x28

51 1 Time and data CTO 129 (response) 0x07, quantity=1

52 1 Time Delay Coarse 129 (response) 0x07, quantity=1

60 1 Class 0 Data 1(read) 0x06

60 2 Class 1 Data 1(read) 0x06, 0x07,0x08

60 3 Class 2 Data 1(read) 0x06, 0x07,0x08

80 1 Internal Indications 2 (write) 0x00, index=7
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Point List The Point List can be printed through TESLA Control Panel to display the 
point names as they are configured. Please refer to “Printing a DNP Address 
List” on page 7-34.

110 0 Octet String 1 (read) 0x06 129 (response) 0x07

111 0 Octet String Change Event 1 (read) 0x06 129 (response) 0x07

No Object 14(warm start)

Object Request Response

Grp Var Description Function 
Codes Qualifier Codes Function 

Codes Qualifier Codes

Binary Inputs (Obj 1, 2)

Static Points Change Event Points

Object group 1 2

Object variation 1 - Binary Input (default) 1 - Binary Input Change without Time

2 - Binary Input with Status 2 - Binary Input Change with Time

3 - Binary Input Change with Relative 
Time

Class 0 1

Change Event Buffer Size 200

Name Point Index Change Event Class

External Input 1 0 1

External Input 2 1 1

External Input 3 2 1

External Input 4 3 1

External Input 5 4 1

External Input 6 5 1

External Input 7 6 1

External Input 8 7 1

External Input 9 8 1

External Input 10 9 1

External Input 11 10 1

External Input 12 11 1

External Input 13 12 1

External Input 14 13 1

External Input 15 14 1

External Input 16 15 1

External Input 17 16 1
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External Input 18 17 1

External Input 19 18 1

External Input 20 19 1

External Input 21 20 1

External Input 22 21 1

External Input 23 22 1

External Input 24 23 1

External Input 25 24 1

External Input 26 25 1

External Input 27 26 1

External Input 28 27 1

External Input 29 28 1

External Input 30 29 1

External Input 31 30 1

External Input 32 31 1

External Input 33 32 1

External Input 34 33 1

External Input 35 34 1

External Input 36 35 1

External Input 37 36 1

External Input 38 37 1

External Input 39 38 1

External Input 40 39 1

External Input 41 40 1

External Input 42 41 1

External Input 43 42 1

External Input 44 43 1

External Input 45 44 1

External Input 46 45 1

External Input 47 46 1

External Input 48 47 1

External Input 49 48 1

External Input 50 49 1

External Input 51 50 1

External Input 52 51 1

External Input 53 52 1

External Input 54 53 1

External Input 55 54 1

External Input 56 55 1

Name Point Index Change Event Class
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External Input 57 56 1

External Input 58 57 1

External Input 59 58 1

External Input 60 59 1

External Input 61 60 1

External Input 62 61 1

External Input 63 62 1

External Input 64 63 1

Fault Information Available for Fault Locator 1 64 1

Fault Information Available for Fault Locator 2 65 1

Fault Information Available for Fault Locator 3 66 1

Fault Information Available for Fault Locator 4 67 1

Fault Information Available for Fault Locator 5 68 1

Fault Information Available for Fault Locator 6 69 1

Fault Information Available for Fault Locator 7 70 1

Fault Information Available for Fault Locator 8 71 1

Fault Information Available for Fault Locator 9 72 1

Fault Information Available for Fault Locator 10 73 1

Binary Outputs (Obj 10)

Static Points Change Event Points

Object Group 10 Not Applicable

Object Variation 2 – Binary Output Status (default) Not Applicable

Class 0 Not Applicable

Note: Binary outputs are scanned with 500 ms resolution.

No change event buffer.

Name Point Index Change Event Class
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Name Point Index Change Event Class

Logic 1 0 N/A

Logic 2 1 N/A

Logic 3 2 N/A

Logic 4 3 N/A

Logic 5 4 N/A

Logic 6 5 N/A

Logic 7 6 N/A

Logic 8 7 N/A

Logic 9 8 N/A

Logic 10 9 N/A

Logic 11 10 N/A

Logic 12 11 N/A

Logic 13 12 N/A

Logic1 4 13 N/A

Logic 15 14 N/A

Logic 16 15 N/A

Logic 17 16 N/A

Logic 18 17 N/A

Logic 19 18 N/A

Logic 20 19 N/A

Logic 21 20 N/A

Logic 22 21 N/A

Logic 23 22 N/A

Logic 24 23 N/A

Logic 25 24 N/A

Logic 26 25 N/A

Logic 27 26 N/A

Logic 28 27 N/A

Logic 29 28 N/A

Logic 30 29 N/A

Output Contact 2 30 N/A

Output Contact 3 31 N/A

Output Contact 4 32 N/A

Output Contact 5 33 N/A

Output Contact 6 34 N/A

Output Contact 7 35 N/A

Output Contact 8 36 N/A
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High/low speed recording active 37 N/A

High/low speed recording space nearly full alarm 38 N/A

Trend Recording Active 39 N/A

Trend Recording Accumulation Alarm 40 N/A

Retrieve Next Fault Information Event for Fault Locator 1 41 N/A

Retrieve Next Fault Information Event for Fault Locator 2 42 N/A

Retrieve Next Fault Information Event for Fault Locator 3 43 N/A

Retrieve Next Fault Information Event for Fault Locator 4 44 N/A

Retrieve Next Fault Information Event for Fault Locator 5 45 N/A

Retrieve Next Fault Information Event for Fault Locator 6 46 N/A

Retrieve Next Fault Information Event for Fault Locator 7 47 N/A

Retrieve Next Fault Information Event for Fault Locator 8 48 N/A

Retrieve Next Fault Information Event for Fault Locator 9 49 N/A

Retrieve Next Fault Information Event for Fault Locator 10 50 N/A

Analog Inputs (Obj 30, 32)

Static Points Change Event Points

Object group 30 32

Object variation 1 - 32-bit Analog Input 1 - Analog Input Change - 32-bit without Time

2 - 16-bit Analog Input 2 - Analog Input Change - 16-bit without Time (default)

3 - 32-bit Analog Input without flag 3 - Analog Input Change - 32-bit with Time

4 - 16-bit Analog Input without flag (default) 4 - Analog Input Change - 16-bit with Time

Class 0 2

Change Event Buffer Size 200

Name Point Index Units Scale Change Event 
Class

Analog Input 1 Magnitude 0 10 2

Analog Input 1 Angle 1 degrees 10 2

Analog Input 1 THD 2 % 100 2

Analog Input 1 SHL 3 % 100 2

Analog Input 1 DC 4 10 2

Analog Input 2 Magnitude 5 10 2

Analog Input 2 Angle 6 degrees 10 2

Analog Input 2 THD 7 % 100 2

Analog Input 2 SHL 8 % 100 2

Name Point Index Change Event Class
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Analog Input 2 DC 9 10 2

Analog Input 3 Magnitude 10 10 2

Analog Input 3 Angle 11 degrees 10 2

Analog Input 3 THD 12 % 100 2

Analog Input 3 SHL 13 % 100 2

Analog Input 3 DC 14 10 2

Analog Input 4 Magnitude 15 10 2

Analog Input 4 Angle 16 degrees 10 2

Analog Input 4 THD 17 % 100 2

Analog Input 4 SHL 18 % 100 2

Analog Input 4 DC 19 10 2

Analog Input 5 Magnitude 20 10 2

Analog Input 5 Angle 21 degrees 10 2

Analog Input 5 THD 22 % 100 2

Analog Input 5 SHL 23 % 100 2

Analog Input 5 DC 24 10 2

Analog Input 6 Magnitude 25 10 2

Analog Input 6 Angle 26 degrees 10 2

Analog Input 6 THD 27 % 100 2

Analog Input 6 SHL 28 % 100 2

Analog Input 6 DC 29 10 2

Analog Input 7 Magnitude 30 10 2

Analog Input 7 Angle 31 degrees 10 2

Analog Input 7 THD 32 % 100 2

Analog Input 7 SHL 33 % 100 2

Analog Input 7 DC 34 10 2

Analog Input 8 Magnitude 35 10 2

Analog Input 8 Angle 36 degrees 10 2

Analog Input 8 THD 37 % 100 2

Analog Input 8 SHL 38 % 100 2

Analog Input 8 DC 39 10 2

Analog Input 9 Magnitude 40 10 2

Analog Input 9 Angle 41 degrees 10 2

Analog Input 9 THD 42 % 100 2

Analog Input 9 SHL 43 % 100 2

Analog Input 9 DC 44 10 2

Analog Input 10 Magnitude 45 10 2

Analog Input 10 Angle 46 degrees 10 2

Name Point Index Units Scale Change Event 
Class
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Analog Input 10 THD 47 % 100 2

Analog Input 10 SHL 48 % 100 2

Analog Input 10 DC 49 10 2

Analog Input 11 Magnitude 50 10 2

Analog Input 11 Angle 51 degrees 10 2

Analog Input 11 THD 52 % 100 2

Analog Input 11 SHL 53 % 100 2

Analog Input 11 DC 54 10 2

Analog Input 12 Magnitude 55 10 2

Analog Input 12 Angle 56 degrees 10 2

Analog Input 12 THD 57 % 100 2

Analog Input 12 SHL 58 % 100 2

Analog Input 12 DC 59 10 2

Analog Input 13 Magnitude 60 10 2

Analog Input 13 Angle 61 degrees 10 2

Analog Input 13 THD 62 % 100 2

Analog Input 13 SHL 63 % 100 2

Analog Input 13 DC 64 10 2

Analog Input 14 Magnitude 65 10 2

Analog Input 14 Angle 66 degrees 10 2

Analog Input 14 THD 67 % 100 2

Analog Input 14 SHL 68 % 100 2

Analog Input 14 DC 69 10 2

Analog Input 15 Magnitude 70 10 2

Analog Input 15 Angle 71 degrees 10 2

Analog Input 15 THD 72 % 100 2

Analog Input 15 SHL 73 % 100 2

Analog Input 15 DC 74 10 2

Analog Input 16 Magnitude 75 10 2

Analog Input 16 Angle 76 degrees 10 2

Analog Input 16 THD 77 % 100 2

Analog Input 16 SHL 78 % 100 2

Analog Input 16 DC 79 10 2

Analog Input 17 Magnitude 80 10 2

Analog Input 17 Angle 81 degrees 10 2

Analog Input 17 THD 82 % 100 2

Analog Input 17 SHL 83 % 100 2

Analog Input 17 DC 84 10 2

Name Point Index Units Scale Change Event 
Class
Release Date: 2008 February 08 TESLA User Manual 2000 Appendix E-9



Appendix E DNP3 Reference
Analog Input 18 Magnitude 85 10 2

Analog Input 18 Angle 86 degrees 10 2

Analog Input 18 THD 87 % 100 2

Analog Input 18 SHL 88 % 100 2

Analog Input 18 DC 89 10 2

Analog Input 19 Magnitude 90 10 2

Analog Input 19 Angle 91 degrees 10 2

Analog Input 19 THD 92 % 100 2

Analog Input 19 SHL 93 % 100 2

Analog Input 19 DC 94 10 2

Analog Input 20 Magnitude 95 10 2

Analog Input 20 Angle 96 degrees 10 2

Analog Input 20 THD 97 % 100 2

Analog Input 20 SHL 98 % 100 2

Analog Input 20 DC 99 10 2

Analog Input 21 Magnitude 100 10 2

Analog Input 21 Angle 101 degrees 10 2

Analog Input 21 THD 102 % 100 2

Analog Input 21 SHL 103 % 100 2

Analog Input 21 DC 104 10 2

Analog Input 22 Magnitude 105 10 2

Analog Input 22 Angle 106 degrees 10 2

Analog Input 22 THD 107 % 100 2

Analog Input 22 SHL 108 % 100 2

Analog Input 22 DC 109 10 2

Analog Input 23 Magnitude 110 10 2

Analog Input 23 Angle 111 degrees 10 2

Analog Input 23 THD 112 % 100 2

Analog Input 23 SHL 113 % 100 2

Analog Input 23 DC 114 10 2

Analog Input 24 Magnitude 115 10 2

Analog Input 24 Angle 116 degrees 10 2

Analog Input 24 THD 117 % 100 2

Analog Input 24 SHL 118 % 100 2

Analog Input 24 DC 119 10 2

Analog Input 25 Magnitude 120 10 2

Analog Input 25 Angle 121 degrees 10 2

Analog Input 25 THD 122 % 100 2

Name Point Index Units Scale Change Event 
Class
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Analog Input 25 SHL 123 % 100 2

Analog Input 25 DC 124 10 2

Analog Input 26 Magnitude 125 10 2

Analog Input 26 Angle 126 degrees 10 2

Analog Input 26 THD 127 % 100 2

Analog Input 26 SHL 128 % 100 2

Analog Input 26 DC 129 10 2

Analog Input 27 Magnitude 130 10 2

Analog Input 27 Angle 131 degrees 10 2

Analog Input 27 THD 132 % 100 2

Analog Input 27 SHL 133 % 100 2

Analog Input 27 DC 134 10 2

Analog Input 28 Magnitude 135 10 2

Analog Input 28 Angle 136 degrees 10 2

Analog Input 28 THD 137 % 100 2

Analog Input 28 SHL 138 % 100 2

Analog Input 28 DC 139 10 2

Analog Input 29 Magnitude 140 10 2

Analog Input 29 Angle 141 degrees 10 2

Analog Input 29 THD 142 % 100 2

Analog Input 29 SHL 143 % 100 2

Analog Input 29 DC 144 10 2

Analog Input 30 Magnitude 145 10 2

Analog Input 30 Angle 146 degrees 10 2

Analog Input 30 THD 147 % 100 2

Analog Input 30 SHL 148 % 100 2

Analog Input 30 DC 149 10 2

Analog Input 31 Magnitude 150 10 2

Analog Input 31 Angle 151 degrees 10 2

Analog Input 31 THD 152 % 100 2

Analog Input 31 SHL 153 % 100 2

Analog Input 31 DC 154 10 2

Analog Input 32 Magnitude 155 10 2

Analog Input 32 Angle 156 degrees 10 2

Analog Input 32 THD 157 % 100 2

Analog Input 32 SHL 158 % 100 2

Analog Input 32 DC 159 10 2

Analog Input 33 Magnitude 160 10 2

Name Point Index Units Scale Change Event 
Class
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Analog Input 33 Angle 161 degrees 10 2

Analog Input 33 THD 162 % 100 2

Analog Input 33 SHL 163 % 100 2

Analog Input 33 DC 164 10 2

Analog Input 34 Magnitude 165 10 2

Analog Input 34 Angle 166 degrees 10 2

Analog Input 34 THD 167 % 100 2

Analog Input 34 SHL 168 % 100 2

Analog Input 34 DC 169 10 2

Analog Input 35 Magnitude 170 10 2

Analog Input 35 Angle 171 degrees 10 2

Analog Input 35 THD 172 % 100 2

Analog Input 35 SHL 173 % 100 2

Analog Input 35 DC 174 10 2

Analog Input 36 Magnitude 175 10 2

Analog Input 36 Angle 176 degrees 10 2

Analog Input 36 THD 177 % 100 2

Analog Input 36 SHL 178 % 100 2

Analog Input 36 DC 179 10 2

Summation 1 Magnitude 180 10 2

Summation 1 Angle 181 degrees 10 2

Summation 2 Magnitude 182 10 2

Summation 2 Angle 183 degrees 10 2

Summation 3 Magnitude 184 10 2

Summation 3 Angle 185 degrees 10 2

Summation 4 Magnitude 186 10 2

Summation 4 Angle 187 degrees 10 2

Summation 5 Magnitude 188 10 2

Summation 5 Angle 189 degrees 10 2

Summation 6 Magnitude 190 10 2

Summation 6 Angle 191 degrees 10 2

Summation 7 Magnitude 192 10 2

Summation 7 Angle 193 degrees 10 2

Summation 8 Magnitude 194 10 2

Summation 8 Angle 195 degrees 10 2

Summation 9 Magnitude 196 10 2

Summation 9 Angle 197 degrees 10 2

Summation 10 Magnitude 198 10 2

Name Point Index Units Scale Change Event 
Class
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Summation 10 Angle 199 degrees 10 2

Summation 11 Magnitude 200 10 2

Summation 11 Angle 201 degrees 10 2

Summation 12 Magnitude 202 10 2

Summation 12 Angle 203 degrees 10 2

Summation 13 Magnitude 204 10 2

Summation 13 Angle 205 degrees 10 2

Summation 14 Magnitude 206 10 2

Summation 14 Angle 207 degrees 10 2

Summation 15 Magnitude 208 10 2

Summation 15 Angle 209 degrees 10 2

Summation 16 Magnitude 210 10 2

Summation 16 Angle 211 degrees 10 2

Summation 17 Magnitude 212 10 2

Summation 17 Angle 213 degrees 10 2

Summation 18 Magnitude 214 10 2

Summation 18 Angle 215 degrees 10 2

Summation 19 Magnitude 216 10 2

Summation 19 Angle 217 degrees 10 2

Summation 20 Magnitude 218 10 2

Summation 20 Angle 219 degrees 10 2

Summation 21 Magnitude 220 10 2

Summation 21 Angle 221 degrees 10 2

Summation 22 Magnitude 222 10 2

Summation 22 Angle 223 degrees 10 2

Summation 23 Magnitude 224 10 2

Summation 23 Angle 225 degrees 10 2

Summation 24 Magnitude 226 10 2

Summation 24 Angle 227 degrees 10 2

Summation 25 Magnitude 228 10 2

Summation 25 Angle 229 degrees 10 2

Summation 26 Magnitude 230 10 2

Summation 26 Angle 231 degrees 10 2

Summation 27 Magnitude 232 10 2

Summation 27 Angle 233 degrees 10 2

Summation 28 Magnitude 234 10 2

Summation 28 Angle 235 degrees 10 2

Summation 29 Magnitude 236 10 2

Name Point Index Units Scale Change Event 
Class
Release Date: 2008 February 08 TESLA User Manual 2000 Appendix E-13



Appendix E DNP3 Reference
Summation 29 Angle 237 degrees 10 2

Summation 30 Magnitude 238 10 2

Summation 30 Angle 239 degrees 10 2

Sequence Function 1 Positive 240 10 2

Sequence Function 1 Negative 241 10 2

Sequence Function 1 Zero 242 10 2

Sequence Function 2 Positive 243 10 2

Sequence Function 2 Negative 244 10 2

Sequence Function 2 Zero 245 10 2

Sequence Function 3 Positive 246 10 2

Sequence Function 3 Negative 247 10 2

Sequence Function 3 Zero 248 10 2

Sequence Function 4 Positive 249 10 2

Sequence Function 4 Negative 250 10 2

Sequence Function 4 Zero 251 10 2

Sequence Function 5 Positive 252 10 2

Sequence Function 5 Negative 253 10 2

Sequence Function 5 Zero 254 10 2

Sequence Function 6 Positive 255 10 2

Sequence Function 6 Negative 256 10 2

Sequence Function 6 Zero 257 10 2

Sequence Function 7 Positive 258 10 2

Sequence Function 7 Negative 259 10 2

Sequence Function 7 Zero 260 10 2

Sequence Function 8 Positive 261 10 2

Sequence Function 8 Negative 262 10 2

Sequence Function 8 Zero 263 10 2

Sequence Function 9 Positive 264 10 2

Sequence Function 9 Negative 265 10 2

Sequence Function 9 Zero 266 10 2

Sequence Function 10 Positive 267 10 2

Sequence Function 10 Negative 268 10 2

Sequence Function 10 Zero 269 10 2

Sequence Function 11 Positive 270 10 2

Sequence Function 11 Negative 271 10 2

Sequence Function 11 Zero 272 10 2

Sequence Function 12 Positive 273 10 2

Sequence Function 12 Negative 274 10 2

Name Point Index Units Scale Change Event 
Class
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Appendix E DNP3 Reference
Sequence Function 12 Zero 275 10 2

Watts/Vars Function 1 P 276 MW 10 2

Watts/Vars Function 1 Q 277 MVAR 10 2

Watts/Vars Function 1 S 278 MVA 10 2

Watts/Vars Function 2 P 279 MW 10 2

Watts/Vars Function 2 Q 280 MVAR 10 2

Watts/Vars Function 2 S 281 MVA 10 2

Watts/Vars Function 3 P 282 MW 10 2

Watts/Vars Function 3 Q 283 MVAR 10 2

Watts/Vars Function 3 S 284 MVA 10 2

Watts/Vars Function 4 P 285 MW 10 2

Watts/Vars Function 4 Q 286 MVAR 10 2

Watts/Vars Function 4 S 287 MVA 10 2

Watts/Vars Function 5 P 288 MW 10 2

Watts/Vars Function 5 Q 289 MVAR 10 2

Watts/Vars Function 5 S 290 MVA 10 2

Watts/Vars Function 6 P 291 MW 10 2

Watts/Vars Function 6 Q 292 MVAR 10 2

Watts/Vars Function 6 S 293 MVA 10 2

Watts/Vars Function 7 P 294 MW 10 2

Watts/Vars Function 7 Q 295 MVAR 10 2

Watts/Vars Function 7 S 296 MVA 10 2

Watts/Vars Function 8 P 297 MW 10 2

Watts/Vars Function 8 Q 298 MVAR 10 2

Watts/Vars Function 8 S 299 MVA 10 2

Watts/Vars Function 9 P 300 MW 10 2

Watts/Vars Function 9 Q 301 MVAR 10 2

Watts/Vars Function 9 S 302 MVA 10 2

Watts/Vars Function 10 P 303 MW 10 2

Watts/Vars Function 10 Q 304 MVAR 10 2

Watts/Vars Function 10 S 305 MVA 10 2

Watts/Vars Function 11 P 306 MW 10 2

Watts/Vars Function 11 Q 307 MVAR 10 2

Watts/Vars Function 11 S 308 MVA 10 2

Watts/Vars Function 12 P 309 MW 10 2

Watts/Vars Function 12 Q 310 MVAR 10 2

Watts/Vars Function 12 S 311 MVA 10 2

Watts/Vars Function 13 P 312 MW 10 2

Name Point Index Units Scale Change Event 
Class
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Appendix E DNP3 Reference
Watts/Vars Function 13 Q 313 MVAR 10 2

Watts/Vars Function 13 S 314 MVA 10 2

Watts/Vars Function 14 P 315 MW 10 2

Watts/Vars Function 14 Q 316 MVAR 10 2

Watts/Vars Function 14 S 317 MVA 10 2

Watts/Vars Function 15 P 318 MW 10 2

Watts/Vars Function 15 Q 319 MVAR 10 2

Watts/Vars Function 15 S 320 MVA 10 2

Watts/Vars Function 16 P 321 MW 10 2

Watts/Vars Function 16 Q 322 MVAR 10 2

Watts/Vars Function 16 S 323 MVA 10 2

Watts/Vars Function 17 P 324 MW 10 2

Watts/Vars Function 17 Q 325 MVAR 10 2

Watts/Vars Function 17 S 326 MVA 10 2

Watts/Vars Function 18 P 327 MW 10 2

Watts/Vars Function 18 Q 328 MVAR 10 2

Watts/Vars Function 18 S 329 MVA 10 2

Group 1 Frequency 330 Hz 100 2

Group 2 Frequency 331 Hz 100 2

Impedance Function 1 Mag 332 ohms 10 2

Impedance Function 1 Angle 333 degrees 10 2

Impedance Function 2 Mag 334 ohms 10 2

Impedance Function 2 Angle 335 degrees 10 2

Impedance Function 3 Mag 336 ohms 10 2

Impedance Function 3 Angle 337 degrees 10 2

Impedance Function 4 Mag 338 ohms 10 2

Impedance Function 4 Angle 339 degrees 10 2

Impedance Function 5 Mag 340 ohms 10 2

Impedance Function 5 Angle 341 degrees 10 2

Impedance Function 6 Mag 342 ohms 10 2

Impedance Function 6 Angle 343 degrees 10 2

Impedance Function 7 Mag 344 ohms 10 2

Impedance Function 7 Angle 345 degrees 10 2

Impedance Function 8 Mag 346 ohms 10 2

Impedance Function 8 Angle 347 degrees 10 2

Impedance Function 9 Mag 348 ohms 10 2

Impedance Function 9 Angle 349 degrees 10 2

Impedance Function 10 Mag 350 ohms 10 2

Name Point Index Units Scale Change Event 
Class
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Appendix E DNP3 Reference
Impedance Function 10 Angle 351 degrees 10 2

Impedance Function 11 Mag 352 ohms 10 2

Impedance Function 11 Angle 353 degrees 10 2

Impedance Function 12 Mag 354 ohms 10 2

Impedance Function 12 Angle 355 degrees 10 2

Impedance Function 13 Mag 356 ohms 10 2

Impedance Function 13 Angle 357 degrees 10 2

Impedance Function 14 Mag 358 ohms 10 2

Impedance Function 14 Angle 359 degrees 10 2

Impedance Function 15 Mag 360 ohms 10 2

Impedance Function 15 Angle 361 degrees 10 2

Impedance Function 16 Mag 362 ohms 10 2

Impedance Function 16 Angle 363 degrees 10 2

Impedance Function 17 Mag 364 ohms 10 2

Impedance Function 17 Angle 365 degrees 10 2

Impedance Function 18 Mag 366 ohms 10 2

Impedance Function 18 Angle 367 degrees 10 2

Power Factor Function 1 Level 368 100 2

Power Factor Function 2 Level 369 100 2

Power Factor Function 3 Level 370 100 2

Power Factor Function 4 Level 371 100 2

Power Factor Function 5 Level 372 100 2

Power Factor Function 6 Level 373 100 2

Power Factor Function 7 Level 374 100 2

Power Factor Function 8 Level 375 100 2

Power Factor Function 9 Level 376 100 2

Power Factor Function 10 Level 377 100 2

Power Factor Function 11 Level 378 100 2

Power Factor Function 12 Level 379 100 2

Power Factor Function 13 Level 380 100 2

Power Factor Function 14 Level 381 100 2

Power Factor Function 15 Level 382 100 2

Power Factor Function 16 Level 383 100 2

Power Factor Function 17 Level 384 100 2

Power Factor Function 18 Level 385 100 2

High/low speed recording space used 386 per 10 2

Trend Recording Days Accumulated 387 days 1 2

Fault Locator 1

Name Point Index Units Scale Change Event 
Class
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Appendix E DNP3 Reference
Fault Information - DNP Time - High 16 bits 388 N/A 1 2

Fault Information - DNP Time - Middle 16 bits 389 N/A 1 2

Fault Information - DNP Time - Low 16 bits 390 N/A 1 2

Fault Information - Fault Distanc 391 User-specified 10 2

Fault Information - Type (see below for defi-
nition)

392 N/A 1 2

Fault Locator 2

Fault Information - DNP Time - High 16 bits 393 N/A 1 2

Fault Information - DNP Time - Middle 16 bits 394 N/A 1 2

Fault Information - DNP Time - Low 16 bits 395 N/A 1 2

Fault Information - Fault Distance 396 User-specified 10 2

Fault Information - Type (see below for defi-
nition)

397 N/A 1 2

Fault Locator 3

Fault Information - DNP Time - High 16 bits 398 N/A 1 2

Fault Information - DNP Time - Middle 16 bits 399 N/A 1 2

Fault Information - DNP Time - Low 16 bits 400 N/A 1 2

Fault Information - Fault Distance 401 User-specified 10 2

Fault Information - Type (see below for defi-
nition)

402 N/A 1 2

Fault Locator 4

Fault Information - DNP Time - High 16 bits 403 N/A 1 2

Fault Information - DNP Time - Middle 16 bits 404 N/A 1 2

Fault Information - DNP Time - Low 16 bits 405 N/A 1 2

Fault Information - Fault Distance 406 User-specified 10 2

Fault Information - Type (see below for defi-
nition)

407 N/A 1 2

Fault Locator 5

Fault Information - DNP Time - High 16 bits 408 N/A 1 2

Fault Information - DNP Time - Middle 16 bits 409 N/A 1 2

Fault Information - DNP Time - Low 16 bits 410 N/A 1 2

Fault Information - Fault Distance 411 User-specified 10 2

Fault Information - Type (see below for defi-
nition)

412 N/A 1 2

Fault Locator 6

Fault Information - DNP Time - High 16 bits 413 N/A 1 2

Fault Information - DNP Time - Middle 16 bits 414 N/A 1 2

Fault Information - DNP Time - Low 16 bits 415 N/A 1 2

Fault Information - Fault Distance 416 User-specified 10 2

Fault Information - Type (see below for defi-
nition)

417 N/A 1 2

Fault Locator 7

Name Point Index Units Scale Change Event 
Class
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Appendix E DNP3 Reference
Fault Information - DNP Time - High 16 bits 418 N/A 1 2

Fault Information - DNP Time - Middle 16 bits 419 N/A 1 2

Fault Information - DNP Time - Low 16 bits 420 N/A 1 2

Fault Information - Fault Distance 421 User-specified 10 2

Fault Information - Type (see below for defi-
nition)

422 N/A 1 2

Fault Locator 8

Fault Information - DNP Time - High 16 bits 423 N/A 1 2

Fault Information - DNP Time - Middle 16 bits 424 N/A 1 2

Fault Information - DNP Time - Low 16 bits 425 N/A 1 2

Fault Information - Fault Distance 426 User-specified 10 2

Fault Information - Type (see below for defi-
nition)

427 N/A 1 2

Fault Locator 9

Fault Information - DNP Time - High 16 bits 428 N/A 1 2

Fault Information - DNP Time - Middle 16 bits 429 N/A 1 2

Fault Information - DNP Time - Low 16 bits 430 N/A 1 2

Fault Information - Fault Distance 431 User-specified 10 2

Fault Information - Type (see below for defi-
nition)

432 N/A 1 2

Fault Locator 10

Fault Information - DNP Time - High 16 bits 433 N/A 1 2

Fault Information - DNP Time - Middle 16 bits 434 N/A 1 2

Fault Information - DNP Time - Low 16 bits 435 N/A 1 2

Fault Information - Fault Distance 436 User-specified 10 2

Fault Information - Type (see below for defi-
nition)

437 N/A 1 2

Name Point Index Units Scale Change Event 
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Appendix E DNP3 Reference
Object 110, 111 - Octet String for Event Log access
Object 110 and Object 111 are Octet String objects used to provide access to 
the Event Log text of the TESLA. These objects are described in Technical 
Bulletin 9701-004.zip_71 available from the DNP user group web page 
(www.dnp.org). Object 110 always contains the most recent event in the TES-
LA. Object 111 is the corresponding change event object. As stated in the DNP 
technical bulletin, the variation of the response object represents the length of 
the string. The string represents the ASCII values of the event text. The first 2 
characters in the string can be used to quickly identify fault location events. 
Fault locator events begin with the characters “FL” (0x46, 0x44 hex). The fol-
lowing example shows a fault distance event returned through either of the oc-
tet string objects.

DNP Example: Event Message 

“2000Sep21 20:16:16.966 : Line 16:FLoc BG 39.7 miles”

DNP Octet string object contents:

0x46 0x4C 0x32 0x30 0x30 0x30

0x53 0x65 0x70 0x32 0x31 0x20

0x32 0x30 0x3A 0x31 0x36 0x3A

0x31 0x36 0x2E 0x39 0x36 0x36

0x20 0x3A 0x20 0x4C 0x69 0x6E

0x65 0x20 0x31 0x36 0x3A 0x46

0x4C 0x6F 0x63 0x20 0x42 0x47

0x20 0x33 0x39 0x2E 0x37 0x20

0x6D 0x69 0x6C 0x65 0x73
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Appendix F  TESLA Mechanical Drawing

Figure F.1:  Mechanical Drawing (rack-mounted TESLA model 2000)
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Appendix F TESLA Mechanical Drawing
Figure F.2:  Cut-out Template(rack-mounted TESLA model 2000)
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Appendix G  Rear Panel
For larger view, see folded diagram at back.

Figure G.1:  Rear Panel
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Appendix H   AC Analog Connections

Figure H.1:  AC Analog Connections
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Appendix I  AC Voltage Input Module

Figure I.1:  401006 AC Voltage Input Module
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Appendix I AC Voltage Input Module
Figure I.2:  401006.02 AC Voltage Input Module

This module has been superceded by the 401006 shown on the previous page.
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Appendix J  AC Current Input Module

Figure J.1:  401014 AC Current Input Module
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Appendix J AC Current Input Module
Figure J.2:  401002.02 AC Current Input Module

This module has been superceded by the 401014 module shown on the previous page.
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Appendix K  AC Current Input Options
Split Core CT (optional)

Figure K.1:  Split Core CT (optional)

Figure K.2:  Connection of Optional Split Core CT
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8'/2.438 m 

Twisted
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2.47"/6.274 cm

Current Flow from main

CT to measuring device

From  Polarity

of main CT

To Polarity of  Measuring 

Device (Relay) in Panel

Optional Split

Core CT

Leads to the Input of the TESLA Recorder

- White lead to dot (polarity mark) of  

  TESLA Recorder Analog input

- Black lead to non-polarity mark of  

  TESLA Recorder Analog input

+

-+
-9 VDC White

Black

1. Connect 9 VDC battery or supply with positive polarity in the 
    direction of arrow on the CT as shown.
2. Connect DC meter (d'Arsonal movement) with positive polarity  
    connected to the white lead on the CT as shown.
3. Momentarily close and open the switch and watch for movement 
    of DC voltmeter. The meter will move in the direction shown for a 
    white lead as polarity.
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Appendix K AC Current Input Options
Figure K.3:  Clamp-on CT (optional)
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Appendix L  DC Input Module
The DC Analog Module is an optional input device to provide DC-coupled iso-
lation and scaling for four independent dc or ac voltage or current channels. 
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Appendix L DC Input Module
DC Analog Module Connection Schematic

Figure L.1:  DC Analog Module Connection Schematic
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Appendix L DC Input Module
DC Analog Module Physical Dimensions

Figure L.2:  401016 DC Input Module Model
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Appendix L DC Input Module
Input and Range Configuration
Resistors mounted on each channels input connector set the channel's input 
range. Up to three resistors are used, depending on the type and level of the sig-
nal to be applied. 
The input signal is applied to low or high range terminals, as appropriate for 
the selected input range.
The following tables give resistor values and wiring examples for different ap-
plications. For applications that are not in these tables, contact ERLPhase.
All resistors must be rated for ¼ watt or more, unless otherwise specified. Un-
less otherwise noted, the RIN resistor must be rated to handle the full input volt-
age, which may require a physically larger resistor be used. This is generally 
true of any application that has an input in excess of 50 V peak. 
The resistor values specified are precision values as per the E48 standard series 
of resistance values in a decade.   See the section L.3 Input and Range Config-
uration for the full table of standard values. It is possible to use other available 
values, although range and resolution may be compromised. Always select RIN 
of equal or greater value to that shown, and select RFB of equal or lesser value 
to that shown.
The Vishay CCF-2 series resistors in ±1% precision, or equivalent, are recom-
mended for this application. These metal film flameproof resistors are rated for 
industrial power applications at up to 2 watts dissipation and up to 350 volt 
drop. Values of 4.99 Ω to 1 MΩ are available in this series - for higher values, 
use two resistors of appropriate value in series.
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Appendix L DC Input Module
DC Voltage Input

Full Scale 
(V dc)

 Shunt 
Resistance

RSH (Ω)

Input 
Resistance

RIN (Ω)

Feedback 
Resistance

RFB (Ω)

Input 
Impedance

(Ω ±10%)

Low Range
0.1 V to 200 V dc FS

± 0.1  332 Ω open  10 kΩ

± 0.2  0 Ω 422 kΩ 10 kΩ

± 0.5  0 Ω 100 kΩ 10 kΩ

± 1  0 Ω 40.2 kΩ 10 kΩ

± 2  0 Ω 13.3 kΩ 10 kΩ

± 5  1.40 kΩ  0 Ω 11 kΩ

± 10  13.3 kΩ 0 Ω 22 kΩ

± 20  38.3 kΩ 0 Ω 47 kΩ

± 25  51.1 kΩ 0 Ω 60 kΩ

± 50  121 kΩ 0 Ω 120 kΩ

± 100  287 kΩ 1/2 W 0 Ω 240 kΩ

± 150  511 kΩ 1 W 0 Ω 350 kΩ

± 200  825 kΩ 1 W 0 Ω 450 kΩ

High Range
350 V to 880 V dc FS

± 350  0 Ω 10.0 kΩ 1.5 MΩ

± 500  0 Ω 3.48 kΩ 1.5 MΩ

± 880 1 MΩ 2W 0 Ω 2 MΩ

NCNC

Input RIN RFB

NCNC

Input RIN RFB
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Appendix L DC Input Module
AC Voltage Input

Full Scale 
(V rms)

 Shunt 
Resistance

RSH (Ω)

Input 
Resistance

RIN (Ω)

Feedback 
Resistance

RFB (Ω)

Input 
Impedance

(Ω ±10%)

Low Range
0.1 V to 150 V rms FS

0.1 0 Ω  1.00 MΩ 10 k Ω

0.2 0 Ω  237 kΩ 10 k Ω

0.5 0 Ω  64.9 kΩ 10 k Ω

1 0 Ω  23.7 kΩ 10 k Ω

2 0 Ω  6.19 kΩ 10 k Ω

5 6.19 kΩ  0 Ω  16 k Ω

10 23.7 kΩ  0 Ω  33 k Ω

20 59.0 kΩ  0 Ω  66 k Ω

50 178 kΩ 1/2 W  0 Ω  160 k Ω 

100 464 kΩ 1 W  0 Ω  320 k Ω

150
(for 69 V)

909 kΩ 2 W  0 Ω 490 k Ω

High Range
200 V to 600 V rms FS

200 0 Ω 15.4 kΩ 1.5 M Ω

250
(for 120 V)

0 Ω  9.53 kΩ  1.5 M Ω

500
(for 240 V)

121 kΩ 0 Ω  1.6 M Ω

600 750 kΩ 1 W 0 Ω  1.9 M Ω

NCNC

Input RIN RFB

NCNC

Input RIN RFB
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Appendix L DC Input Module
DC Current Input
(External Shunt Optional)

Full Scale 
(mA dc)

 Shunt 
Resistance

RSH (Ω)

Input 
Resistance

RIN (Ω)

Feedback 
Resistance

RFB (Ω)

Full Scale  
Voltage Drop

(V)

1 mA to 500 mA dc FS 1 100 Ω  332 Ω  open 0.1

2 100 Ω  0 Ω 422 kΩ 0.2

5 100 Ω  0 Ω 100 kΩ 0.5

10 100 Ω  0 Ω 40.2 kΩ 1.0

20 100 Ω  0 Ω 13.3 kΩ 2.0

25
(for 4-20 mA)

100 Ω  0 Ω 8.25 kΩ 2.5

50 10 Ω  0 Ω 100 kΩ 0.5

100 1 Ω  332 Ω Open 0.1

200 1 Ω  0 Ω 422 kΩ 0.2

500 1 Ω 1/2 W  0 Ω 100 kΩ 0.5

External shunt with value of RSH may be used as shown instead of RSH on the termi-
nal block.

NC

Input RIN RFB

RIN RFB

RSH

NC

R

NC

Current+ -SH
External

ORor

AC Current Input
(with External Shunt)

Full Scale 
(V rms)

output of 
shunt

 Shunt 
Resistance

RSH (Ω)

Input 
Resistance

RIN (Ω)

Feedback 
Resistance

RFB (Ω)

Input 
Impedance
(Ω ±10%)

0.1 V to 1 V rms FS 0.1 0 Ω  1.00 MΩ 10 kΩ

0.2 0 Ω  237 kΩ 10 kΩ

0.5  0 Ω 64.9 kΩ 10 kΩ

1.0  0 Ω 23.7 kΩ 10 kΩ
NC

RIN RFB

NC

Current

Shunt
External
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Appendix L DC Input Module
Standard Series of Values in a Decade
The following tables show the standard values of resistance available in a de-
cade. The lower numbered series are more common and easier to obtain, while 
the higher numbered series provide more resolution. In general, it is best to use 
the lowest numbered series which provides acceptable resolution, since this 
will be the easiest and least expensive to obtain.
Most often, distributors stock ±2% and ±5% resistors in the E24 series, 1% re-
sistors in the E96 series, and ±0.1%, ±0.2% and ±0.5% in the E192 series.
The values are not linear, but are instead approximately equal percentages 
apart from each other. Each value is related to the next by a ratio of approxi-
mately the Nth root of 10, where “N” is the series number (3 to 192).
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Appendix L DC Input Module
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Appendix M  AC Low Voltage Input Module

Figure M.1:  401022 AC Low Voltage Input Module
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Appendix N   TESLA Portable Wiring 
Connections

Figure N.1:  TESLA Portable 2000/P Simplified Wiring Connections

Figure N.1: TESLA Portable 2000/P Simplified Wiring Connections on page 
1 shows how to connect the analog input devices, as well as Dry and Wet con-
tacts. Note how the “Wetted” contact signal on one part of the signal (+/-125 
Vdc) shows the Hi or Lo signal. On the “Dry” contact note how the voltage sig-
nal appears on the digital inputs. The recorder is protected from “mixing up” 
the 48 Vdc Wetting 48 Supply to the external voltage supply (48 to 250 volts). 
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Remote
“Dry”
Contacts

125 Vdc
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Index
Index

A
absolute time 21
AC 3 Channel isolated voltage input 
module 1
AC 4 Channel isolated current input 
module 2
AC current input module 2
AC Scaling 11
Actions 29
active trace information 19
add 11
add analog graph 14
add digital graph 15
Alarm contacts 3
Analog input 3, 8

calibration 10
channels 1

Analog input isolation modules 1, 2, 
1, 2, 1

C
calculate derived channels now 26
calculated channels 71
Calibration

analog input 10
change scale (Y axis) 25
change trace color 18
Channel groups 6
Channel naming 8
channel tool-tip 34
Channel types and triggers 3

external inputs 3
fault locators 5
frequency 5
impedance 5
logics 5
power factor 5
sequence 4
summation 4
Watts/Vars 4

Channel view 5, 7
Chatter limits 33
Clamp-on CT 2
Communication ports 4

settings 3
COMTRADE import 77
Configuation

planning 6
Configuration files

channel view 5
element view 5

main branches 3
managing 1
navigating 2
older firmware versions 1
saved configurations 2
working with IED’s present configu-

ration 1
Configuring

Windows 95/98 setup 2
Windows NT 4.0 setup 4

Control panel
control tabs 5
features 2
navigating 5
status bar 5
working area 5

copy to clipboard 12
copy trace 16
copy trace data to clipboard 18
cross hair 20

D
DC module 2
DC Scaling 11
delete 9, 11
delete all traces 18
delete graph 15
delete trace 17
Dial-up Network Connections (DUN)

APT_MODEM Dial-Up 16, 19
APT_SERIAL Dial-Up 13

DNP 15, 34, 1
Duration recording 6

E
Edge recording 5
Element view 5

adding an element 7, 8
external input channels 11
fault locator channels 26
frequency channels 23
impedance channels 19
logic channels 24
power factor channels 27
sequence component channels 17
summation channel 14
Watts/Vars channels 21

Error handling 1, 3
Event log 14, 1
Event messages 1
Event priority 30
exit 10
Export
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Index
COMTRADE 1, 3
Excel (CSV) 1, 7
launch 2
PTI 1, 5

export 9
exporting channel data 73
exporting views 72
extend print range 28
External input 3, 11, 13, 3

F
Failure modes 4
Fault locator 5, 26
file menus 6
Frequency 5
front view 4
fundamental RMS 21

G
Glossary 1
Graph 2
graph 34

adding 34
adding channels 34
copy to clipboard 72
keyboard functions 37
panning 37
save as meta file 72
time alignment 65
zooming 35

graph menus 14
Grounding 6, 4

H
Hardware description 1
harmonics 21
help menus 30

I
Identification 2
Impedance 5, 19
import 10
Installation

null modem 5
software 3
TESLA Control Panel 1

IRIG-B time signal 4

L
Launch RecordGraph

from TESLA Control Panel 1
from Windows Explorer 3

line 13
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Software Installation Instructions

The CD-ROM contains software and the User Manual for TESLA Disturbance 
Fault Recorder.
Software is installed directly from the CD-ROM to a Windows PC. 
The CD-ROM contains the following:
   •  TESLA Control Panel: interface software
   •  TESLA Firmware: Firmware and installation instructions
   •  TESLA User Manual: TESLA manual in PDF format

Access the CD-ROM Insert the CD-ROM in your drive; the CD-ROM should open automatically. If 
the it does not, go to Windows Explorer and find the CD-ROM (usually on D 
drive). Open the TESLA.exe file to launch the CD-ROM. 

To view the TESLA User Manual you must have Adobe Acrobat on your com-
puter. If you need a copy, download a copy by clicking on Download Adobe 
Acrobat.

Installation of TESLA Control Panel software requires that your Win-
dows system be properly configured. For details see “TESLA Control 
Panel Setup” on page 2-1.
Release Date: 2008 February 08 TESLA User Manual 2000 V
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